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Introduction 
SpaceClaim Professional 2008 is the 3D productivity tool for engineers who need to focus on their core 
competencies while also benefiting from working in 3D. The software provides a highly flexible design 
environment coupled with a modern user experience that speeds contributions to the product development 
process. SpaceClaim Professional 2008 is for those who collaborate in the design and manufacture of 
mechanical products across a broad range of industries. 

The online help, tutorials, and training materials are provided to help you become productive with 
SpaceClaim as quickly as possible. We strongly recommend that you review the Getting Started section and 
step through the tutorial provided in the online help before beginning your own work. Additional self-paced 
tutorial videos are available on MySpaceClaim.com. You can also begin by exploring a library of SpaceClaim 
models. 

User's Guide 

This User's Guide begins with a focus on the basic tools and on simple concepts. SpaceClaim is all about 
adding and manipulating the faces of a design model, primarily through pull and move operations. If there 
is a face, you can pull on it. If you need a new face, draw an edge or copy an existing one. Design clutter is 
minimized wherever possible. This guide communicates these simple, but powerful concepts so that you can 
extrapolate them to your real-world designs. This guide also provides useful shortcuts to use as you 
progress, as well as animations of tools in action to help you understand their function. 

SpaceClaim is different, and we encourage you to open your mind and enter into a world where you can 
focus on the design, not the software. SpaceClaim appreciates your feedback, so let us know where we 
have succeeded and what we can do better. Thanks for your purchase and we look forward to working with 
you! 

 Get started using SpaceClaim 

1   Sketch and pull to create a part, or open an existing model from any modeling software. 

2   Edit the part using SpaceClaim's 2D and 3D editing tools. 

3   (Optional) Customize SpaceClaim and your workspace to your working style. 

4   Detail the part with notes, measurements, and geometric tolerances. 

5   Submit the part for review using 3D Markup. 

 Watch tutorials 

 Review designs in the MySpaceClaim library 
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Getting started 

Tutorials 
Tutorials and demos are available on the SpaceClaim website. Step-by-step tutorials are also available in 
this Help file. Working through each of the tutorials will allow you to quickly grasp the basics of using 
SpaceClaim. We strongly recommend that newcomers to 3D design run through the tutorials. You will gain 
competency with the functionality featured and the experience will help you master the remaining features 
more easily. 

Text tutorials 

The following tutorials are available in this Help file: 
 

 
Bracket and knob  

In this tutorial, you will: 

 Create a bracket using SpaceClaim's sketching and 3D 
editing tools  

 Create an assembly by importing and modifying a knob to 
fit into your bracket  

 Create a drawing sheet to detail your design 

 
Turbine wheel and housing  

In this tutorial, you will: 

 Create a turbine wheel using SpaceClaim's sketching and 
3D editing tools  

 Create a sheet metal housing for the turbine wheel 

Self-paced training tutorials 

Self-paced, animated training tutorials are available on MySpaceClaim.com, a personalized web portal for 
easy access to everything SpaceClaim. On MySpaceClaim.com, you can: 

 Gain access through a unique user name and password 

 Directly download SpaceClaim software, including purchased new products, updates, and upgrades 

 Learn from self-paced training tutorials 

 Submit a new idea  

To access MySpaceClaim.com, select the Login link at the top of the SpaceClaim.com home page. 
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Bracket and knob assembly 

In this tutorial, you will:  

 Create a bracket using SpaceClaim's sketching and 3D editing 
tools  

 Create an assembly by importing and modifying a knob to fit into your bracket  

 Create a drawing sheet to detail your design 

Please note that as you move back and forth between this help window and the SpaceClaim application, you 
may need to click once in SpaceClaim to make it the active window before following the directions in the 
step.  

Getting started 

1   Create a new design document. 

a   Select New > New Design from the Application menu   to create a new design. 

A blank design containing the sketch grid is displayed in a new Design window. The mode is set to 
Sketch, since that is usually the first step to create a new design.  

The following figure shows some of the interface elements referred to in this tutorial. 

 

 
b   Select Save from the Application menu to name and save your design.  

The name of your design appears as the top-level component in the Structure tree. 

2   Set your design preferences. 

a  Click SpaceClaim Options in the Application menu .  

4 
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b  Click Units. 

c   Select Imperial from the Type drop-down. 

Inches appear in the Length drop-down, the minor grid spacing changes from .1mm to 1/8 in, and the 
minor grid lines per major changes from 10 to 8. This means that you can dimension in inches, and that 
the sketch grid lines are now spaced 1/8 inch apart, and the darker grid lines appear every inch. 

d   Select Decimal from the Decimal/fraction drop-down. 

e   Click OK.  

Creating the bracket 

3   Create the bottom of the bracket using the sketch and pull tools. 

a   Sketch a rectangle that will become the bottom piece of the 
bracket. 

1  Click the Rectangle tool  in the Sketch ribbon group on the 
Design tab. 

2  Click to set the first corner of the rectangle. (Start at the 
upper left.) 

As you move your mouse, a preview of the rectangle is 
drawn, and dimension fields appear. 

3  Enter 1.125, then press Tab and dimension the second side 
by entering 4.281. 

If you make a mistake, click a dimension to edit it. Or click the Select tool   in the Edit ribbon 
group and double-click the rectangle to select it. Then press Delete to delete the rectangle and 
redraw it. 

3  Press Enter to complete the rectangle. 

b   Pull the rectangle into 3D to create the bottom of the bracket. 

1  Switch to 3D mode by clicking the 3D mode tool  in the Mode ribbon group. 

The Pull tool   in the Edit ribbon group is activated, your sketched rectangle now appears as a 
rectangular surface, and the surface appears 
in the Structure tree. 

end that you move your mouse off to the side when pulling to make it 

4  E

4   the bracket by extruding an edge and adding thickness to the 

a   

1  C

i-
e. 

2  Click on the face of your rectangular surface to 
select it. 

The faint yellow cursor arrows show you the 
directions in which you can pull the rectangle. 

3  Drag to begin adding thickness to the 
rectangle. 

You can drag with your cursor anywhere in the Design window – you do not have to drag on the 
Pull arrow itself. We recomm
easier to see your changes. 

nter .483 and press Enter to dimension the pull. 

The surface in the Structure tree is replaced by a solid. 

Create the back of 
resulting surface. 

Extrude an edge to form a surface. 

lick the back edge of the solid with the Pull tool to select it. 

The edge is highlighted and edge options appear in the Options panel and min
toolbar. Move your mouse closer to the mini-toolbar to make it more opaqu
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2  Select the extrude edge option  in the Options panel. 

(You can hover over any option to display a tooltip that explains the option.) 

The Pull arrows change to indicate the two default directions in which you can extrude the edge. 

. 

ing, press and release the spacebar to display a dimension field. 

6  P

ars in the structure tree, below the solid. 

b   

 select it.  

4  P

 and this new solid is 
erged with the first. 

a   

r of the bracket with the Pull tool.  

3  Click the vertical arrow and drag the edge upward to begin creating a surface

4  While dragg

5  Enter 1.4. 

ress Enter to complete the surface. 

This surface now appe

Pull the surface into 3D.  

1  Click the surface you just created to

2  Drag toward the front of the solid. 

3  Enter .483 to match the thickness of your first solid. 

ress Enter to finish pulling and create the surface. 

ace disappearsIn the Structure tree, the surf
automatically m

5   Round the corners. 

Round the inside corner of the bracket.  

1  Click the edge on the inside corne

2  Click the Round Edge pull option  in the Options panel.  

4 ng, press and release the spacebar to display a dimension 

 the round. 

b   

1  Turn the br

3  Drag away from the solid to round the edge. 

  While draggi
field. 

5  Enter .2. 

6  Press Enter to finish pulling and create

Round the outside corner of the bracket.  

acket so you can see the bottom by clicking the Spin tool  in the Orient ribbon group 
and dragging to spin your design. 

Another way to spin is to mouse over an edge in your design. Then press Alt and drag with the 
middle mouse button to spin your design around that edge
Pull tool active. 

l tool, then click the edge that forms the 

. Spinning in this way lets you keep the 

2
outside corner of the bracket. 

  Click the Pul

elease the spacebar to 
dimension field. 

to

6  Click Home 

3  Drag into the solid to round the edge. 

ng, press and r4  While draggi
display a 

5  Enter .4. 

5  Press Enter  finish pulling and create the round. 

 in the Orient ribbon group to view the design in trimetric view. 

6 



SpaceClaim 2008 SP1 User’s Guide 

6   Remove material by sketching and pulling. 

a   Sketch a dimensioned point on the top face of the bottom piece of the bracket.  

1  Click the Select tool  in the Edit ribbon group and click the top face of the 
bottom piece of the bracket to select it.  

2  Click the Point tool  in the Sketch ribbon group. 

You are now in Sketch mode. The sketch grid appears and the Sketch mode tool 
 is active in the Mode ribbon group.  

Because you entered Sketch mode with a face selected, SpaceClaim assumes you 
want to sketch on that face, and orients the sketch grid along that face. 

3  Click  Plan View in the Orient ribbon or the mini-toolbar to view the sketch grid 
head-on.  

4  Place the cursor over the bottom vertex of the face (as shown in the figure), press 
and release Shift, then move your mouse toward the back of the bracket along 
the right edge. Do not press the mouse button. 

A dimension field appears. (You can “Shift+touch” any object in any tool to dimension from that 
object.) 

5  Press and release the spacebar to dimension the point’s distance from the vertex. 

Enter 1.5. If you need to, press Tab to switch dimension fields. 

6  Press Enter to create the point. 

If the point was created at the wrong place, you can press Ctrl+Z or click   in the Quick Access 
toolbar (on the left side of the SpaceClaim title bar) to try again. 

b   Draw an angled line. 

1  Click the Line tool  in the Sketch ribbon group.  

2  Click the point you created in the previous step. 

3  Move the mouse towards the end of the bracket. Do not hold a 
mouse button.   

Two dimensions appear, one for the line’s length, and one for the 
angle formed between the sketch grid’s axis and the line. 

4  Press and release the spacebar to dimension the line. Press Tab to 
switch to the angle dimension. 

Enter 13. (You may need to enter a different value if the angle 
dimension is drawn to a different axis than is shown in the figure.) 

5  Press Tab and continue moving the mouse until it intersects with 
the end of the bracket. 

The edge that forms the end of the bracket highlights when the 
line intersects with it. 

6  Double-click to end the line. 

If the line tool continues to draw line segments, press Esc or right-click and select Finish Line.  
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c   Remove material from the bracket.  

1  Click  Home in the Orient ribbon group to view the design in trimetric view. 

2  Click the Pull tool  in the Edit ribbon group. 

You are now back in 3D mode. The 3D mode tool  is active in the Mode ribbon group.  

3  Click the triangular region created by the line and the edge of the bracket. 

4  Drag downward until all the material is removed. 

Notice that as you pull through the solid of the bracket, the Pull tool assumes that you want to 

remove material, and the cursor changes to   indicate that the pull is subtractive. 

7   Remove material by pivoting and revolving. 

a   Sketch a dimensioned point on 
the side face of the bracket.  

ol menu.) 

1  By dragging with the middle 
mouse button, turn the 
bracket so you can see the 
side opposite the side you 
just removed material from. 
(You can also click the Spin 
tool in the Orient ribbon 
group and drag to spin your 
design or select Right (or 
Left) from the Trimetric to

Click  Pan in the Orient ribbon group and reposition the bracket within the Design window. 

2  Click the Select tool  in the Edit ribbon group and click the side face of the bracket to select it.  

3  Click the Point tool  in the Sketch ribbon group. 

You are now in Sketch mode. You can tell you are in Sketch mode because the sketch grid appears, 
and the Sketch mode tool  is active in the Mode ribbon group.  

Because you entered Sketch mode with a face selected, SpaceClaim assumes you wanted to sketch 
on that face, and orients the sketch grid along that face. 

4  Click  Plan View to view the sketch grid head-on.  

5  Place the cursor over the vertex at the end of the bracket, press and release Shift, then move your 
mouse toward the back of the bracket along the edge. Do not 
press the mouse button. 

A dimension appears. (You can “Shift+touch” any object in any 
tool to dimension from that object.) 

6  Press and release the spacebar to dimension the point’s distance 
from the vertex. 

Enter 1.5. 

7  Press Enter to create the point. 

If the point was created at the wrong place, you can press 
Ctrl+Z or click   in the Quick Access toolbar (on the left side of 
the SpaceClaim title bar) to undo and  try again. 
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b   Draw a line that will become the 
edge to pivot around.  

1  Click the Line tool  in the 
Sketch ribbon group.  

2  Click the point you created in 
the previous step. 

3  Move the mouse until the line 
is drawn at 90 degrees from 
the top to the bottom of the 
bottom piece of the bracket. 

4  Double-click to end the line. 

If the line tool continues to 
draw line segments, press 
Esc or right-click and select 
Finish Line. 

c   Revolve the face to match the angled face on the other side of the 
bracket.  

1  Click the Pull tool  in the Edit ribbon group.  

You are now in 3D mode. The 3D mode tool  is active in the 
Mode ribbon group.  

2  Turn the bracket so you can see the side and top of the bracket by 
clicking the Spin tool   in the Orient ribbon group and dragging a 
small amount to spin your design. 

3  Click the Pull tool again and click the face between the pivot line 
and the end of the bracket. 

4  Click the Revolve tool guide  (located on the right side of the 
Design window). 

5  Click the pivot line. 

The line is highlighted in blue and the Pull arrow changes to show that pulling will revolve the 
selected face.  

6  Drag to begin revolving the face. 

7  While dragging, press and release the spacebar to dimension the revolve. 

Enter -13. 

8  Press Enter to finish the revolve. 

8   Pull to round the angled end. 

a   Round the angled end of the bracket.  

1  Click in the empty space in the Design window to clear your previous 
selections.  

2  Click one of the edges at the end of the bracket to select it.  

(You can drag with the middle-mouse button to quickly spin your design.) 

Notice that the round edge option is selected by default, since the Pull tool 
assumes from your selection that you want to round the edge. 

3  Ctrl+click the other edge to add it to your selection.  

4  Drag into the solid to round both edges simultaneously. Continue dragging until the rounds meet in 
the center to form a full round. 
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9   Sketch and pull to create a hole. 

a   Create a circle at the end of the bracket.   

1  Click the Select tool  in the Edit ribbon group and 
click the top face of the bottom piece of the bracket to 
select it.  

2  Click the Circle tool  in the Sketch ribbon group. 

You are now in Sketch mode. You can tell you are in 
Sketch mode because the sketch grid appears, and the 
Sketch mode tool  is active in the Mode ribbon 
group.  

Because you entered Sketch mode with a face selected, 
SpaceClaim assumes you wanted to sketch on that face, and orients the sketch grid along that face. 

3  Click  Plan View in the Orient ribbon group to view the sketch grid head-on. 

The center of the arc created by the full round is shown with a cross. 

4  Click the center of the arc and drag to begin sketching a circle.  

5  While dragging, press and release the spacebar to dimension the pull. 

Enter .3. 

6  Press Enter to create the circle. 

 

 

2   Pull the circle to create a hole in the end of the bracket.   

1  Click the Pull tool  in the Edit ribbon group. 

You are now in 3D mode. The 3D mode tool  is active in the Mode 
ribbon group.  

2  Turn the bracket so you can see the side and top of the bracket by 
dragging slightly with the middle mouse button. 

3  Click on the circular region to select it.  

4  Drag downward until all the material is removed. 

Notice that as you pull through the solid of the bracket, the Pull tool 
assumes that you want to remove material, and the cursor changes to indicate that the pull is 
subtractive. If you pull away from the solid, it will add material. 

5  Drag with the middle mouse button to spin the bracket so you can see through the hole. 

10 Create a precisely placed hole. 

a   Sketch a construction line so you can center a hole 
on the angle points. 

1  Click the Select tool  in the Edit ribbon group 
and click the top face of the bottom piece of the 
bracket to select it.  

2  Click the Construction line tool  in the Sketch 
ribbon group. 

You are now in Sketch mode. The sketch grid 
appears and the Sketch mode tool  is active in 
the Mode ribbon group.  

10 
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Because you entered Sketch mode with a face selected, SpaceClaim assumes you wanted to sketch 
on that face, and orients the sketch grid along that face. 

3  Click  Plan View to view the sketch grid head-on. 

4  Click the vertex on one side of the angled part, then click the vertex on the opposite side.  

The cursor snaps to each vertex and it is highlighted in green. A dotted construction line appears. 

 

 

b   Sketch a circle at the midpoint of the construction line. 

1  Click the Circle tool  in the Sketch ribbon group. 

Mouse over the construction line. A triangle 
indicates the line’s midpoint.  

2  Click the triangle and move the mouse slowly, until 
the existing hole is highlighted. 

3  Release the mouse button to create a circle that 
matches the diameter of the first hole. 

 

 

c   Pull the circle to create the second hole.  

1  Click the Pull tool  in the Edit ribbon group. 

2  Click  Home in the Orient ribbon group to view the design in trimetric 
view. 

3  Click on the circular region to select it.  

4  Drag downward until all the material is removed. 

5  Drag with the middle mouse button to spin the bracket so you can see 

ruction line is converted to an axis, and now appears in 

6  U

lso remove the sketched points by clicking them with the Select tool, then pressing 

a   Create a pattern with the Move tool. 

through both holes. 

Notice that the const
the Structure tree.  

ncheck the axis in the Structure tree to hide it. 

You can a
Delete. 

11 Create a pattern of holes. 

1  Click the Move tool  in the Edit ribbon group.  

2  C

 Extents from the Zoom 

3  Click the inside surface of the hole that is centered on the angle 

4  C handle axis that is in line with the long dimension of 

d at the back of the bracket.  

6  Release Ctrl and the mouse button.   

heck the Create Patterns option in the Options panel.  

Zoom into your design by selecting Zoom
tool menu to make the next step easier.  

points.  

The Move handle is aligned along the axis. 

lick the Move 
the bracket.  

5  Press Ctrl and drag almost to the roun
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A pattern count parameter is displayed, along with the dimension from the original hole to the 
copied hole. 

 

a   Edit the pattern. 

Enter 4 as the count.   

Four identical, equidistant holes appear on the bracket 
surface. These holes are now part of a pattern. The 
dimension between each hole in the pattern is now 
displayed as well as the other parameters. 

Changes made to one hole will now affect all the others in 
the pattern. For example, if you click the Pull tool and select an axis of one of your holes, then drag, 
you can see all the holes change to slots. (Press Ctrl+Z to undo your change.) 

12 Pull to chamfer the top edge. 

a   Chamfer the top edge.   

1  Click the Pull tool  in the Edit ribbon 
group. 

2  Select the chamfer edge option .  

3  Double-click one of the top edges to 
select the edge loop. 

If the wrong edge loop is selected, 
double-click to select an alternate loop. 

4  Drag into the solid to begin chamfering the edge. 

5  While dragging, press and release the spacebar to dimension the chamfer’s setback. 

Enter .1. 

6  Press Enter to finish pulling and create the chamfered edges. 

b   Press Ctrl+S or select Save from the Application menu  to save your design. 

Importing, modifying, and aligning the knob 

13 Import the knob. 

a   Get the knob model. 

1  Select SpaceClaim Options from the Application menu .  

2  Click Resources.  

3  Click Get Models to display the SpaceClaim Model Library on the SpaceClaim 
website.  

4  Find the TutorialKnob.scdoc file and click Download. 

b   Insert the knob component. 

1  Click Home to orient your bracket.  

2  Click the Insert tool  in the Insert ribbon group to display the Open 
Design window.  

3  Navigate to and select TutorialKnob.scdoc and click Open. 

The knob appears in the Design window inside the outline of a red box with the Move tool active to 
move it to a better position. 

12 
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c   Move the knob so its small end is pointing at the back of the bracket. 

1  Turn the bracket and knob so you can see their sides by clicking the 
Spin tool  in the Orient ribbon group and dragging to spin your 
design. (You might find it easier to use the trimetric views.) 

2  Click an arrow of the Move tool  and drag the knob until it is 
far enough past the bracket so you can turn it on its side. 

b   Create a pattern of grooves with the Move tool. 

1  T
ient 

oup and dragging to spin your 

rom the Zoom tool menu in the Orient group.  

3  Click the curved arrow of the Move tool and drag the knob until it is pointing toward the back of the 
bracket.  

d   Activate the bracket component. 

1  Mouse over the top-level structure in the Structure panel.  

2  Right-click and select New Component. A new component, Component1, appears in the structure 
tree and is in bold, indicating it is activated.  

3  Right-click the new component, Component1, click Rename, and name the new component 
Bracket. It appears in bold to indicate that it is the active component.  

4  In the Structure tree, drag the first object, Solid, and drop it on the new Bracket component. You 
now have an ordered structure for your design.  

5  In the Structure tree, right-click the top-level component and select Activate Component. The top-
level component is now active, making both subcomponents active.  

14 Modify the knob. 

a   Activate the knob as a component, preparing to work on it by itself.  

1  In the Structure tree, mouse over the knob component. 

A red box appears around the knob. 

2  Right-click and select Activate Component.  

The knob component appears in bold to 
indicate that it is active. 

urn the knob so you can see the whole 
groove by clicking the Spin tool in the Or
ribbon gr
design.  

To make this easier, zoom into your design 
by selecting Zoom Box In f

2  Check Create Patterns in the Move Options panel.  

3  Click the Select tool in the Edit ribbon group 
and click both surfaces of the groove. 
Ctrl+right-click on both surfaces. 

4  Re-anchor the Move tool to a central axis so 
you can copy the groove by dragging the 
center of the Move handle, or using the 
Anchor tool guide -  select the Anchor tool 
guide (on the right of the Design window), 
then click on the axis in the center of the 
knob. 

5  Press Ctrl and drag with the right mouse button slowly along the blue rotate arrow.  

SpaceClaim gives you its best idea of what you would like for a pattern. It stops at 45°. If you kept 
going it would snap to a 60° pattern.  

13 
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c   Remove unwanted space with the Fill tool in the Edit 
ribbon. 

1  Rotate the knob so you can see the fillet under the 
head of the knob. 

2  Click on the Select tool  in the Edit ribbon group then 
click on the fillet. 

3  Click on Fill tool in the Edit ribbon  

The fillet becomes flat. 

15 Fit the knob to the bracket. 

a   Measure the small cylinder on the end of the knob. 

1  Zoom out of your design by selecting Zoom Out from the Zoom tool menu.  

2  Click the Measure tool  in the Analysis ribbon, then click on the small cylinder. 

You will see measurements for the circle diameter (3/8 in), circle perimeter (1.178 in) and angle 
between adjacent surfaces (90°). 

Click on other parts of the model to see their dimensions. 

b   Create a hole in the back of the bracket so you can insert the knob into it. 

1  Right-click Bracket in the Structure tree and select Activate Component from the drop-down 
menu.  

A red box appears around the Bracket. 

2  Pan over to the bracket and spin it so you can see the back of its wall and the knob. 

3  Click the back of the bracket then click the Sketch Mode tool  in the Mode ribbon. The grid 
appears on the back of the bracket.  

4  Click the Display tab above the ribbon.  

In the Grid group, click Clip Scene Above Grid. The knob temporarily disappears.  

5  Return to the Design tab and click the Trimetric tool from the Orient ribbon, and select Back from 
the menu. The back of the bracket faces you.  

c   Use a construction line to locate the hole in the center of the back.  

1  Click the Construction line tool  in the Sketch ribbon group.  

Move the cursor over the top line. It snaps to the center of the line. Be careful to click on the top of 
the back and not on the top of the chamfer.  

2  Drag to draw a construction line to the bottom of the surface. 

The line snaps to the center of the bottom edge. Press Esc to exit the tool.  

3  Click the Circle tool  in the Sketch ribbon group and move the mouse over the top of the 
construction line. (Do not press a mouse button.)  

4  Press and release the Shift key to dimension from another point, then move the mouse slowly in the 
direction you want to place the circle. In the dimension box, type the value where you want to 
locate the circle center (.742). Press Enter. The cursor is moved to center of the hole. 

5  Move the mouse slowly and a second dimension box appears into which you can type the diameter of 
the circle (.376). Press Enter. Press Esc to exit the tool.  

6  Click the Pull tool in the Edit ribbon group tool then click on the center of the hole so the direction 
arrows are over the hole. 

7  Select the Up To tool guide on the right of the Display window. Move the mouse to the side of the 
model and roll the middle button to select the hidden surface. When it is highlighted, click. The 
circle goes to the surface and becomes a hole. 
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d   Create an assembly. 

1  Click the knob in the Structure tree to make it reappear in 
the display. 

2  Drag with the middle mouse button to spin the model so the 
knob is on the right and the bracket is on the left. 

3  Click the Select tool in the Edit ribbon group, select the 
surface of the small end of the knob, then Ctrl+click the 
inside surface of the hole. Click the Center tool  in the 
Assembly ribbon. 

The knob moves so its end is aligned with the hole. 

 

4  Click the flat surface of the knob just below the revolve 
surface. 

Move the mouse to the side of the bracket, turn the scroll 
wheel to highlight the back of the bracket. Ctrl+click the side. 

 

 

 

 

 

5  Select the Align tool  on the Assembly ribbon. The 
knob slips through the hole in the bracket.  

The surfaces that move are those of the model you 
pick first.  

b.  
6  Spin the assembly around to see that you assembled 

the bracket and the kno

Creating the drawing sheet 

16 Create a drawing sheet for your design. 

a   Shut off the display of the knob by unchecking it in the Structure tree.  

b   Click the Application Menu and select New > Drawing Sheet.  

A new window appears with a drawing sheet form that includes the parts of your model in three 
orthogonal orientation for third angle projection and a format for entering dimensions and general 
information. Click the Select tool   and move the parts of the model so they are closer together.  

c   Make the sheet smaller by clicking on the Detailing tab above the ribbon.  

1  Click on the Format tool in the Sheet Setup ribbon.  

2  Select Format A Portrait size. The bracket drawing sheet moves to the center of the window in 
portrait form. 

You can toggle between the model and the drawing sheet by using the tabs below the Design 
window.  

17 Annotate the design. 

a   Enter width of bracket back. 

1  Click on the Design tab above the ribbon. To make this easier, zoom into the bracket components by 
selecting Zoom Box In from the Zoom menu in the Orient ribbon.  

2  Click on the Detailing tab again then click on the Dimension tool in the Annotation ribbon. 
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3  Click on the left edge of the wall of the bracket (bottom left of drawing) then click on its right edge. 
Do not use the Ctrl key. 

A dimension box displays the width of the wall. 

4  Move the mouse up (no buttons should be pressed) until the dimension box is located where you 
want it, then click. 

b   Enter the width of the bracket base. 

1  Click on the top edge of the bracket base (bottom right of drawing) then click on its bottom edge. Do 
not use the Ctrl key. 

A dimension box displays the width of the base. 

2  Move the mouse over (no buttons should be pressed) until the dimension box is located where you 
want it, then click. 

Notice the dimension is the same that you used to create the bracket 

c   Enter the height of the bracket back. 

1  Click on the bottom edge bracket base (bottom right of drawing) then click on the top edge of its 
back. Do not use the Ctrl key. 

A dimension box displays the height of its back.  

2 Click and move the mouse (no buttons should be pressed) until the dimension box is located where 
you want it then click again. 

d   Enter dimensions for the top view of the bracket (top of drawing). 

1  Click on the edge of the hole at the end of the bracket. 

Move the mouse (no buttons should be pressed) until the diameter of the hole is located where you 
want it, then click. You may need to click on the arrow to move it to the edge oh the circle. 

2  Click on the top of the back of the bracket.  

Move the mouse (no buttons should be pressed) to the bottom of the rounded edge. When you 
move the mouse, many dimensions appear, including the tangent point of the bottom edge. Click 
and move the dimension until you have placed it where you want it. 

Notice the dimension is 4.281, which is what you entered to create the solid.  

e   Create a note. 

1  Click on the Note tool in the Annotation ribbon. 

MB1 where you want the note to be on the drawing and begin to type your note. Press Esc to exit 
the tool.  

2  Click on the Note Leader tool  in the Annotation ribbon.   

Mouse over the note to see where you can attach the leader. Click on one of those places and drag. 
When the leader reaches where you want it to end, release the mouse and press Esc to exit the 
tool.  

3  Create a Material Finish Symbol. 

Select the Material Removal Required tool from the Surface Finish list in the Annotation ribbon. 
Place the mouse where you want to place the symbol, click, then drag to the end of the symbol. 
Double-click to end the line.  

4  Change the design from the drawing. 

You can see the solid models in the drawing by pressing the middle mouse button and spinning the 
drawing.  
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18 Modify the design from the drawing sheet. 

a   Change the design from the drawing. 

1  Change the size of the .3 diameter hole at the bottom of the bracket.  

Turn the drawing so you can see inside the hole by clicking the Spin tool  in the Orient ribbon 
group and dragging to spin your design. 

Click on the Design tab above the ribbon. 

Enlarge the hole by selecting Zoom Box In from the Zoom menu in the Orient ribbon.  

Select the Pull tool in the Edit ribbon group then select the inside diameter of the hole. Press and 
release the spacebar and enter a radius of .2. 

Zoom out. The dimension has been changed to .4 on the drawing. 

2  Two views of the changed drawing.  

To see the drawing view, right-click and select View > Flat View.  

To view the whole drawing, right-click and select View > Home. 

Turbine wheel tutorial 

This tutorial will be inserted in the next version of the Help.  
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SpaceClaim interface 
SpaceClaim’s graphical user interface (GUI) was designed to conform (within reason) to Microsoft Vista 
standards and contains the toolbars, buttons, and windows associated with a Vista-compliant graphical 
application. As a result, only those features of the GUI that relate to performing SpaceClaim-specific tasks 
are explained in this guide. We assume, for example, that you are familiar with standard Windows 
conventions, such as dragging a window’s title bar to move the window, or clicking the close button to close 
the window. 

To take advantage of the full range of SpaceClaim features, we recommend using SpaceClaim with a scroll 
wheel mouse or with a 3D Connexion SpaceBall or SpaceNavigator. However, SpaceClaim is also fully 
operational with a laptop's touchpad and integrated mouse buttons. You can use the nub as a scroll wheel, 
and configure the laptop so that pressing both buttons simultaneously behaves the same as pressing a 
middle mouse button. 

This image shows the major interface elements in the SpaceClaim application: 

 
The Application menu contains file-related commands and options to customize SpaceClaim. 

The Quick Access toolbar can be customized so that it contains the file-related shortcuts you use most 
often. 

The Ribbon contains all the tools and modes you need to design, detail, and display models, drawing sheets, 
and 3D markups. 

The Design window contains your model. If you are in sketch or section modes, it also contains the sketch 
grid to show the 2D plane on which you are working. The tool guides for the selected tool appear on the 
right side of the Design window. The cursor also changes to indicate the selected tool guide. A mini-toolbar 
places commonly used options and actions close to the cursor. 

The status bar displays messages and progress information about your actions on the current design.  

The Message icon displays error messages as they occur. Click the icon to display all the messages currently 
relevant to your design. Click a message to highlight the object referenced by the message. 
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Panels 

The panels initially appear along the left side of the application window. You can dock and detach these 
panels. 

The Structure tree contains the Structure tree, which shows you each of the objects in your design. You can 
quickly show or hide any object using the checkbox next to the object's name. You can expand or collapse 
the nodes of the tree, rename objects, create, modify, replace, and delete objects, as well as work with 
components. 

The Layers panel allows you to group objects and set their visual characteristics, such as visibility and color. 

The Selection panel lets you select other objects related to the one currently selected. 

The Groups panel stores groups of selected objects. Selection, Alt+selection, and move anchoring, axis, and 
ruler dimension information is all stored with the group.  

The Options panel allows you to modify the functions of the SpaceClaim tools. For example, when you use 
the Pull tool, selecting an edge and then selecting the Chamfer Edge option creates a chamfer instead of a 
round when you pull the edge. 

The Properties panel displays details about the selected object. You can change the property values to 
change the object. 

Working with objects in the Structure tree 

The Structure tree contains the Structure tree, 
which shows you each of the objects in your 
design. You can quickly show or hide any object 
using the checkbox next to the object's name. You 
can expand or collapse the nodes of the tree, 
rename objects, create, modify, replace, and 
delete objects, as well as work with components. 

The top-level design (called StructureTree in the 
image on the right) is also a component. The 
figure on the right shows some objects that can 
appear in a Structure tree.  

When you select a solid or surface (or other 
object) in the Design window, it is highlighted in 
the Structure tree. 

You can Ctrl+click or Shift+click objects in the 
Structure tree to select multiple objects at once. 

To set the visibility of objects 

There are now three methods for setting the 
visibility of objects in the Design window: 

 Right-click an object in the Structure tree and select Always Visible from the context menu. 

 Uncheck the box in the Structure tree to hide the object in the Design window. The object icon is 
displayed in gray. You can also right-click an object in the Design window and select Hide (or select it 
in the Design window and press Ctrl+H) to turn the visibility of the object off. 

 Check the box next to the object in the Structure tree to set the visibility of the object to the layer 
visibility.  

If the layer visibility is on, the icon appears normally. If the layer visibility is off, the icon appears like the 
Solid_LayerHidden icon in the figure on the right. You cannot work with hidden objects in the Design 
window. 
Do it faster Shift+click and Ctrl+click multiple objects to work with them as a group.  
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To find an object in the Structure tree 

Right-click any solid, surface, plane, axis, or other object in the Design window and select Locate in 
Structure Tree to display the object in the Structure tree. If the Structure panel is not open, it is 
displayed. 

To expand or collapse components 

Click  or press + on the number pad to expand a component. Click   or press - on the number pad to 
collapse it. Right-click any component (including the top-level component) and select Expand All or press * 
on the number pad to expand the component and all its subcomponents. 

To rename objects 

Right-click an object in the Structure tree and select Rename or press F2 to rename the selected object. 

Once you save a file, the top-level design component's name is set to the file name and it cannot be 
renamed. 

To move objects into components 

Drag any object or component to move it into another component.  

To use an object as a secondary selection for a tool 

Alt+click an object in the Structure tree.  

For example, if you want to revolve an object, you can click to select the face to Pull, then Alt+click an axis 
in the Structure tree to set the revolve axis for the pull. 

Working with layers 

A layer can be thought of as a grouping mechanism for visual 
characteristics. Visual characteristics include visibility and color. 
 Layers can be managed in the Layers panel and accessed and 
modified in the Layer tool in the Style ribbon group on the Display 
tab. 

Layers are especially useful when you want to hide annotation 
planes. Any objects created are automatically placed on the active 
layer. 

To create a layer 

Right-click in the Layers panel and select New.  

This layer becomes the activate layer. Any objects created are automatically placed on this layer. 

To rename a layer 

Right-click the layer in the Layers panel and select Rename or click the layer name and slowly drag to the 
right.  

Layer0 cannot be renamed. 

To delete a layer 

Right-click the layer in the Layers panel and select Delete.  

Layer0 cannot be deleted. 
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To place an object on a layer 

1   Select the solid, surface, or component. 

The Layer tool in the Style ribbon group on the Display tab displays the layer of the selected object. If 
no object is selected, it displays the layer on which new objects are placed. It is blank if selected objects 
are on different layers.  

2   Select a different layer from the drop-down list to place the selected object(s) on that layer. 

You can also create a new layer to place the selected object onto that layer. 

To set layer visibility 

1   Select a layer in the Layers panel. 

2   Click  to show the objects on the layer. Click   to hide them. 

If an object is located on a layer with the visibility turned off, and the object in the Structure tree is set 
to show visibility by layer, the object is not visible in the Design window, and cannot be acted on by the 
design tools. Layer visibility can be overridden in the Structure tree. 

To set the visibility of layout lines and imported, DWG and DXF lines 

Select Solid or Hidden from the layer's line drop-down in the Layers panel. 

To modify the layer color 

1   Select a layer in the Layers panel. 

2   Select a color from the  drop-down. 

You can also specify a custom color by selecting Custom Color and using the Color window.  
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Groups 

You can create a group from any set of selected objects. 
Selection, Alt+selection, Section plane location, move 
anchoring, axis, and ruler dimension information is all stored 
with the group. You can use groups in combination with the 
SpaceClaim API to change these parameters, or use them as 
a way to indicate to others your design intentions about 
which sort of changes you expect them to make to your 
design. 

A Round Group is also created each time you fill a round. You 
can reattach a group of rounds as long as some portion of the 
original edges (or faces that bordered the edges) still exists in 
your design. 

To create a group 

1   Select any set of 3D objects. 

2   Click Create Group in the Groups panel or press Ctrl+G. 

The group appears in the list. A status message reports the number of faces in the group. Mouse over 
the group to highlight the objects in the group and click the group to select them. Properties and other 
information, such as the selected axis for the last Move rotation, are saved with the group. 

To reattach a round 

1   Right-click the Round Group in the Groups panel. 

2   Select Reattach Round from the context menu. 

To rename a named group 

1   Right-click the group in the Groups panel. 

2   Select Rename from the context menu. 

3   Enter the new name for the group and press Enter. 
Do it faster Click the group, then click it again to enter a new name. 

To delete a named group 

1   Select the group in the Groups panel. 

2   Click Delete Group. 

You can also right-click the group and select Delete Group from the context menu. 
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Options panel 

The Options panel allows you to modify the functions of the SpaceClaim tools. For example, when you use 
the Pull tool, selecting an edge and then 
selecting the Chamfer Edge option creates a 
chamfer instead of a round when you pull the 
edge.  

Options are enabled when the relevant 
geometry is selected. 
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Properties 

Components, surfaces, and solids selected in 
their entirety (that is, with triple-click in the 
Design window, or selected in the Structure 
tree) display their properties in the Properties 
panel. The Properties panel initially appears on 
a Properties tab on the Options panel. When 
detailing your design, we recommend making 
Properties a separate panel and placing it above 
the other so that you can see object properties 
and tool options simultaneously. 

The figure on the right shows the properties for 
a general view on a drawing sheet. 

To modify an object's properties 

Select an object in the Structure tree or right-
click the object in the Design window and select 
Properties. 

To create a custom property for your 
design 

Document properties are displayed when you select the top-level design in the Structure tree. Right-click in 
the Properties panel and select Add Property to create a custom property. Expand the property to display 
its value. Enter a name for the property, select its type (date, Boolean, number, or string), and enter its 
value. 

onent 

ructure tree. 

e of the material in the Material Name property. 

5   

 the same 
SpaceClaim session, SpaceClaim displays that value in the Density property for you. 

To create or specify a material for a comp

1   Select a component in the St

2   Select the Properties panel. 

3   Enter the nam

4   Press Enter. 

Enter the density of the material in the Density property. 

If you specified the density for the material elsewhere in the design, or specified it in
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SpaceClaim shortcuts 

You can use the following shortcuts to quickly access tools, tool guides, and other SpaceClaim commands. 
You can display these on the ribbon bar by selecting Show tool KeyTips in the SpaceClaim Popular 
options. 

Bend B 

Circle C 

Escape Esc 

Fill F 

Home H 

Line L 

Pull  P 

Rectangle R 

Select S 

3D Mode D 

Section Mode X 

Sketch Mode K 

Up To tool guide U 

Move M 

Spin Drag with middle mouse button 

Pan Shift+drag with middle mouse button 

Zoom Ctrl+drag up and down with middle 
mouse button 

Snap View Ctrl+Shift+middle mouse button 

Zoom Extents Z 

 

Application menu Alt+F 

Close document Ctrl+F4 

Complete Ctrl+Enter 

Copy Ctrl+C 

Copy Special Ctrl+Alt+C 

Create Group Ctrl+G 

Cut Ctrl+X 

Cut Special Ctrl+Alt+X 

Delete Del 

Detach Face Ctrl+D 

Exit Alt+F4 

Font Ctrl+Shift+F 

Font Size Ctrl+Shift+P 
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Invert Selection Ctrl+Shift+I 

Display next Design window Ctrl+Tab 

Display previous Design 
window 

Ctrl+Shift+Tab 

Move Sketch Grid in Ctrl+right arrow 

Move Sketch Grid out Ctrl+left arrow 

Display the previous view of 
your design 

Alt+left arrow 

Reapply the last view to your 
design 

Alt+right arrow 

New Ctrl+N 

Open Ctrl+O 

Paste Ctrl+V 

Print Ctrl+P 

Print Preview Ctrl+F2 

Redo Ctrl+Y 

Save Ctrl+S 

Select All Ctrl+A 

Bold Text Ctrl+B 

Italicize Text Ctrl+I 

Underline Text Ctrl+U 

Toggle Visibility Ctrl+H 

Undo Ctrl+Z 

Zoom In Ctrl+ + 

Zoom Out Ctrl+ - 

Expand entire node in 
Structure tree 

* on number pad 

Expand selected node in 
Structure tree 

+ on number pad 

Collapse selected node in 
Structure tree 

- on number pad 
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Mouse gestures 

You can use mouse gestures in the Design window as shortcuts to common actions and tools.  

You can make the following gestures while holding down the right mouse button. To cancel a gesture, 
pause for one second. 
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SpaceClaim objects 
The SpaceClaim interface describes objects slightly differently than other modeling software you might be 
familiar with. 

Document 

A SpaceClaim .scdoc may contain any combination of design versions, associated drawing sheets, and 3D 
markup slides. 

Design 

A design is a 2D or 3D model, which contains at least one top-level component. 

Component 

A component consists of any number of objects, such as solids and surfaces. You can think of a component 
as a "part." A component can also contain any number of sub-components. You can think of a hierarchy of 
components and subcomponents as an "assembly." 

Object 

An object is anything recognizable by SpaceClaim tools. For example, 3D objects include vertices, edges, 
faces, surfaces, solids, layouts, planes, axes, and origins. 2D objects include points and lines. 

Examples of some object types are shown below: 

 

  

Vertex Edge in 3D mode and the same 
edge in Section mode 

Face in 3D mode and the same 
face in Section mode 

 

  

Surface Solid 

 

 

 
  

Plane Axis Origin 
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Body 

In SpaceClaim, a body is a solid or surface. 

Mating condition 

Components are aligned using mating conditions. 

Curve 

An imported Curve file. 

Working with components 
The Structure tree contains the Structure tree, which shows you each of the objects in your design. You can 
quickly show or hide any component 
using the checkbox next to the object's 
name. You can expand or collapse the 
nodes of the tree, rename objects, 
create, modify, replace, and delete 
objects, create components, copy 
components, make components 
independent, open a component in a new 
design window, set the component to be 
a sheet metal component, make a 
component active, make a component 
independent, delete, rename, or display 
properties. 

Offset, mirror, and shell relationships stay 
with a solid when it is moved to another 
component, unless the relationship would 
link two components when it is moved. 

The top-level design (called 
StructureTree in the image on the 
right) is also a component. 

If you are working with a single instance 
of an external component, make that 
instance independent to prevent your 
changes from being made to the external 
component file. Once you make a copied 
sub-component independent, you can modify it without changing any of the other instances of that sub-
component. Or you can modify one of the other instances to change all the copied sub-components except 

f the same external component internal creates a second 

the one you made independent. 

If your design includes multiple copies of an external component, making one of them internal does not 
affect the other copies. Making another copy o
instance of the
 

 same internal component. 

Do it Shift+click and Ctrl+click multiple objects to work with them as a group.  
faster 

About lightweight components 

When you insert an external file into your design, if you have the Enable lightweight assemblies advanced 
SpaceClaim option enabled, only the component's graphic information is loaded. This allows you to quickly 
view the component with the Orient tools and load the geometry information when you are ready to work 
with it in SpaceClaim.  
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To create a component 

Right-click top-level design (or another component) in the Structure tree and select New Component from 
the context menu to create a new component or sub-component. 

To copy a component 

1   Select a component and click the Copy tool or press Ctrl+C. 

2   Select the component under which you want to create a copy and click the Paste tool or press Ctrl+V. 

An instance of the component is created, which is linked to the original component. All changes made to 
the copied component are also made to the original unless you make the copy independent.   

To insert a component or assembly 

1   Select the Insert File tool   in the Insert ribbon group. 

2   Navigate to the component and double-click to insert it. 

The component is placed in the center of the workspace and its sub-components (if it is an assembly) 
appear in the Structure panel.  

To activate a component 

Right-click the component and select Activate Component from the context menu. 

If the component is lightweight, it is also loaded. Any new objects are created within this component. A 
component must be active before you can cut or copy it for pasting. 

To externalize a component 

1   Right-click the component and select Open Component from the context menu. 

The selected component appears in a new Design window. 

2   Select Save As from the Application menu to save the component as a separate file. (DO NOT check the 
Save as copy box.) 

The icon in the Structure tree of the original design changes to reflect that the component is now 
external.  

To copy an external component into your design 

Right-click the component and select Use Internal Copy from the context menu. 

The selected component is copied into your design. Any changes you make to the component do not affect 
the original, external file. 

To load a lightweight component 

Right-click the component and select Load Component from the context menu. 

The component and all its subcomponents' geometry information is loaded, and you can work on the 
components with any SpaceClaim tool. 

To make a component independent 

Right-click the inserted, dependent component in the Structure tree and select Make Independent from 
the context menu. 

The icon in the Structure tree changes, and the component is renamed <OriginalComponentName>2. 

If your design consists of multiple instances of the same external component, and that external component 
also contains multiple instances of another external subcomponent, making the subcomponent independent 
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makes both the subcomponent and its parent component independent. Any parent component in the tree, 
all the way up to the top-level design component, will also be made independent.  

To create or specify a material for a component 

1   Select a component in the Structure tree. 

2   Select the Properties panel. 

3   Enter the name of the material in the Material Name property. 

4   Press Enter. 

5   Enter the density of the material in the Density property. 

If you specified the density for the material elsewhere in the design, or specified it in the same 
SpaceClaim session, SpaceClaim displays that value in the Density property for you. 

Getting help 
We offer several resources you may find helpful when using SpaceClaim. 

Online help 

Detailed tooltips are provided for each tool within SpaceClaim. You may find that a careful reading of the 
tooltip provides all the information you need to use the tool. 

If you need more information, click   in the tab bar or press F1 while the tooltip is open to display the 
online help for the tool. The online help provides step-by-step instructions, animations, and examples. 

Customer support 

SpaceClaim is committed to providing you with every opportunity to communicate directly with us so you 
benefit by helping us continuously improve our products, services, and build our growing community. We 
want to help you apply SpaceClaim efficiently to solve your product development problems. 

SpaceClaim's annual lease license includes subscription services, so you can be confident that you will 
always have access to expert technical resources and the latest software. Subscription services provide the 
latest product releases and upgrades, direct access to SpaceClaim technical resources via phone, email, and 
chat, and personalized access to our customer portal: MySpaceClaim.com. 

To contact customer support: 
 Email: support@spaceclaim.com 
 Mail: SpaceClaim, 150 Baker Ave Ext., Concord, MA 01742 
 Toll free phone: 1.800.636.4215 
 Local/International phone: 1.978.482.2281 

Phones are staffed 8:30am - 6pm EST, Monday-Friday, excluding US national holidays 

When contacting customer support, the following information may be needed to properly diagnose your 
issue: 

 SpaceClaim version number 
 Environment details (operating system, hardware, graphics card) 
 Brief description of your issue 
 Detailed steps to reproduce the issue 
 Related files (journal files, data files) 

Gathering this information before contacting customer support could help us find a resolution more quickly. 

MySpaceClaim.com 

MySpaceClaim.com is a personalized web portal for easy access to everything SpaceClaim. The web portal 
provides the ability to: 

 Gain access through a unique user name and password 
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 Directly download SpaceClaim software, including purchased new products, updates, and upgrades 

 Search the product knowledge base for answers to common questions 

 Learn from self-paced training tutorials 

 Check on the status of your license 

 Submit a new idea to influence product development 

 Find the status of outstanding issues 

To access MySpaceClaim.com, select the Login link at the top of the SpaceClaim.com home page. 

To check for updates 

When you open the SpaceClaim application, it automatically checks for updates. If updates are available, a 
message appears in the status bar. 

1   Select SpaceClaim Options from the Application menu and click Resources.  

2   Click Check for updates to check for recent software updates. 

To download models, contact us, or find the version number 

1   Select SpaceClaim Options from the Application menu and click Resources.  

2   Click:  
 Get models to download models from the SpaceClaim model library 
 Contact us to contact us through our website 
 About to find the version number of the SpaceClaim software you are running.  

32 



SpaceClaim 2008 SP1 User’s Guide 

Designing 
The tools you use for 2D and 3D sketching and editing are found in SpaceClaim's Design tab. With the 
design tools, you can sketch in 2D, generate and edit solids in 3D, and work with assemblies of solids.  

In SpaceClaim, there are three modes you can use to design: Sketch, Section, and 3D mode. You can switch 
between these modes at any time. 

When creating designs, you will use the following tools most often: 
 

 

Use the Select tool to select 2D or 3D objects in your design for editing. You can select vertices, 
edges, axes, faces, surfaces, solids, and components in 3D. In 2D, you can select points and lines. 
You can also use this tool to change the properties of recognized or inferred objects. 

 
Use the Pull tool to offset, extrude, revolve, sweep, draft, and blend faces; and to round or chamfer 
corner edges. 

 

Use the Move tool to move any single face, surface, solid, or component The behavior of the Move 
tool changes based on what you have selected. If you select a face, you can pull or draft it. If you 
select a solid or surface, you can rotate or translate it.  

 
Use the Combine tool to merge and split solids and surfaces. 

 
Use Section mode to create and edit designs by sketching on and editing any cross-section through 
the design. 

Design tools are grouped into the following ribbon groups: 
 

Clipboard Cut, copy, and paste 3D objects. 

Orient Spin, pan, and zoom your design. You can also select or create 
a view. 

Sketch Create and edit lines, arcs, splines, rectangles, circles, and 
points in 2D. 

Mode Switch between sketching in 2D, editing a cross-section, and 
creating and editing objects directly in 3D 

Edit Edit 2D and 3D geometry. 

Intersect Merge or split solids and faces. 

Insert Create relationships between the components in your design. 

Assembly Import other components and orient them within your design. 

Analysis Find lengths, angles, and volumes. 

Press and hold Esc to cancel out of any design action that is taking too long. 

When using any tool guide, you can click an empty point in the Design window to clear the tool guide 
selection and return to the previous action within the tool. 

2D and 3D design modes 
In SpaceClaim, there are three modes you can use to design: Sketch, Section, and 3D. These modes make 
it clear when you are working in 2D vs. 3D, and clarify the difference between working in cross-section 
(where you can alter 3D objects) and sketching (where you cannot alter 3D objects) 

To switch modes 

Click a tool in the Mode ribbon group. 
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Detailed instructions

1   Click a tool in the Mode ribbon group. 

You can also right-click an empty area of the Design window and select Sketch Mode, Section Mode, 
or 3D Mode from the context menu, or press K (for Sketch mode), X (for Section mode), or D (for 3D 
mode). 

If you are sketching, you can also click Return to 3D mode  in the Sketch mini-toolbar. 

2   If you are switching from 3D mode to one of the other modes, select a plane to sketch on or create the 
cross-section. 

Mode ribbon group 

 
The Mode ribbon group contains the following tools: 

 Sketch mode displays the sketch grid, so you can use any of the sketch tools 
to sketch in 2D. 

 
Section mode lets you edit solids and surfaces by working with their edges 
and vertices in cross-section. You can also use all the sketch tools in Section 
mode to create and edit solids and surfaces in cross-section. 

 3D mode lets you work directly with objects in 3D space.  
 

Editing in cross-section 
Use Section mode to edit solids by working with their edges and vertices in cross-section. Since you are 
working with a cross-section of geometry in section mode, pulling a line pulls a face, and pulling a vertex 
pulls an edge. For example, to rotate a face around an edge, select the line that represents the face, 
Alt+click the vertex that represents the edge, and pull. Moving a sketched line in Section mode does not 
move the solid it is sketched on. You must move a section line (a line that represents a face) to modify a 
solid in Section mode. 

Hatching is used to show the intersection of the cross-section plane and a solid. Arc centers are shown as 
small cross marks. Hatching appears bolder inside faces to indicate what is shown in a cross-section view. 
(See Examples, below). 

You can use the following tools: Select, Pull, Move, Combine, Split Body, Shell, Offset, Fill, and all sketch 
tools. Use the Select tool to edit spline faces (represented by a spline in cross-section). You can also cut, 
copy, and paste. We recommend that you clip the scene above the grid to enhance the visibility of the 
cross-section 

To edit in cross-section 

1   Select or de-select options based on whether you want to maintain and view relationships while you edit 
in cross-section. 

2   Select the face you want to use to create the cross-section. 

If you are in a drawing sheet with cross-section views, you do not have to choose a face, as the plane 
of the drawing sheet is automatically used as the section plane. 

3   (Optional) Move or rotate the cross-section grid and click the Section tool when you are finished. 
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4   Click and drag the edges and vertices of the cross-section to edit them. 

You can also bend edges with the Bend tool, and pull section points (edges) and section lines (faces) 
with the Pull tool. If you set the Auto-extrude/revolve sketches in Section mode Advanced 
SpaceClaim option, sketch made with the sketch tools are automatically extruded or revolved to form 
surfaces and solids when you begin the sketch on the edge of an existing surface or solid. If you do not 
begin the sketch on an existing edge, you are switched to Sketch mode. 

We recommend zooming into your design so that it is easier to select the correct entity. For example, if 
you are trying to select an edge, but your design appears very small in the Design window, it is possible 
to accidentally select a midpoint or endpoint of the edge instead. Moving the midpoint or endpoint of an 
edge will not be reflected by a mirrored entity. 

Options 

The following options are available in the Section tool: 
 

Maintain 
Mirror Select this option to maintain the influence of mirrors in your design while editing. 

Maintain 
Offset 

Select this option to maintain the influence of baselines in your design while editing. 
Baseline faces are shown as blue edges when viewed in cross-section. 

Examples 

 
Bold hatching indicates the hatching that would be shown on a drawing sheet cross-section view 

 
Extruding while sketching in Section mode 

Cutting, copying, and pasting 
Select a tool from the Clipboard ribbon group to cut, copy, or paste any 2D or 3D object. You can use these 
tools any time, even when you are designing with other 2D or 3D tools. 
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To cut an object 

1   Select the object. 

2   Select the Cut tool  from the Clipboard ribbon group. 

You can also press Ctrl+X or right-click in the Design window and select Cut from the context menu. If 
you cut the face of a solid, it is converted to a surface. 

To copy an object 

1   Select the object. 

2   Select the Copy tool  from the Clipboard ribbon group. 

You can also press Ctrl+C or right-click in the Design window and select Copy from the context menu. 

To paste an object into the Design window 

1   Cut or copy the object. 

2   Select the Paste tool  from the Clipboard ribbon group. 

You can also press Ctrl+V or right-click in the Design window and select Paste from the context menu. 

To paste an object onto a face 

1   Select all the faces of the object. 

2   (Optional) Alt+click the face of the object you want to attach to the face. 

The face is highlighted in blue. 

3   Cut or copy the selection. 

4   Click the face onto which you want to paste the object. 

5   Paste the object. 

The object is pasted on the face at the location you clicked. The blue face is attached to the clicked 
face. 

To paste a round onto another edge 

1   Select the face of the round. 

3   Cut or copy the face. 

4   Click the edge onto which you want to paste the round. 

5   Paste the round. 

To delete an object 

1   Right-click the selected object (or set of objects). 

2   Press Delete. 

If you want to delete something and fill the gap with neighboring geometry, or create faces in the gap, 
you should use the Fill tool. 

If you delete the face of a solid, it is converted to a surface. 
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Dimensions 
You can dimension every element in your design, from 
lines in sketches to faces of solids. In SpaceClaim, 
dimensions are not constraints. Rather, they are tools 
for precise control during the creation or modification of
a design. In SpaceClaim, if you do want to save a
dimension with your design, use the Ruler Dimension 
option when pulling or moving. You can save the ruler 
dimensions as Groups for later edits.  

 
 

Whenever dimension fields appear, you can press the 
spacebar or click on them to enter a value, and press 
Tab to switch between fields. You can enter expressions as dimension values. 

The following expression elements are available: 

 Infix (dyadic) operators:  + - * / ^ 

 Prefix (monadic) operators:  + - 

 Functions:  sin cos tan asin acos atan sqrt log log10 exp 

 Constants:  pi e root2 root3 

 Units:  m cm mm yd ft in ' " deg rad 

Normal precedence rules apply: 

1 + 2 * 3 ^ 4 = 1 + (2 * (3 ^ 4)) = 163 

Parentheses are required for expression arguments and optional for simple arguments: 

 sqrt 2 = sqrt(2) = 1.4142... 

 sqrt 2*2 = (sqrt 2) * 2 = 2.8284... 

 sqrt(2*2) = 2 

Missing operators are inferred: 

 1 1/2 = 1 + 1/2 

 1’6” = 1’ + 6” 

 1ft 6in - 17in = 1ft + 6in - 17in 

 1 2 3 4 5 = 1 + 2 + 3 + 4 + 5 = 15 

 (1)(2)(3)(4)(5) = (1) * (2) * (3) * (4) * (5) = 120 

 2(1 + 2) = 2 * (1 + 2) = 6 

 sqrt 2 sqrt 2 = sqrt 2 * sqrt 2 = 2 

 4(4atan(1/5) - atan(1/239)) = 4 * (4 * atan(1/5) - atan(1/239)) = pi 

Units are applied to previous terms if units were not specified and are applied to subsequent terms unless 
you override them: 

 1 + 1cm = 1cm + 1cm 

 1cm + 1 = 1cm + 1cm 

 1cm + 1 + 1mm = 1cm + 1mm + 1mm 

 1cm + 1 1/2 mm = 1cm + 1mm + 1mm / 2 

Trigonometry functions work in radians by default, but you can enter degrees: 

sin(45 deg) 
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Numbers support standard form, but e is a built-in constant: 

 2e2 = 200 
2e 2 = 2 * e * 2 = 10.873... 

 2e-2 = 0.02 
2e – 2 = 2 * e – 2 = 3.436... 

 2e1 = 20 
2e = 2 * e 

To dimension a sketch line during creation 

1   Press the spacebar (or just type) to enter a value in the highlighted 
field. 

2   Press Tab to switch between dimension fields. 

3   Repeat step 2 until you have entered all the dimensions. 

4   Press Enter to accept the values and return to sketching. 

The dimensions persist until you select another tool or begin drawing another sketch object. 

To dimension the start or end point of a sketch line from another point in your 
sketch 

1   Hover the mouse over the point from which you want to dimension. 

2   Press Shift. 

As you move your mouse around the sketch grid, a dimension will appear from the 
point you indicated to the mouse location. 

3   Press the spacebar (or just type) to enter a value in the highlighted field. 

4   Press Tab to switch between dimension fields. 

5   Repeat step 4 until you have entered all the dimensions. 

6   Press Enter to accept the values and place the point that 
begins or ends your line. 

 sketch lines 

3   e item's size or location by doing one of the 
w

 r (or just type) to enter a value in the 

 

 Press Shift while dragging to dimension from the current mo

2   Press the spacebar (or just type) to enter a value in the highlighted 

4   Repeat step 3 until you have entered all the dimensions. 

To dimension existing

1   Click the Select tool. 

2   Select the sketch object you want to change. 

Dimension th
follo ing: 

Press the spaceba
highlighted field. 

 Drag the selected item to change its size or location. 

Hover over a point in your design and press Shift to 
dimension between the selected object and that point. 

use location. 

To dimension while moving or pulling 

1   Select a direction for the move or pull. 

field. 

3   Press Tab to switch between dimension fields. 
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5   Press Enter to accept the values and move or pull the selected object the distance you entered. 

To create a ruler dimension 

1   Select the faces or edges whose location you wish to specify. 

2   Select a direction for the dimension. 

3   Select Create Ruler Dimension from the Options panel or right-click and select it from the mini-
toolbar. 

The start point of the dimension is set as the location of the Pull arrow or Move handle. 

4   Click an object to set the endpoint of the dimension. 

Use the scroll wheel if multiple objects appear at the same point in the Design window. 

5   Enter a value. 

6   Press Enter to accept the value and complete the move or pull. 

Press Esc to hide the ruler dimension. 

You can make more than one change per ruler dimension. 

To create an angular ruler dimension 

1   Select the Move tool and switch to Section mode. 

2   Select the section line (that represents a face) that you want to rotate. 

3   (Optional) Anchor the Move handle to the object around which you want to 
rotate by dragging the center sphere or using the Anchor tool guide. 

4   Select the rotational axis of the Move handle. 

5   Select Create Ruler Dimension from the Options panel or right-click and select it from the mini-
toolbar. 

An angular dimension indicator appears from the red linear axis of the Move handle. 

6   Select the end reference for the angular dimension. 

7   Enter a value for the dimension. 

Detaching in 2D and 3D 
You can detach individual pieces of a sketch, or detach objects or faces in 3D. You can detach protrusions 
to move them with the Move tool's Detach First option. 

To detach in 2D 

Alt+drag with the Select tool to detach the selected item when sketching. Use the 2D Move tool to detach 
items and move them. 

To detach in 3D 

1   Click the Select tool in the Edit ribbon group.  

2   If you want to detach an object, Ctrl+click all its faces to select them.  

3   Right-click the object and select Detach from the context menu. 
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Undoing and redoing your actions 
SpaceClaim stores all your actions from the moment you open the SpaceClaim application until you close it. 
This includes the use of all tools in all tabs, opening and closing files, loading and activating components, 
and changing settings. Every action is recorded and can be undone and redone. 

The undo list is limited to 20 steps by default, but you can modify this number. We recommend that you set 
it to at least 50. 

To undo or redo a tool action 

Click the Undo and Redo tools  in the Quick Access toolbar or press Ctrl+Z to undo and 
Ctrl+Y to redo. 

You can undo and redo actions until you have undone or redone every action in your session, or you can 
jump to a particular action by selecting that action from the Undo and Redo menus. If undoing an action will 
open or close a document or switch to a new Design window, a confirmation window is displayed.  

When you undo a tool action, the view is also changed to the view you used to perform that action. 

To undo or redo a view 

Click the Previous View and Next View tools   on the status bar to undo and redo your design 
view changes. 

Move handle 
You will use the Move handle to move objects in 2D and 3D. The Move handle 
allows you to translate and rotate objects. You use the Move handle by clicking 
the axes of the Move handle and dragging to move the selected object.  

When you select the object you want to move, and click one of the Move tools, 
SpaceClaim guesses at the anchor point and orientation of the Move handle. If 
either of these is incorrect, you can change them. 

To translate objects using the Move handle 

1   Click the axis that is aligned with the direction you want to move the selected object. 

2   Drag in the direction of the axis to move the object. 

To rotate objects using the Move handle 

1   Click the rotational axis that is aligned with the direction you want to rotate the selected object. 

2   Drag in the direction of the axis to move the object. 

To realign the axes of the Move handle 

You can realign the Move handle in the following ways: 

 Drag the small balls on each rotation axis of the Move handle to reorient it. While dragging, you 
can also press the spacebar to enter the angle directly. 

 Drag the center ball of the Move handle (or use the Anchor tool guide) to place it on another solid, 
face, edge, or vertex. If you use this method, keep in mind that the selected object is still the one 
that is going to move. 
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 Alt+click a point or line (or use the Move Direction tool guide) to orient the closest linear axis 
toward that point or along the line.  

Sketching 
Sketching is useful if you want to create a region that can be pulled into 3D. If you want to create a 2D 
layout, and have no immediate need to generate 3D objects from the lines in the layout, then you should 
create a layout.  

Use the sketch tools to sketch shapes in 2D. When you exit the sketch, regions are formed by intersecting 
lines. These regions will become solids and lines become edges when you pull your sketch into 3D with the 
Pull tool. Even when pulled into 3D, a region can be decomposed back into its sketched lines for further 
editing as long as any remnant of the lines is still unused in 3D. 

To use any of the sketch tools to sketch in 2D, you must first display the sketch grid. If you have a planar 
surface highlighted, and press a sketch tool shortcut (such as L for the Line tool), you can mouse over 
planar surfaces in the design to highlight surfaces for the sketch grid. (Press Esc while in this state to return 
to the Select tool in 3D mode.) You can adjust the units and spacing of the grid, and we recommend that 
you fade the scene under the grid to enhance the visibility of your sketch. 

While you are sketching, you may need to orient your design. If you use the Spin, Pan, or Zoom tools to 
reorient it, click them again or press Esc to continue sketching where you left off. 

Depending on your options, sketching in Section mode may automatically extrude your sketch to 3D. The 
extrusion depth is set to 10 times the spacing of your sketch grid. You can dimension this depth for any 
extruded sketch by entering a value in that dimension field. 

To sketch 

1   Select any sketch tool. 

2   Choose where you want to sketch. 

3   (Optional) Move or rotate the sketch grid. 

4   Draw with the tool. 

5   Repeat steps 1 through 4 until you are finished sketching. 

Detailed instructions

1   Select Sketch mode  from the Mode ribbon group. 

2   Choose where you want to sketch. 

Mouse over the planes and planar faces in your design to preview the location and orientation of the 
sketch grid.  

If you previously selected a set of references that define a plane, the sketch grid is placed on the 
defined plane. The sketch grid mini-toolbar allows you to switch from sketching on one plane to 
sketching on another without leaving the sketch tools. 

The sketch grid is placed automatically if an object in the active component is already selected. 

a   If the sketch grid is currently displayed, click Select New Sketch Plane  in the mini-toolbar, or 
right-click and select Select New Sketch Plane from the context menu. 

b   Mouse over any existing geometry to display existing planes. 

c   Click to select the highlighted plane and display the sketch grid. Any vertices or edges on the plane 
are drawn in the current layer color and bolded. 

d   (Optional) Click Plan View  in the mini-toolbar or in the Orient ribbon group to view the sketch 
grid head-on. 

3   (Optional) Move or rotate the sketch grid. 

a   (Optional) Select any points, lines, or curves that you want to move with the sketch grid. 

41 



SpaceClaim 2008 SP1 User’s Guide 

b   Click Move Grid in the mini-toolbar. 

c   Use the Move handle to move or rotate the sketch grid. 

4   Select any sketch tool from the Sketch ribbon group. 

You can draw points, lines, tangent lines, construction lines, rectangles, three-point rectangles, circles, 
three-point circles, construction circles, ellipses, splines, tangent arcs, three-point arcs, sweep arcs, and 
polygons using the sketch tools. You can also create sketch lines by projecting the edges of 3D solids 
onto the sketch grid. 

SpaceClaim's sketch tools also let you split, trim, and offset lines, as well as create corners and rounded 
corners.  

5   Draw with the tool. 

Mousing over the sketch grid snaps to points based on your snapping options. Press Shift to turn 
snapping on and off. 

While mousing, SpaceClaim also provides extension lines when you are parallel to an edge or 
perpendicular to an endpoint. For certain drawing tools, it displays indicators of tangency, line midpoint, 
line endpoint, squares, and golden rectangles. 

All tools let you enter dimensions while sketching. In some tools, you can press Shift at a reference 
point to see dimensions from that point to the cursor. 

When you are done sketching with the tool, you can:  

 Click another sketching tool. 

 Click Return to 3D Mode in the mini-toolbar or 3D Mode in the Mode group in the ribbon bar 
to pull your sketch to 3D. 

 Press Esc or click the Select tool in the Edit ribbon group to edit the sketch. 

To edit a sketch 

1   Click the Select tool. (You can also press Esc if you are in a sketching tool.) 

2   Click and drag the line or point you want to edit. 

Alt+click and drag if you want to detach the line or point before moving it.  

Ctrl+click and drag to create a copy. 

Enter a value to dimension the move. 

Sketch ribbon group 

 
The Sketch ribbon group contains the following sketch creation tools: 

 Use the Line tool to sketch lines in 2D. 

 Use the Tangent Line tool to sketch lines tangent to any curves in your design. 

 Use the Tangent Arc tool to sketch an arc tangent to any single curve or line in your design. 

 Use the Rectangle tool to draw a rectangle along the axes of the sketch grid. 

 Use the Three-Point Rectangle tool to quickly sketch a rectangle at any angle in 2D. 
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 Use the Ellipse tool to sketch an ellipse in 2D. 

 Use the Circle tool to sketch a circle in 2D when you know the location of the circle's center and radius, 
diameter, or a point on the circle's edge. 

 Use the Three-Point Circle tool when you don’t know the center of the circle, but you know where the 
edge of the circle must be. This tool works with any combination of free points, known points, or 
tangent attachments. 

 Use the Sweep Arc tool to create an arc with a known center and endpoints. 

 Use the Polygon tool to sketch a polygon with up to 32 sides. 

 Use the Spline tool to sketch splines in 2D. A spline is a continuously curved line, without sharp 
boundaries (that is, without vertices). 

 Use the Three-Point Arc tool to create an arc by specifying its start and end points, and the radius or 
chord angle. 

 Use the Construction Circle tool to draw circles that help you create an accurate sketch. Construction 
circles cannot be pulled into 3D, and are removed when you select a new sketch plane or exit sketching.

 Use the Construction Line tool to draw lines that help you create an accurate sketch. These lines 
become axes in 3D mode. 

 Use the Point tool to sketch points in 2D.  

 Use the Project to Sketch tool to copy an edge, vertex, or note text to 2D lines and points that you can 
manipulate with the sketch tools. 

The Sketch ribbon group contains the following sketch editing tools: 

 
Use the Bend tool to bend straight lines and edges to form an arc. You can also use the Bend tool to 
adjust the radius of arcs and arced edges. Bend works on straight lines when you are sketching, when 
you are editing in cross-section, and when you are editing blend sections with the Edit as Blend tool. 

 Use the Create Corner tool to trim back or extend two lines so that they meet at a corner.  

 Use the Trim Away tool to delete any line portion bounded by an intersection with a line or edge.  

 Use the Split Line tool to split one line with another line or point. 

 
Use the Create Rounded Corner tool to trim back or connect two intersecting lines or arcs so that they 
meet with an arc tangent at both ends.  

 Use the Offset Line tool to create an offset of any line in the grid plane. 

Sketching mini-toolbar 

 
While you are sketching, the mini-toolbar provides quick access to the following actions: 

 Click Return to 3D Mode to switch to the Pull tool and pull your sketch into 3D. Any closed loops will 
form surfaces or faces. Intersecting lines will split faces.  

 Click Select New Sketch Plane to select a new face to sketch on.  

 Click Move Grid to move or rotate the current sketch grid with the Move handle. 

 Click Plan View for a head-on view of the sketch grid. 

Options 

The following options are available in every sketching tool: 
 

 Snap to grid Select this option turn snapping on or off while sketching. 
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Editing a sketch 

You can edit the dimensions of sketched lines, arcs, and points using the 
Select tool. Tangency is maintained when you edit a sketch. 

To edit a sketch 

1   Click the Select tool. (You can also press Esc if you are in a sketching 
tool.) 

Select the Select Reference Curve tool guide to dimension from 
another object, similar to the Shift+hover functionality in other tools. 

2   Click and drag the line or point you want to edit. 

Alt+click and drag if you want to detach the line or point before moving 
it.  

Ctrl+click and drag to create a copy. 

Enter a value to dimension the move. 

To edit the length and angle dimensions of a line 

1   Click the endpoint of a line or arc to edit the length or diameter and  angle or chord angle dimensions of 
the line or arc. 

2   Mouse over the opposite endpoint of the line or arc to display a blue circle. 

3   Drag to move the reference point for the dimension's length. 

4   Enter the dimension for the length from the endpoint of the line to the new reference point. 

5   Mouse over the line showing the end of the angle reference to highlight it in blue. 

6   Drag the blue line to move the reference for the angle dimension. 

If you move the angular reference 360°, the angle measurement is changed from clockwise to 
counterclockwise. 

7   Enter the dimension to adjust the angle of the line from the new reference line. 

To edit the distance from another point 

1   Click the midpoint of a line, the center of an arc, or any sketched point to display a dimension to a 
reference point. 

2   Mouse over the reference point, then drag the blue circles to the location you want to dimension from. 

3   Click to set the new reference location. 

To skew the X-Y lines, click the outer blue circle and enter the skew angle. 

To change the properties of a sketch object 

1   Click the Select tool. (You can also press Esc if you are in a sketching tool.) 

2   Select the sketch object to display its properties in the Properties panel. 

You may need to adjust the width of the Properties panel or the columns within the properties panel. 
Place your mouse over the vertical column line and drag to widen the column. Place your mouse over 
the border of the panel and drag to widen the panel. 

3   You can: 

 Select a new color from the Color property to color the object. 

 Switch between lines and construction lines by selecting a value from the Construction property. 
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 Switch between straight lines and mirror lines by selecting a value from the Mirror property. 

 Enter the number of sides for a polygon in the Number of Sides property. 

Copying a sketch 

You can copy a sketch line in Sketch mode with the Select tool. 

To copy a sketch line  

Ctrl+drag (with the Select tool) while sketching to copy a sketch line. 

Press the spacebar while Ctrl+dragging a sketch line to dimension the distance between the first line and 
the second, copied line. 

The sketch grid 

The sketch grid indicates that you are performing actions in a 2D plane. Selection, sketching, creating 
layouts, adjusting blend planes, cross-section editing, and annotating all use the sketch grid. You can adjust 
the units and spacing of the grid, as well as how solids are displayed when the grid appears. 

To display a sketch grid 

1   Select Sketch Mode  or any sketching tool. 

2   Click a face, plane, axis, or drawing sheet. 

You can also select the combinations used to insert a plane to display a sketch grid at that location. 

If you do not see the grid, make sure that the Show Sketch Grid box is checked in the Display tab's 
Grid ribbon group. 

To select a new location for the sketch grid 

1   Click Select New Sketch Plane in the mini-toolbar, or right-click and select Select New Sketch 
Plane from the context menu. 

2   Mouse over any existing geometry to display existing planes. 

3   Click to select the highlighted plane and display the sketch grid. 

To move the sketch grid 

1   (Optional) Select any points, lines, or curves that you want to move with the sketch grid. 

2   Click Move Grid in the mini-toolbar. 

3   Use the Move handle to move or rotate the sketch grid. 

To view the sketch grid head-on 

Click Plan View in the mini-toolbar or in the Orient ribbon group to view the sketch grid head-on. 
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Moving the sketch grid 

Use the Move Grid tool to move the sketch grid. Make successive sketches by moving the grid after 
sketching closed line regions. These closed lines turn into regions when you move the grid.  

To move the sketch grid 

1   Click the Move Grid tool  on the mini-toolbar or click the Move tool and check the Move Grid option. 

2   (Optional) Select any sketch entities that you want to move along with the sketch grid. 

3   Select a Move handle axis. 

4   Drag along the axis of the Move handle to move or rotate the sketch grid. 

Press Shift while dragging to snap the move to angular and linear increments based on your snap 
settings as well as to snap the move parallel to planes, edges, and axes. You can also right-click and 
select Use Ruler Dimension, and enter a value or press Enter to drag the grid. You can also use the 
standard Move tool guides when moving the grid. 

The Move handle can be moved around by dragging the center ball onto appropriate entities on the 
sketch grid. 

Layouts 

2D layouts are useful when you want to draw in 2D, and have no immediate need to generate 3D objects 
from the lines in the layout. If you want to create a region that can be pulled into 3D right away, create a 
sketch instead.  

You can think of a layout as a pencil drawing made on your design. If you try to pull layout lines to 3D, they 
do not behave the same way that sketched lines do. Closed lines are not converted to regions, so if you pull 
a layout line, it creates a surface, not a solid. When you are ready to use your layout to create geometry, 
project the layout lines to a sketch. Projecting a layout line to a sketch is like inking the line.  

Layouts always appear on planes in the Structure tree. 

We strongly encourage you to use layers when working with layouts to help you organize your design. For 
example, you can color individual lines on each layout, show or hide the lines, or put the bounding planes 
on a separate layer and turn that layer's visibility off to declutter your design. (When you import files, they 
will initially appear in one color.) 

To create a layout 

1   Insert a plane. 

2   Right-click the plane in the Structure tree and select Edit Layout. 

The icon on the Structure tree changes to reflect that the plane is a layout. 

3   Sketch on the plane. 

To convert an existing plane to a layout 

1   Click the Edit Layout icon   next to the plane in the Design window. 

The icon on the Structure tree changes to reflect that the plane is a layout 

2   Sketch on the plane. 
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To convert a sketch to a layout 

1   Select the sketch entities that you want to appear on the layout. 

2   Click the Plane tool in the Insert ribbon group. 

A layout plane is drawn around the selected sketch entities. 

3   Click the Edit Layout icon  next to the plane in the Design window to continue editing the sketch 
objects on the layout. 

To import a 2D AutoCAD DXF or DWG file as a layout 

You can import a 2D AutoCAD file into your design in the following ways: 

 Drag and drop the DXF or DWG file into the Design window to create a layout in the active 
component.  

 Drag the file onto a plane in the Structure tree to place the drawing on that plane and convert it to 
a layout. 

Edit a layout 

1   Right-click the plane in the Structure tree and select Edit Layout, or click the Edit Layout icon  next 
to the plane in the Design window. 

A layout plane is drawn around the selected sketch entities. 

Moving in two dimensions 

Use the Move tool to move lines or points with the Move handle. When you move points or lines with this 
tool, they do not maintain their connections to other lines or points. If you want to maintain the connections 
in your sketch, use the Select tool to edit the sketch. 

To move sketch entities 

1   Click the Move tool. 

2   Select the line or point you want to move. 

3   Use the Move handle to move the line or point. 

Detailed instructions

1   Select the Move tool  from the Edit ribbon group. 

2   Select the line or point on the sketch grid that you want to move to display the Move handle. 

You can select multiple sketch entities. 

3  (Optional) Drag the center point of the Move handle to anchor it to any endpoint or midpoint of any line 
on the sketch grid.  

This functionality is useful when you want to rotate a sketch entity around another point on the sketch.  

4  (Optional) Click the Move Direction tool guide and click a line or edge to reorient the Move handle.  

You can also Alt+click the line or edge to reorient the Move handle. 

5   Click an axis and drag in that direction to detach and move the selected sketch entity. 

To dimension the move, type the length of the move or the rotation angle and press Enter. 

The cursor does not need to be on the axis to move the selected object. In fact, you may find it easier 
to control the move if you drag some distance from the entity and the Move handle. 
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Dimensional sketching 

SpaceClaim allows you to do precise, dimensional sketching internal to the current line and relative to other 
lines and points. If a dimension cannot be edited, it does not highlight on mouseover. 

To dimension the current line 

1   Press the spacebar to enter a value. 

2   Press Tab to highlight and edit a secondary dimension. 

3   Press Enter to accept the values. 

SpaceClaim allows you to enter expressions as dimension values. 

The following expression elements are available: 

 Infix (dyadic) operators:  + - * / ^ 

 Prefix (monadic) operators:  + - 

 Functions:  sin cos tan asin acos atan sqrt log log10 exp 

 Constants:  pi e root2 root3 

 Units:  m cm mm yd ft in ' " deg rad 

Normal precedence rules apply: 

1 + 2 * 3 ^ 4 = 1 + (2 * (3 ^ 4)) = 163 

Parentheses are required for expression arguments and optional for simple arguments: 

 sqrt 2 = sqrt(2) = 1.4142... 

 sqrt 2*2 = (sqrt 2) * 2 = 2.8284... 

 sqrt(2*2) = 2 

Missing operators are inferred: 

 1 1/2 = 1 + 1/2 

 1’6” = 1’ + 6” 

 1ft 6in - 17in = 1ft + 6in - 17in 

 1 2 3 4 5 = 1 + 2 + 3 + 4 + 5 = 15 

 (1)(2)(3)(4)(5) = (1) * (2) * (3) * (4) * (5) = 120 

 2(1 + 2) = 2 * (1 + 2) = 6 

 sqrt 2 sqrt 2 = sqrt 2 * sqrt 2 = 2 

 4(4atan(1/5) - atan(1/239)) = 4 * (4 * atan(1/5) - atan(1/239)) = pi 

Units are applied to previous terms if units were not specified and are applied to subsequent terms unless 
you override them: 

 1 + 1cm = 1cm + 1cm 

 1cm + 1 = 1cm + 1cm 

 1cm + 1 + 1mm = 1cm + 1mm + 1mm 

 1cm + 1 1/2 mm = 1cm + 1mm + 1mm / 2 

Trigonometry functions work in radians by default, but you can enter degrees: 

sin(45 deg) 

Numbers support standard form, but e is a built-in constant: 
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 2e2 = 200 
2e 2 = 2 * e * 2 = 10.873... 

 2e-2 = 0.02 
2e – 2 = 2 * e – 2 = 3.436... 

 2e1 = 20 
2e = 2 * e 

To dimension relative to other lines and points 

Hover the mouse over a line or point and press Shift to create a dimension relative to that line or point. If 
you click a spline, the dimension is always created from the start point of that spline. 

To create an offset angular dimension 

If the angular reference does not touch the arc center, parallel reference lines are created.  

Points 

Use the Point tool to sketch points in 2D.  Points are useful as a dimensional reference, for splitting, and for 
creating a point on a line or curve through which you want to draw a three-point circle.  

The sketch grid must be visible in the workspace before you can draw.  

To draw a point 

Click anywhere. 

Detailed instructions

1   Select the Point tool  from the Sketch ribbon group. 

2   (Optional) Dimension the point relative to another sketch object. 

3   Click or press Enter to place the point. 

You can also project vertices in 3D to create points in the sketch. 

To insert a point at the mid-point between two points 

1   Select the Point tool. 

2   Alt+Shift+click two points to create a temporary point at the mid-point. 

3   Click the temporary point to place a point there. 

Lines 

Use the Line tool to sketch lines in 2D. These lines will become edges when you 
pull your sketch into 3D with the Pull tool.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a line 

Click to set each point of the line. 
 

Do it faster Click and drag to draw one straight line. 

Detailed instructions

1   Select the Line tool   from the Sketch ribbon group or press L. 

2   (Optional) Dimension the first point relative to another sketch object. 
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3   Click or press Enter to set the first point of the line. 

4   (Optional) Dimension the line. 

5   Click or press Enter to set the next points of the line. 

By default, the line is dimensioned to its start point. You can also dimension relative to another sketch 
object. 

If you want any section of the line to be an arc, right-click and select Switch to Arc, then click to set 
the radius. Right-click and select Switch to Line to return to drawing straight lines between points. 
You must create at least one line segment before using this option. 

6   End the line.  

You can: 

 Double-click to set the end point of the line. 

 Right-click and select Finish Line. 

 Press Esc. 

 Connect the end point to the start point. 

 Click any tool (except the Clipboard and Orient tools). 

You can also: 

 Use a line as a mirror 

Right-click the line and select Set as Mirror Line. 
 Toggle between a line and a construction line 

Right-click the line and select Construction On/Off. 

Tangent lines 

Use the Tangent Line tool to sketch lines tangent to any curves in your design. These lines will become 
edges when you pull your sketch into 3D with the Pull tool.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a tangent line 

1   Click a curve.  

2   Click to set the line's end point. 

Detailed instructions

1   Select the Tangent Line tool  from the Sketch ribbon group. 

Curves are highlighted as you mouse over them, and the tangency indicator appears at your cursor 
location. If there are no curves in your design, this tool is disabled; you must add a curve to create a 
tangent line. 

2   Click the curve you want to draw tangent to. 

As you move the mouse, the start point moves so that the line remains tangent to the curve.  

3   (Optional) Dimension the line with a length. 

You cannot dimension from another sketch object when creating a tangent line. 

4   Click or press Enter to set the end point of the line. 

If you mouse over another curve, the line snaps so that it is tangent to the second curve. To stop this 
behavior, Alt+click the end point. 

You can also: 

 Use a tangent line as a mirror 

Right-click the line and select Set as Mirror Line. 
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 Toggle between a tangent line and a construction line 

Right-click the line and select Construction On/Off. 

Construction lines 

Use the Construction Line tool to draw lines that help you create an accurate sketch. Construction lines 
become axes in 3D. They are also useful for creating mirrors. 

The sketch grid must be visible in the workspace before you can draw. 

To draw a construction line 

Click to set the start and end point of the construction line. 
 

Do it 
faster 

Click and drag to draw a straight construction line. 

Detailed instructions

1   Select the Construction Line tool   from the Sketch ribbon group. 

2   (Optional) Dimension the first point relative to another sketch object. 

3   Click to set the first point of the line. 

4   (Optional) Dimension the line. 

5   Click or press Enter to end the line. 

By default, the line is dimensioned to its start point, but you can dimension to another sketch object. 

You can also: 

 Use a construction line as a mirror 

Right-click the line and select Set as Mirror Line. 
 Toggle between a line and a construction line 

Right-click the line and select Construction On/Off. 

Rectangles 

Use the Rectangle tool to draw a rectangle along the axes of the sketch grid. When you exit the sketch, any 
rectangles become surfaces, and the lines become edges of a rectangular solid when you pull your sketch 
into 3D with the Pull tool. 

The sketch grid must be visible in the workspace before you can draw. 

To draw a rectangle 

1   Click to set the first corner of the rectangle. 

2   Click to set the opposite corner of the rectangle. 
 

Do it 
faster 

Click and drag to draw a rectangle. 

Detailed instructions

1   Select the Rectangle tool  from the Sketch ribbon group or press R. 

2   (Optional) Dimension the first point relative to another sketch object. 

3   Click to set the first corner. 

Mouse over the sketch grid to preview the rectangle. Indicator lines appear when you create a square. 

4   (Optional) Dimension the rectangle from the first corner or relative to another sketch object. 
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5   Click or press Enter to set the opposite corner of the rectangle. 

Example 

 
Sketching a square 

Three-point rectangles 

Use the Three-Point Rectangle tool to quickly sketch a rectangle at any angle in 2D. These lines will become 
the edges of a rectangular solid when you pull your sketch into 3D with the Pull tool.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a three-point rectangle 

1   Click to set the first corner of the rectangle. 

2   Click to set the length of the first side. 

3   Click to set the length of the second side. 
 

Do it 
faster 

Click and drag to draw the first side, then click to set the length of the second side. 

Detailed instructions

1   Select the Three-Point Rectangle tool  from the Sketch ribbon group. 

2   (Optional) Dimension the first point relative to another sketch object. 

3   Click to set the first corner of the rectangle. 

Mouse over the sketch grid to preview the rectangle. Indicator lines appear when you create a square or 
golden rectangle. 

4   (Optional) Dimension the first side from the start point or relative to another sketch object. 

5   Click or press Enter to set the length of the second side or dimension it. 

Circles 

Use the Circle tool to sketch a circle in 2D when you know the location of the 
circle's center and a point on the circle’s edge, or the radius or diameter. The 
circle can become a cylinder or hole when you pull it into 3D with the Pull tool, 
or a sphere or torus if you rotate or sweep it.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a circle 

1   Click to set the circle’s center. 

2   Click to set the circle's diameter. 
 

Do it faster Click and drag to draw a circle. 

52 



SpaceClaim 2008 SP1 User’s Guide 

Detailed instructions

1   Select the Circle tool  from the Sketch ribbon group or press C. 

2   (Optional) Dimension the center of the circle relative to another sketch object. 

3   Click to set the circle’s center. 

4   (Optional) Dimension the diameter. 

5   Click or press Enter to set the circle's diameter. 

The circle will snap to existing sketches or determined circles and arcs in the plane of the sketch. 

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by 
editing its dimension, tangency with the other circle is maintained. 

If you drag the center of a circle that is tangent to another circle, the radius of the other circle changes 
to maintain tangency. 

Example 

 
Editing a tangent circle by dragging the circle's center; tangency is maintained 
 

Three-point circles 

Use the Three-Point Circle tool  when you don’t know the center of the circle, but you know where the 
edge of the circle must be. This tool works with any combination of free points, known points, or tangent 
attachments. The circle will become a cylinder or hole when you pull it into 3D with the Pull tool. You can 
also rotate the circle about a line to make a sphere or torus.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a three-point circle 

1   Click to set the first point on the circle's edge. 

2   Click to set the second point. 

3   Click to set the third point. 

Detailed instructions

1   Select the Three-Point Circle tool   from the Sketch ribbon group. 

2   (Optional) Dimension the first point relative to another sketch object. 

3   Click to set the first point on the circle’s edge. 

If you click a curve or line, the circle will be drawn tangent to the curve or line, unless you click the 
midpoint or vertex. 

4  (Optional) Dimension the second point relative to another sketch object. 

5   Click or press Enterto set the second point on the circle’s edge. 
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As you mouse over the sketch grid, if the circle disappears, the cursor location cannot be included in 
any circle drawn through the first two points and the current one. If you click a curve or line, the circle 
will be drawn tangent to the curve or line, unless you click the midpoint or vertex. 

6   (Optional) Dimension the radius of the circle or dimension the third point relative to another point.. 

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by 
editing its dimension, tangency with the other circle is maintained. 

7   Click or press Enter to set the last point on the circle’s edge. 

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by 
editing its dimension, tangency with the other circle is maintained.  

If you drag the center of a circle that is tangent to another circle, the radius of the other circle changes 
to maintain tangency. 

Options 

The following options are available in the Three-Point Circle tool: 
 

 Three-point circle 
segment 

Check this option to create an arc that is a segment of a three-point circle. To 
create an arc with this option, click to set the first point, click to set the second 
point, then enter the diameter or click to set the final point. 

Example 

 
Editing a tangent circle by dragging the circle's center; tangency is maintained 

 
Dragging (with the Select tool) a three-point circle drawn through a rectangle’s vertex maintains the 
connection. 

Construction circles 

Use the Construction Circle tool to draw circles that help you create an accurate sketch. Construction circles 
cannot be pulled into 3D, and are removed when you select a new sketch plane or exit sketching. The 
construction circle is useful for dimensioning or indicating a circular relationship of objects that lie on a 
virtual circular line of centers. For example, bolt hole circles around a flange. 

The sketch grid must be visible in the workspace before you can draw. 

54 



SpaceClaim 2008 SP1 User’s Guide 

To draw a circle 

1   Click to set the circle’s center. 

2  Click the set the circle's diameter. 
 

Do it 
faster 

Click and drag to draw a construction circle. 

 

Detailed instructions

1   Select the Construction Circle tool  from the Sketch ribbon group. 

2   (Optional) Dimension the center relative to another sketch object. 

3   Click to set the circle’s center. 

4   (Optional) Dimension the diameter. 

5  Click or press Enter to set the circle's diameter. 

The circle will snap to existing sketches or determined circles and arcs in the plane of the sketch. 

If you sketch two circles that are tangent to each other, and then change the diameter of one circle by 
editing its dimension, tangency with the other circle is maintained. 

If you drag the center of a circle that is tangent to another circle, the radius of the other circle changes 
to maintain tangency. 

Example 

 
Editing a tangent circle by dragging the circle's center; tangency is maintained 

Ellipses 

Use the Ellipse tool to sketch an ellipse in 2D. The ellipse can become an elliptical solid or hole when you 
pull your sketch into 3D with the Pull tool. You can also sweep the ellipse in 3D, or rotate it. 

The sketch grid must be visible in the workspace before you can draw. 

To draw an ellipse 

1   Click to set the center of the ellipse. 

2   Click to set the overall length and angular orientation of the first axis. 

3   Click to set the overall length of the second axis. 

Detailed instructions

1   Select the Ellipse tool  from the Sketch ribbon group. 

2   (Optional) Dimension the center relative to another sketch object. 

3   Click or press Enterto set the center of the ellipse. 

4   (Optional) Dimension the first axis. 
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5   Click or press Enter to set the overall length and angular orientation of the first axis. 

6   (Optional) Dimension the second axis. 

7   Click or press Enter to set the length of the second axis. 

Tangent arcs 

Use the Tangent Arc tool to sketch an arc tangent to a curve or line in your design. This arc will become an 
edge when you pull your sketch into 3D with the Pull tool.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a tangent arc 

1   Click to set the start point of the arc on a line. 

2   Click to set the radius and chord angle of the arc. 

Detailed instructions

1   Select the Tangent Arc tool   from the Sketch ribbon group. 

Mouse over the sketch grid to highlight curves and lines. If there are no curves or lines in the sketch, 
the tool is disabled. You must add a curve or line or move the grid to create a tangent arc. 

2   Click the line or curve you want to draw tangent to.  

Usually, this is done at the endpoint of a line, arc, or spline, but it can be on the line as well. If there are 
two lines sharing an end point, use the scroll wheel to set tangency to the other line. 

3   (Optional) Dimension the radius and chord angle. 

4   Click or press Enter to set the end point of the arc. 

The end point cannot fall on the start point to make a circle or end on the same line as the start point.  

To edit a tangent arc 

Drag the arc to edit it. When you drag a tangent arc, it increases its radius while maintaining its chord 
angle. 

Example 

 
Arc sketched tangent to two circles 

 
Editing a tangent arc maintains its connections 
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Swept arcs 

Use the Sweep Arc tool to create an arc with a known center and endpoints. Tangency is not a factor in the 
creation of this arc. The arc will become an edge when you pull your sketch into 3D with the Pull tool.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a swept arc 

1   Click the arc's center. 

2   Click the start point to set the radius and begin the arc. 

3   Click the end point. 

Detailed instructions

1   Select the Sweep Arc tool  from the Sketch ribbon group. 

2   (Optional) Dimension the center relative to another sketch object. 

3   Click or press Enter to set the center of the sweep circle. 

4   (Optional) Dimension the chord angle or create an offset angular dimension. 

5   Click to set the start point and radius of the sweep circle. 

6   (Optional) Dimension the chord angle or create an offset angular dimension. 

7   Click or press Enter to set the end point of the arc.  

Three-point arcs 

Use the Three-Point Arc tool to create an arc by specifying its start and end points, and the radius or chord 
angle. This arc can be created tangent to another arc, line, or spline at its start. The arc will become an 
edge when you pull your sketch into 3D with the Pull tool.  

The sketch grid must be visible in the workspace before you can draw. 

To draw a three-point arc 

1   Click the start point of the arc. 

2   Click the end point. 

3   Click to set the radius. 

Detailed instructions

1   Select the Three-Point Arc tool  from the Sketch ribbon group. 

2   (Optional) Dimension the start point of the arc relative to another sketch object. 

3   Click or press Enter to set the start point of the arc. 

You can set tangency by clicking a point on another line, arc, or spline. 

4   (Optional) Dimension the gap between the arc's ends with the linear distance and angle from the start 
point. You can also dimension the end point relative to another sketch object. 

5   Click or press Enter to set the end point of the arc. 

If the start point is on another line, arc, or spline, then the arc will initially be drawn tangent to that line, 
arc, or spline. 

6   (Optional) Dimension the chord angle or radius. 

7   Click or press Enter to set the arc's radius. 
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Polygons 

Use the Polygon tool to draw a polygon with up to 32 sides. You can dimension the location of the axis, the 
length of the radius, and the orientation angle. The lines of a sketched polygon maintain their relationship to 
each other. When you pull a polygon into 3D, faces with a polygon relationship are shown in blue. If you act 
on one face or edge, it affects all the faces in the relationship. 

To draw a polygon 

1   Select the Polygon tool  in the Sketch ribbon group. 

2   Click to set the center of the polygon. 

3   Click to set the diameter and orientation of the polygon. 

Detailed instructions

1   Select the Polygon tool  in the Sketch ribbon group. 

2   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar.  

3   (Optional) Dimension the center of the polygon relative to another sketch object. 

4   Click or press Enter to set the center of the polygon. 

5   (Optional) Dimension the diameter and orientation. 

6   Click or press Enter to set the diameter and orientation of the polygon. 

The sides of the polygon are all related, and act as one object. When pulled in 3D, the edges and faces 
of the polygonal solid will also maintain this relationship. 

Tip: If you trim a polygon sketch with the Trim Away tool, you can drag the original sides of the polygon 
with the Select tool to re-create the polygon. 

To set the number of sides 

1   In Sketch mode, select the polygon with the Select tool. 

2   Right-click the polygon and select Properties. 

3   Enter a value for the Number Of Sides property. 

Polygons can have a minimum of 5 sides, and a maximum of 64 sides. 

To remove the polygon relationship from the faces of a polygon solid 

Right-click a face of the polygon and select Remove Association.  

Any changes you make to the face of the polygon will affect only that face. 

Options 

The following option is available in the Polygon tool: 
 

Use internal 
radius 

Select this option to dimension the polygon based on the diameter of a circle inscribed 
within the polygon. Uncheck it to dimension the polygon based on a circumscribed 
circle. 

58 



SpaceClaim 2008 SP1 User’s Guide 

 

Examples 

 
Hexagonal head nut 

 
Two polygons. The outer polygon has the construction circle inscribed within it; the inner polygon has the 
construction circle circumscribed around it. 

Splines 

Use the Spline tool to sketch splines in 2D. A spline is a continuously curved line, without sharp boundaries 
(that is, without vertices). Splines can become edges when you pull your sketch into 3D with the Pull tool. 
Sweeping along a spline in 3D lets you create smooth, curvy shapes. 

The sketch grid must be visible in the workspace before you can draw. 

To draw a spline 

1   Click to set each point of the spline. 

2   Double-click to end. 

Detailed instructions

1   Select the Spline tool  from the Sketch ribbon group. 

2   (Optional) Dimension the first point of the spline relative to another sketch object. 

3   Click or press Enter to set the first point of the spline.  

4   (Optional) Dimension the spline by entering the coordinate distance from the start point to each point, 
or dimension each point relative to another sketch object.  

5   Click or press Enter to set the next points of the spline. 

.  

6   End the spline.  

You can: 

 Double-click to set the end point of the spline. 

 Right-click and select Finish Spline. 

 Press Esc.  

 Connect the end point to the start point. 

 Click any tool (except the Clipboard and Orient tools).  
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You can also: 

 Move a spline 

1   Click the Select tool in the Edit ribbon group. 

2   Mouse over the spline to highlight the spline and display its defining points. 

3   Click anywhere on the spline except for the defining points, and drag it to move it. 
 Edit a spline 

1   Click the Select tool in the Edit ribbon group. 

2   Mouse over the spline to highlight the spline and display its defining points. 

3   Click and drag on any internal point to move it, leaving the other spline points fixed in space. 

4   (Optional) Edit the dimensions associated with that point. 

5   Click an endpoint to display its endpoint control handle. 

The endpoint control handle is a light blue point at the end of a dotted line extending outwards 
from the end of the spline. In some cases, these endpoints may be located some distance 
away from your sketch. Zoom out from the sketch until you can see the endpoint control 
handle. 

If another line, arc, or spline shares that endpoint, the endpoint influence may snap into 
tangency with that sketch entity. To adjust the endpoint influence in this case, move the 
mouse a short distance away from the endpoint to display the endpoint control handle. 

6   Drag the endpoint control handles to change the influence of that endpoint on the shape of the 
spline.  

The amount of the endpoint's influence can be controlled by dragging the endpoint control 
handle closer to or further away from the endpoint.  

 Add spline points 

1   Click the Select tool in the Edit ribbon group. 

2   Mouse over the spline to highlight the spline and display its defining points. 

3   Right-click anywhere on the spline except on the defining points, and select Add Spline Point 
to create another spline point at that location. 

 Remove spline points 

1   Click the Select tool in the Edit ribbon group. 

2   Click the spline to highlight it and display its defining points. 

3   Right-click the point you want to remove and select Remove Spline Point. 

The spline adjusts to accommodate the removal of the point. 
 Create a closed spline 

You can create a closed spline in the following ways: 

 When drawing a spline, end it on the start point. 

 When editing the spline, drag one endpoint on top of the other point. 

Once you have created a closed spline, you cannot edit it into an open spline. 

Splitting lines 

Use the Split Line tool to split one line with another line or point. The segments of the split line can then be 
selected and edited independently. 

The sketch grid must be visible in the workspace before you can split lines. 

To split a line 

1   Select the Split Line tool   from the Sketch ribbon group. 
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2   Click the line you want to split. 

3   Click the line or point that will split the first line where they intersect. 

Trimming lines 

Use the Trim Away tool to delete any line portion bounded by an intersection with a line or edge. 

The sketch grid must be visible in the workspace before you can trim lines. 

To delete a bounded line 

Click the line portion you want to delete. 

Detailed instructions

1   Select the Trim Away tool  from the Sketch ribbon group or press T. 

2   Mouse over a line to preview the section that will be deleted. 

3   Click to delete the highlighted line section. 

The portion of the line you clicked is deleted up to any intersection with another 2D line or edge of a 
solid. 

 

Creating corners 

Use the Create Corner tool to trim back or extend two lines so that they meet at a corner.  

The sketch grid must be visible in the workspace before you can create corners. 

To connect two lines with a corner 

1   Click one of the lines you want to connect with a corner. 

2   Click an intersecting line to trim the lines, or a non-intersecting line to extend the lines. 

Detailed instructions

1   Select the Create Corner tool   from the Sketch ribbon group. 

2   Click a line, arc, or spline. 

3   Mouse over another line to preview the corner that will be created. 

If you mouse over a line that is the cross-section edge of a solid or a silhouette edge, it will not change. 
Only a sketched line will change. 

4   Click an intersecting line to trim the lines, or a non-intersecting line to extend the lines. 

If the lines intersect, click the part of the intersecting line you want to keep. If the lines do not intersect, 
you can click anywhere on the line to extend the lines to form a corner. 

Options 

The following options are available in the Create Corner tool: 
 

 Trim/Extend 
curve 

If you select this option and click the first line, then click a second, non-intersecting line, 
you extend the first line, but not the second. If the two lines intersect, the first line is 
trimmed by the second line. 
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Creating rounded corners 

Use the Create Rounded Corner tool to trim back or connect two intersecting lines or arcs so that they meet 
with an arc tangent at both ends.  

The sketch grid must be visible in the workspace before you can create filleted corners. 

To connect two lines with a fillet 

1   Click a line or arc. 

2   Click an intersecting line to size and trim the arc. 

Detailed instructions

1   Select the Create Rounded Corner tool  from the Sketch ribbon group. 

2   Click a line or arc. 

3   Mouse over another line to preview the fillet that will be created. 

If you mouse over a line that is the edge of a solid, that edge will not change. Only a sketched line will 
change. The radius of the arc is previewed as you move the mouse. Enter a radius to dimension it. 

4   Click an intersecting line to trim the lines, or a non-intersecting line to connect the lines. 

Where you click on the intersecting line defines the radius of the tangent arc, or you can dimension the 
round by entering its diameter.  

If the lines intersect, click the part of the intersecting line you want to keep. If the lines do not intersect, 
you can click anywhere on the line to extend the lines to form a rounded corner. Circles are never 
trimmed. 

To edit a rounded corner 

Drag the rounded corner to change its radius. Tangency is maintained. 

Offsetting lines 

Use the Offset Line tool to create an offset of any line in the grid plane. If you are creating an offset spline, 
you will get the best results with an offset distance appropriate to the curvature of your spline.  

The sketch grid must be visible in the workspace before you can create offset lines. 

To offset a line 

1   Click the line for which you want to create an offset. 

2   Click to set the offset distance. 

Detailed instructions

1   Select the Offset Line tool  from the Sketch ribbon group. 

2   Click the line for which you want to create an offset. 

You can Ctrl+click to include other lines in the sketch that you want to have the same offset.  

Standard line selection techniques apply, so you can double-click to select connected loops of lines. Ctrl 
and Shift can also be used to extend or replace the selected items prior to offsetting. 

To clear the current selection, click an empty spot in the Design window. 

Hover the mouse over a line or point and press Shift to create an offset from that line or point. 

As you move the cursor away from the selected line, you can see a preview of the offset result. The 
offset defaults to one grid square. 

3   (Optional) Select an option to specify how intersecting offset lines should meet. 
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4   Enter a dimension or click to set the width of the offset. 

Options 

The following options are available in the Offset Line tool: 
 

Close with 
corner Close intersecting offset lines with a corner. 

Close with arc Close intersecting offset edges with an arc. 

Close naturally Close intersecting offset edges with a curve. 

 Offset both ways Create two offset lines on either side of the selected line 

Example 

 
Highlighted line offset using each option. Shown from top to bottom: Close naturally, Close with corner, and 
Close with arc. 

Projecting onto the sketch grid 

Use the Project to Sketch tool to copy an edge or vertex of a solid to a 2D line or point that you can 
manipulate with the sketch tools. You can also project a note onto the sketch grid. Projecting an axis onto 
the sketch grid creates a construction line.  

Except when explicitly selecting a new sketch plane, this is the only sketch tool that can select items that 
are not on the sketch grid. You can also select note text and project the text onto your sketch. 

The sketch grid must be visible in the workspace before you can project edges onto it. 

To project a face, edge, vertex, or note onto the sketch grid 

Click any edge, vertex, or note text in your design. Click a face in Section mode (represented by a line) to 
project it onto the sketch grid. 

If you have difficulty seeing a projected line, check that Fade Scene Under Grid is selected on the Display 
tab. 

Detailed instructions

1   Select the Project to Sketch tool  from the Sketch ribbon group. 

Mouse over your design to highlight the objects available for projection. 

2   Click the edge, edge chain, vertex, or note text you want to project into the sketch plane. 

Standard edge selection methods apply, so you can double-click, Ctrl+click, and Shift+click to create or 
modify your selection.  

You can also click and drag to draw a selection box enclosing the objects you want to project, including 
silhouette edges. 
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The edge, vertex, or text appears as a sketched line to show that it is now a line or point in the sketch 
plane. 

Duplicate edges (that appear on top of each other) in the sketch are consolidated when you return to 
3D mode. 

Bending 

Use the Bend tool to bend straight lines and edges to form an arc. You can also use the Bend tool to adjust 
the radius of arcs and arced edges. Bend works on straight lines when you are sketching and when you are 
editing in cross-section. 

You can insert a point curve text file to make a complicated bend. 

To bend a line or edge 

1   Select the Bend tool  from the Sketch ribbon group.  

2   If you are working in Section mode, select the face that contains the edge.  

3   Click and drag a line or arc to bend it or change its radius. 

Enter a value to dimension the radius. 
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Editing 
Use the editing tools to create and edit 2D and 3D solids. You can select, pull, move (in 2D and 3D), edit in 
cross-section, fill (heal), bend lines and edges, and edit faces as a blend.  

In SpaceClaim, the line between creating and editing is blurred. Since there is no hierarchical feature tree, 
you have considerable freedom when designing. Create a box by pulling on a rectangular region. Edit the 
size of the box by pulling on one of its faces. Draw a rectangle to create a pull-able region. Draw a rectangle 
on a face to create a new face.  

In general, you are either editing or creating with one of main tools (Select, Pull, Move, Combine, or 
sketching and editing in Section mode), the many secondary tools, or inserting relationships between faces 
in the design (Shell, Offset, Mirror). Combining objects (intersecting, merging, cutting, etc.) is handled by 
the tools in the Intersect ribbon group. 

Selection is integral to face and edge manipulation. You can extend selections with standard controls 
(double-click, Ctrl, Shift), by right-clicking and selecting from the Select menu, or using SpaceClaim's power 
selection functions. 

A quick note about solids and surfaces: SpaceClaim always converts a closed set of surface faces into a 
solid. Similarly, sketched lines that clearly create regions on faces are replaced with real edges. The change 
in face transparency and edge lines reflects this transformation. 

You can cut, copy, paste, and detach objects in most tools. 

In SpaceClaim, there are three modes you can use to edit your designs: 
 

 Sketch mode displays the sketch grid, so you can use any of the sketch tools to sketch in 2D.l 

 Section mode lets you edit solids by working with their edges and vertices in cross-section. 

 3D mode lets you work directly with objects in 3D space.  

Edit ribbon group 

 
The Edit ribbon group contains the following tools: 

 

Use the Select tool to select 2D or 3D objects in your design for editing. You can select vertices, 
edges, planes, axes, faces, surfaces, rounds, solids, and components in 3D. In 2D, you can select 
points and lines. You can also select circle and ellipse centers, the midpoints of lines and edges, and 
the internal points and endpoints of splines. The Select tool can also be used to edit a sketch. 

 
Use the Pull tool to offset, extrude, revolve, sweep, draft, and blend faces; use it to round, chamfer, 
or extrude edges. 

 
Use the Move tool to move any single face, surface, solid, or component. The behavior of the Move 
tool changes based on what you have selected.  

 
Use the Fill tool to fill in the selected region with the surrounding surface or solid. The region must be 
completely surrounded to be filled. 

  

 
You can use the Edit as Blend tool to edit any blended face or convert a regular face to a blended 
one. You can create a new blend section or delete one. You can move any blend section, or you can 
edit it by moving an edge, moving a vertex, or bending an edge. 
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Selecting objects 

Use the Select tool to select 2D or 3D objects in your design for editing. You can select vertices, edges, 
planes, axes, faces, surfaces, rounds, solids, and components in 3D. In 2D, you can select points and lines. 
You can also select circle and ellipse centers, the midpoints of lines and edges, and the internal points and 
endpoints of splines. You can also select components and other objects in the Structure tree. 

You can search for related objects to select on the Selection panel. 

The Select tool can also be used to edit a sketch. 

To select 

1   Click to select the highlighted object. Double-click to select an edge loop. (Double-click again to cycle 
through alternate loops.) Triple-click to select a solid. Drag (or select Using Box from the Select tool 
menu) to create a selection box. 

2   (Optional) Ctrl+click and Shift+click to add or remove items. Alt+click to create a secondary selection 
set. 

Detailed instructions

1   Select the Select tool  from the Edit ribbon group. 

2   Mouse over the vertices, edges, faces in the workspace to preview the selectable items in your design.  

If multiple objects occur at your cursor location, use the scroll wheel or arrow keys to preview each one.  

3   Click to select a vertex, edge, or face in 3D; click to select a line or point in 2D.  
 

To select: Do this: 
All the edges around a face 
or closed loop 

Double-click an edge or line. Double-click again to select the next loop 
of edges. Repeat as necessary. You can also right-click the edge or 
line and choose one of the loop options in the Select menu. 

All tangent faces  Double-click a face. (Tangent faces are created by rounds or when 
edges are drawn on a face.) 

Contiguous edges or faces Click one face or edge, then Shift+click another face or edge to select 
all the faces or edges between the two. 

The sides (but not the top 
and bottom) of a solid 

Triple-click the solid and Ctrl+click the top and bottom to remove 
them from the selection. 

A solid or surface body Triple-click the solid, or right-click on the solid and select Select > 
Body.  

An entire sketch Triple-click the sketch. 
A component Right-click on the component and select Select > Component. This 

option is available only when you right-click an object within the active 
component. 

All the objects in the active 
component (except layout 
surfaces) 

Press Ctrl+A, click Select All in the Select tool menu, or right-click 
and select Select > Select All from the context menu. The types of 
objects selected depend on whether you are in Sketch, Section, or 3D 
mode. 

Layout surfaces Click the object in the Structure tree. 
Anything completely within 
a selection box 

Click and drag from the upper left to lower right to draw a selection 
box. You can also click Using Box in the Select tool menu, or right-
click and select Select > Using Box from the context menu, then 
click and drag. 

A lightweight component Check the Lightweight Components box in the Options panel. Then 
right-click and select Select > Component. 

The inverse of the current 
selection (in the active 

Right-click a selected object and select Select > Inverse Selection. 
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To select: Do this: 
component) 
A protrusion Right-click on a protrusion and select Select > Protrusion. 
A depression Right-click inside a depression and select Select > Depression. 
One member of a pattern Right-click a pattern member and select Select > Pattern Member. 
All members of a pattern Right-click a pattern member and select Select > All Pattern 

Members. 
Anything partially in a 
selection box 

Click and drag from the lower right to upper left when drawing a 
selection box. 

If any object was part of a group selection used to perform an action, the other parts of the group are 
highlighted when that object is selected. Click again to select the entire highlighted group. 

When selecting within a view on a drawing sheet, you can only select those objects that are on the 
cross-section plane, or that are within the boundary of a detail view. Box selecting in Sketch mode 
selects only sketch lines. Box-selecting in Section mode selects only section lines. 

4   (Optional) Ctrl+click and Shift+click to add or remove items from the selection set. 

Ctrl+click to add or remove one item from the selection set. Shift+click to add everything between your 
first click and the Shift+click to the selection. You can add or remove items both in the workspace and 
on the Structure tree. You can also press Ctrl and drag to add the items within the selection box to the 
selection. 

5  (Optional) Alt+click to create a secondary selection set. 

Hold down the Alt key while performing any of the other selection techniques (double-click, triple-click, 
Ctrl, Shift) to create the second selection set.  Alternate selections are shown in blue, and are used to 
guide the actions of the Pull and Move tools.  

Click an unoccupied space in the Design window to clear the selection. 

You can also use the Select tool to: 

 Move protrusions and depressions 

 Move solids and surfaces 

 Edit a sketch 

 Copy a sketch 

 Pull 

 Pivot 

To clear a selection 

Click any empty space in the Design window or select Clear Selection from the Select tool menu. 

Selectable objects that are coincident in 2D and 3D 

Sometimes objects appear at the same location in 2D. For example, a vertex and end point of a line are 
often located at the same point in space. When selecting, be sure to check that you have selected the 
correct object by using the scroll wheel without moving the mouse. 

When you have an edge shared by two surfaces or solids, mousing over the edge shades the face that will 
be affected by an action to the edge if you select it. You can scroll with the mouse wheel to switch between 
the two faces. Mousing over a vertex shades the edge that will be affected by an action to the vertex if you 
select it. You can scroll with the mouse wheel to switch between the edges. 

You can select the face of a solid when only the edge is displayed (such as in a drawing sheet view) using 
the scroll wheel. The edge becomes a slightly thicker line when the face is highlighted. 

Tool guides 

Within the Select tool, there are two tool guides that offer you alternative behaviors: 
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The Select tool guide is active by default. This tool lets you click, double-click, triple-click, Ctrl+click, 
Shift+click, and Alt+click to select items. 

 

Click a face or edge with the Select Bounds to Extend Selection tool guide to extend the current 
selection to include all objects bounded by that face or edge. Ctrl+click or double-click to add faces 
or edges to the boundary. The extended selection appears when you release the Ctrl key. Faces are 
selected if your initial selection was a face. Edges are selected if your initial selection was an edge. 

Options 

The following options are available in the Select tool: 
 

Cartesian 
Dimensions Select this option to use Cartesian dimensions while editing sketches. 

Polar Dimensions Select this option to use polar dimensions while editing sketches. 

Snap to Grid Select this option to snap to the grid while editing sketches. 

Filtering selections 

You can filter selections using 
the drop-down control in the 
status bar, as shown in the 
image on the right.  

ault. 

t only faces. 

Selection filters apply to each 
tool. When you switch to another 
tool, the filter selections are 
reset to the def

When you select objects, only 
those selected in the Filter 
options are selected. You can 
limit selection (on click and with 
box-select) to a number of 
different objects. When selecting 
by clicking, all checked objects 
will be selected. When using box-
select, only the top-most 
checked object is selected. For 
example, in the figure above, 
box-selection would selec

Example 

 
Extending a selection with the Select Bounds to Extend Selection tool guide. Arrows indicate the two faces 
that were clicked to bound the selection. 
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Moving protrusions and depressions 

You can move protrusions and depressions with the Select tool or the Move tool.  

To move a protrusion or depression 

1   Select a protrusion or depression. 

2   Drag the protrusion or depression. 

If two faces connect at an angle greater than 90 degrees, you can drag the protrusion across the two 
faces, as shown in the image below. 

 

Moving solids and surfaces 

You can move solids and surfaces with the Select tool. 

To move a solid or surface 

You can do any of the following:  

 Select a vertex of a solid or surface, then drag it to move the solid or surface. (Surfaces on the 
same plane are treated as a single surface and move together.) 

 Alt+click a point, then drag the vertex to rotate in the plane of the screen.  

 Alt+click an edge or two points, then drag the vertex to rotate the object around the axis defined 
by the line or points.  

 You can place the dragged vertex on a plane or edge by dragging until the plane or edge is 
highlighted. 

Editing a sketch 

You can edit the dimensions of sketched lines, arcs, and points using the 
Select tool. Tangency is maintained when you edit a sketch. 

To edit a sketch 

1   Click the Select tool. (You can also press Esc if you are in a sketching 
tool.) 

Select the Select Reference Curve tool guide to dimension from 
another object, similar to the Shift+hover functionality in other tools. 
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2   Click and drag the line or point you want to edit. 

Alt+click and drag if you want to detach the line or point before moving it.  

Ctrl+click and drag to create a copy. 

Enter a value to dimension the move. 

To edit the length and angle dimensions of a line 

1   Click the endpoint of a line or arc to edit the length or diameter and  angle or chord angle dimensions of 
the line or arc. 

2   Mouse over the opposite endpoint of the line or arc to display a blue circle. 

3   Drag to move the reference point for the dimension's length. 

4   Enter the dimension for the length from the endpoint of the line to the new reference point. 

5   Mouse over the line showing the end of the angle reference to highlight it in blue. 

6   Drag the blue line to move the reference for the angle dimension. 

If you move the angular reference 360°, the angle measurement is changed from clockwise to 
counterclockwise. 

7   Enter the dimension to adjust the angle of the line from the new reference line. 

To edit the distance from another point 

1   Click the midpoint of a line, the center of an arc, or any sketched point to display a dimension to a 
reference point. 

2   Mouse over the reference point, then drag the blue circles to the location you want to dimension from. 

3   Click to set the new reference location. 

To skew the X-Y lines, click the outer blue circle and enter the skew angle. 

To change the properties of a sketch object 

1   Click the Select tool. (You can also press Esc if you are in a sketching tool.) 

2   Select the sketch object to display its properties in the Properties panel. 

You may need to adjust the width of the Properties panel or the columns within the properties panel. 
Place your mouse over the vertical column line and drag to widen the column. Place your mouse over 
the border of the panel and drag to widen the panel. 

3   You can: 

 Select a new color from the Color property to color the object. 

 Switch between lines and construction lines by selecting a value from the Construction property. 

 Switch between straight lines and mirror lines by selecting a value from the Mirror property. 

 Enter the number of sides for a polygon in the Number of Sides property. 

Copying a sketch 

You can copy a sketch line in Sketch mode with the Select tool. 

To copy a sketch line  

Ctrl+drag (with the Select tool) while sketching to copy a sketch line. 

Press the spacebar while Ctrl+dragging a sketch line to dimension the distance between the first line and 
the second, copied line. 
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Pulling with the Select tool 

You can pull with the Select tool or the Pull tool.  

To pull with the Select tool 

Drag the vertex of a selected face to another vertex to pull the selected face, as shown in the figure below. 

 

Pivoting with the Select tool 

You can pivot an edge with the Select tool or the Pull tool. 

To pivot an edge 

Drag the vertex of a selected edge to another vertex to pivot the selected face, as shown in the figure 
below. 

. 

Advanced selection techniques 

SpaceClaim offers a powerful method for selecting objects related to the one currently selected in the 
Selection window that are in the 
same component. 

To select objects similar to the 
currently selected object 

1   Select any 3D object. 

2   Click the Selection tab to 
display the Selection panel. 

The Selection tab is initially 
located at the bottom of the 
Structure panel. It displays the 
number and type of objects 
currently selected. 
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3   ects with the selected 

4   

(Optional) Select a type from the drop-down list to show only those obj
relationship. 

Select All Types to display all the geometry related to your selection. 

Click  to search for related objects in your design. 

hlight those 
objects in the Design window. 

in the list to add them to the current selection. 

2   

3   Click 

Related objects are displayed in the Related list. Mouse over the objects in the list to hig

5   Click any number of the related objects 

To find all the edge loops in a surface 

1   Select a face on the surface that contains one edge loop. 

Select Surface Edge Loop in the Selection panel drop-down. 

 to search for all the edge loops on the entire surface. 

ear on top of each other in the Design window. 

4   

This option is useful when edge loops app

To select and create potential patterns 

1   Select a protrusion or depression. 

2   Alt-click the planar face that contains the potential pattern. 

3   Select Recognized Pattern from the drop-down. 

Click  to display potential patterns containing the selected protrusion or depression. 

the 
selected protrusions or depressions into a pattern. 

isplay the count and dimensions for editing. 

 void 

s. 

2   Select Inner Faces from the drop-down. 

5   Right-click the potential pattern and select Create Pattern from the context menu to convert 

6   (Optional) Select a face of a pattern member to d

To select faces that surround an internal

1   Click a face of the solid with internal face

3   Click  to display all the internal faces. 

or 
es. You can select a face, then pull, dragging anywhere to act, or you can click, drag, and 

 pivot the face around that edge. When 

n 

going to happen at the edges of the face. By default, the edges 
of the face are determined by its neighbors, but you can override this behavior by including the edges in 

n extrusion. 

1   Select the faces and/or edges you want to work with. 

Pulling 

Use the Pull tool to offset, extrude, revolve, sweep, draft, and blend faces; use it to round, chamfer, 
extrude edg
release a highlighted face. In general, the result of a pull stays selected or highlighted after the pull 
operation. 

The action of the Pull tool depends on which faces and edges you select to work with, and which faces, 
planes, or edges you select to drive the change. For example, if you choose to work with a face, then select 
an edge to "drive" the pull, the Pull tool infers that you want to
multiple actions can be inferred, you can use the tool guides to correct the Pull tool's inference. The Pull tool 
maintains any offset, mirror, pattern, or coaxial relationships. 

When you pull a face, there are two main decisions you need to make. The first is to determine the directio
you want to pull in. A default direction is offered to you, but it can be overridden using the Direction tool 
guide. The second is to determine what is 

your Pull selection to create a

To create and edit solids 
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2   (Optional) Alt+click the face or edge that will drive the pull. 

ion of the Pull arrow. 

Detailed instructions

1   

3   Drag in the direct

Select the Pull tool  from the Edit ribbon group. 

Mouse over faces and edges in your design to preview the natural Pull direction. If your mouse is over 
ch one. 

2   

mand is useful when you want to dimension a Pull from a different 

3   

 option, arrows appear to indicate the 

 them from the mini-toolbar. 

5   

lighted, press Tab or click the Pull arrow you want to use.  

dimension field does 

 
n in which you are moving the cursor. When you pull, contiguous solids are 

d of the Pull arrow. Slide the gray bar to the left to subtract material, and to the right to add 

u want 

er 
rties. If you pull multiple, touching surfaces, the smaller 

largest one. 

nts under Designing > Editing > Pulling for the list of actions 
you can perform with the Pull tool. 

Within th

multiple faces or edges, use the scroll wheel to preview the Pull direction for ea

Select the faces and/or edges you want to pull to create 3D solids or surfaces. 

You can right-click in the Design window and select Anchor Pull Handle, then click to anchor the Pull 
handle on another object. This com
location than the center of a face. 

(Optional) Alt+click to select the face or edge that will drive the change. 

You can also select the appropriate tool guide, then click the face or edge. The driving edge or face is 
shown in blue. If you select the Show cursor arrowsSpaceClaim
directions you can move your mouse to edit the selected object. 

4   (Optional) Select options from the Options panel, or right-click and select

Click and drag in the direction of the Pull arrow to create or edit a solid. 

If the correct pull arrow is not high

Press Shift to snap while pulling. 

To dimension the pull, type the distance you want to pull and press Enter. (If the 
not appear editable, start typing while you are pulling to enter the dimension.) 

You do not have to click and drag on (or even near) the Pull arrow. In fact, we recommend that you 
move your cursor away from the arrow for more precise control of the pull. The only important input to
the Pull tool is the directio
automatically combined.  

If you want to pull in a head-on view, use the ruler at the bottom right corner of the Design window to 
pull instea
material. 

You can also click the Up To tool guide, then click the object that sets the plane up to which yo
to pull. (When pulling an edge, the face does not need to intersect the edge you are pulling.) 

If you pull through another object in the same component, the smaller object is merged into the larg
one, and receives the larger object's prope
surfaces are merged into the 

Press Esc to cancel the Pull. 

See the topics in the Table of Conte

Tool guides 

e Pull tool, there are several tool guides that let you specify the behavior of the Pull tool: 

 

The Select tool guide is active by default. When this tool guide is active, you can perform standa
selection tasks, and create natural offsets and rounds. Select a face, parallel faces, or surface 
edges to offset them. Select a solid edge to round it. Alt+click to select the driving face or edge 
for revolves, directed extrusions, sweeps, and drafts. Alt+double-click an edge to select an edge 
loop. Alt+doube-click again to

rd 

 cycle through alternate edge loops. You can select objects across 
multiple components to pull. 

 

Select a face to pivot or select a face and edge to revolve. Then use the Rotate tool guide to 
select the straight line, edge, or axis around which you want to pivot or revolve.  
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Use the Direction tool guide to select a straight line, edge, axis, origin axis, plane, or planar face 
to set the pull direction.  

 

Use the Sweep tool guide to select the straight or curved lines or edges along which you want to 
sweep. Faces and edges can be swept, and the sweep trajectory cannot be in the same plane as 
the face. 

 

Select any number of contiguous faces on the same body, then use the Draft tool guide to select 
the plane, planar face, or edge around which you want to pivot. None of the contiguous faces can 
be parallel to the neutral plane, face or edge around which you want to pivot. 

 

Use the Up To tool guide to select the object that you want to pull to. The pulled object's face or 
edge will mate with the surface of the selected body or be pulled up to a plane through the 
selection. 

Options 

The following options are available in the Pull tool. Once you select the edge or face to pull, select these 
options from the Options panel, or right-click and select them from the mini-toolbar: 
 

Add Select the Add option to only add material. If you pull in a subtractive direction, no 
change will occur. You can combine this option with other Pull options. 

Cut Select the Cut option to only remove material. If you pull in an additive direction, no 
change will occur. You can combine this option with other Pull options. 

Pull Both 
Sides 

Select a single, detached edge, imprinted edge, or surface, then click this option to pull 
both sides of the edge or surface at once.  

Full Pull 
Once you select the edge about which to revolve or sweep, click this option to revolve 
360 degrees or to the next face, sweep through the full trajectory, or blend through 
selected faces.  

 
Create Ruler 
Dimension 

Select this option, then click to connect a ruler, oriented along the pull axis, to an anchor 
edge or face. You can use the ruler to dimension the pull. The direction must be specified 
to successfully create a ruler dimension. Press Esc to cancel the ruler dimension. 

Round When you are pulling an edge, select this option to create a fillet. 

Chamfer When you are pulling an edge, select this option to create a chamfer. 

Extrude 
Edge 

When you are pulling an edge, select this option to extrude the edge into a surface. 

Copy Edge When you are pulling an edge, select this option to create a copy of the edge. 

Pivot Edge 
When you are pulling an edge, select this option to pivot the edge along the selected Pull 
arrow. 

Maintain Offset Select this option to maintain the offset relationship when pulling. 

Blend  
Select this option to create a blend between the selected faces, surfaces, or edges when 
you pull.  

Rotational 
Blend 

Select this option to create cylinders and cones whenever possible during the creation of 
a blend. 

Periodic Blend Select this option to go all the way around when blending. 

Show Take-Off 
Vectors 

Select this option to show the vectors created by maintaining tangency of neighboring 
faces and edges when blending. This option is especially useful when blending between 
edges. 
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Revolve Helix Select this option to create a helix. 

Right-Handed 
Helix Select this option to determine the direction in which the helix is revolved around its axis.

Rotational Rib Select this option to pull a rib in a rotational direction. 

Normal to 
Trajectory 

Select this option to keep every portion of the swept geometry normal to the sweep 
trajectory. 

Draft Both 
Sides 

Select this option to pivot the face on the opposite side of the reference face as well as 
the selected face. 

Examples 

 
About to cut a solid with a surface using the Pull tool's Cut option 

 
Drafting a face about a round 

 
Drafting non-contiguous faces 
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Drafting around a plane that does not touch the faces being drafted 

 
Pulling edges up to other edges 
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Offsetting or extruding faces 

When you offset a face with the Pull tool, the pull extends the 
neighboring faces without creating an edge. Extruding a face creates 
edges. 

To offset or extrude a face 

1   Make sure the Select tool guide   is active. 

2   Select the face or surface you want to offset or extrude. 

You can select multiple surfaces and faces of solids to offset or 
extrude them simultaneously. 

3   (Optional) Add edges to your selection. 

Select the edges of the face that you want to extrude when you 
pull. (Any unselected edges are defined by the neighboring 
geometry during the pull, creating an offset instead of an 
extrusion.) 

4   (Optional) Select options from the Options panel, or right-click 
and select them from the mini-toolbar. 

Select: 

 Add to add material during the pull. 

 Cut to remove material during the pull. 

 Pull Both Sides to pull both sides of a single surface or 
edge. 

 Create Ruler Dimension to dimension the pull to any 
reference point along the pull direction. 

5   (Optional) Select the Direction tool guide , then click the 
straight line, axis, or edge  if you want to offset or extrude in a 
different direction.  

You can also Alt+click a straight line, axis, or edge. Sometimes 
SpaceClaim guesses your intent incorrectly when you Alt+click 
the direction line. If this happens, just use the Direction tool 
guide to correct it. 

The pull direction is shown in blue. 

6   Click and drag the face in the direction of the Pull arrow. 
 

Dragging a: Does this: 
Solid face Offsets the face in its natural offset direction 
Solid face and all 
its edges 

Creates an extrusion 

Surface face Thickens or thins the face 
Corner edge of a 
solid 

Creates a round, chamfer, or extrusion, depending 
on the selected option 

Round or 
chamfer 

Offsets the round or chamfer 

Variable round Uniformly offsets the variable round  
Cylinder or cone Offsets the cylinder or cone 
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To dimension the offset, type the distance you want to pull and press Enter.  

You can also use the Up To tool guide to pull up to any edge, plane, surface, or face in your design. 

Extending or extruding surface edges 

hout creating a new edge. Extruding an 
edge creates edges. 

Press and hold Ctrl to offset a surface in both directions. 

Neighboring faces automatically extend to bound the offset face.  

You can extend or extrude the edges of any surface with the 
Pull tool. When you extend an edge, the pull extends the 
neighboring faces wit

To extend or extrude the edge of a surface 

1   Make sure the Select tool guide   is active.  

2    

3   l) Select options from the Options panel, or right-click and select them from the mini-toolbar. 

Select the outside edge of a surface.

Ctrl+click to select multiple edges. 

(Optiona

Select: 

 Add to add material during the pull. 

 Cut to remove material during the pull. 

 Create Ruler Dimension to dimension the pull to any reference point along the pull 

4    extend the edge. Press Tab or click the other Pull 

6   Drag in the direction of the Pull arrow to extend the edge or create a new surface perpendicular to the 

rrow you want to use.  

 
e does not intersect the edge you are pulling, the edge will be pulled parallel to the selected 

xtension, type the distance you want to extend the surface while you are pulling 
and press Enter.  

direction. 

Click the Pull arrow oriented along the surface to
arrow to extrude the edge in another direction. 

5   (Optional) Ctrl+click the vertex of one or both neighboring edges to ignore their influence. 

old one. 

If the correct pull arrow is not highlighted, press Tab or click the Pull a

The natural direction of a surface edge is in the plane of the surface. 

You can use the Up To tool guide to pull a linear edge up to a face, surface, edge, or point.  If the face
or surfac
object.  

To dimension the e
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Examples 

 
Pulling the edge of a surface up to another edge forms a solid 

 
Pulling the edge of a cylindrical surface extends the surface along a cylindrical path 

Rounding edges 

You can round the edges of any solid by selecting the Pull tool's Fillet option. 

To round an edge 

1   Make sure the Select tool guide   is active. 

2   Select the edge or edges you want to round. Double-click to select a 
tangent chain. 

Rounds are generated on exterior corners, and fillets are generated on 
interior corners. 

3   Select the Fillet option  in the Options window, or from the mini-toolbar. 

4   Click and drag the edge in the direction of the Pull arrow. 

To dimension the round, right-click and enter a radius length in the mini-toolbar, or type the radius 
length while you are pulling and press Enter. 

Once you create a round, pulling an adjacent face also pulls the round. 

Note: The face hidden by the round is remembered, so that if you fill the round it can be displayed. If 
you move a round, the face hidden by it also moved. 

To create a full round by pulling edges 

Select two edges that share a face, then pull until they meet to create a full round.  
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To create a full round by selecting faces 

1   Select three faces: the face that will become the full round, and the two faces that will share edges with 
the full round. 

All faces must be part of the same solid.  

2   Right-click and select Full Round from the context menu. 

To change a constant-radius round to a variable-radius round 

1   Make sure the Pull tool's Select tool guide   is active. 

2   Right-click the round face and select Edit as Variable Radius Round. 

3   Click the Pull arrow on the end of the round face and drag away from the face adjust the radius at the 
edge of the round. Click the Pull arrow pointing toward the center of the face and drag it along the face 
(or enter a length or percent) to set another point where you can adjust the round's radius. 

Two rounds that intersect at a shared edge can be made variable together by selecting the shared sharp 
edge for modification. Both rounds become variable at that point. They can be made variable 
independently by selecting the sharp end edge that is not shared by the rounds. 

Capping round faces 

Use the Fill tool  to remove and cap round faces. You might want to do this if you are trying to move a 
protrusion surrounded by round faces and it cannot be moved because the rounds create impossible 
geometry.  

Usually you can just select all the round faces and click the Fill tool to remove and cap them all. However, 
sometimes this is not possible. In that case, select one round and fill it. If that works, undo and select that 
round and the next. Undo. Continue adding rounds to your selection and trying to fill them until the fill fails. 
Now you have identified one of the rounds that is causing the problem. Next, fill all the rounds that filled 
successfully. Finally, repeat this process in the other direction of the round tangent chain. Once you have 
filled all the rounds except for the one or two causing the problem, select the one causing the problem and 
its two neighbors. Then click Fill. This process allows more options for the extension of neighboring edges to 
intersect and cap the round. 

Examples 
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Full rounds 

 
Editing a variable radius round 

Chamfering edges 

You can chamfer the edges of any solid by selecting the Pull tool's Chamfer 
option.  

When you make a hole in a chamfered face, the face is no longer a chamfer. 
You can still pull the face, or the hole, but you cannot change the chamfer to 
a round or dimension the chamfer. 

To chamfer an edge 

1   Make sure the Select tool guide   is active. 

2   Select the edge or edges you want to chamfer. Double-click to select a tangent chain. 

3   Select the Chamfer option  in the Options window, or from the mini-toolbar. 

4   Click and drag the edge in the direction of the Pull arrow. 

To dimension the chamfer, right-click and enter a setback distance in the mini-toolbar, or type the 
setback distance while you are pulling and press Enter. 

Extruding edges 

You can extrude the edge of any solid by selecting the Pull tool's Extrude Edge 
option. You can also extend and extrude surface edges.  

To extrude an edge 

1   Make sure the Select tool guide   is active. 

2   Select the edge or edges you want to extrude.  

Ctrl+click to select multiple edges. Double-click to select a tangent chain. 

3   Select the Extrude Edge option   in the Options window, or from the 
mini-toolbar. 

The Pull arrow changes to show the two directions in which you can extrude the edge. One arrow is 
highlighted to show the primary direction.  

4   If the arrow pointing the direction you want to pull is not highlighted, click the arrow or press Tab to 
change the direction. 

5   Click and drag the edge in the direction of the Pull arrow. 

To dimension the extrusion, right-click and enter a distance in the mini-toolbar, or type the distance 
while you are pulling and press Enter. 

Press Ctrl to copy the edges. 
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You can click the Up To tool guide and click a face, edge, or point to pull up to. If the face does not 
intersect the edge you are pulling, the edge will be pulled parallel to the face. If you pull the edge of a 
surface up to another object, the result is automatically solidified if it creates a closed volume. 

Pivoting edges 

You can pivot the edge of any solid with the Pull tool's Pivot Edge option.  

To turn a cylinder into a cone, select the Pull tool and the Pivot Edge option. Then click the edge of the 
cylinder and pull it until it forms a point. To turn a truncated cone into a cylinder, click the small edge and 
pull it out.  

To pivot an edge 

1   Make sure the Select tool guide   is active. 

2   Select the edge or edges you want to pivot. Double-click to select a tangent chain. 

3   Select the Pivot Edge option  in the Options window, or from the mini-toolbar. 

The Pull arrow changes to show the two directions in which you can move the edge to pivot the 
connected faces. One arrow is highlighted to show the primary direction.  

4   If the arrow pointing the direction you want to pull is not highlighted, click the arrow or press Tab. 

5   Click and drag the edge in the direction of the Pull arrow. 

During the pull, the distance you have moved the edge is displayed. You can dimension the distance in 
Section and 3D mode, and dimension the angle in Section mode. 

Example 

 
Dimensioning the angle of a pivot 
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Revolving faces 

You can revolve any face or surface with the Pull tool.  

To revolve a face 

1   Make sure the Select tool guide   is active. 

2   Select the surfaces, faces, or solids you want to revolve. 

3   Alt+click the straight line, axis, or edge to set the revolve axis. 

You can also select the Rotate tool guide , then click to set the revolve axis. The revolve axis is 
shown in blue. 

4   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar. 

Select: 

 Add to add material during the pull. 

 Cut to remove material during the pull.  

 Pull Both Sides to pull both sides of a surface simultaneously. 

 Full Pull to revolve 360 degrees. 

5   Click and drag in the direction of the Pull arrow to revolve the selected object, select the Up To tool 
guide and click an edge,  face, or plane, or select Full Pull from the Options panel or mini-toolbar. 

Neighboring faces automatically extend to define the boundaries of the revolved faces of solids. 
Revolving from a flat surface face has no neighboring faces, so it makes new face boundaries.  

Ctrl+drag to keep the faces parallel. 

To dimension the rotation, type the rotation angle while you are pulling and press Enter.  

Examples 

 
Revolve using cut, 180 degree revolve, and a full revolve of an ellipse around an asymmetrical axis 
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Ctrl+pulling vs. using the Pull Both Sides option to create ribs 

Revolving edges 

You can revolve an edge to form a surface with the Pull tool. You 
can revolve the edge of a solid or surface. 

To revolve an edge 

1   Make sure the Select tool guide   is active. 

2   Select the edges you want to revolve. 

3   Alt+click the straight line, axis, or edge to set the revolve axis. 

You can also select the Rotate tool guide , then click the 
revolve axis. The revolve axis is shown in blue. 

4   Click and drag in the direction of the Pull arrow to revolve the 
selected edge or select the Up To tool guide and click an edge 
or face to revolve up to. 

Ctrl+click to select edges of faces along with the face to force the pull tool to create new neighboring 
faces to contain these edges (essentially changing from a draft to a revolve). Unlike other CAD products, 
SpaceClaim allows revolving planar and non-planar edges and faces about lines that do not lie in those 
planes. This allows skewed rotational solids and surfaces. 

To dimension the rotation, type the rotation angle while you are pulling and press Enter.  

Revolving helices 

You can revolve a helix with the Pull tool.  

To revolve a helix 

1   Make sure the Select tool guide   is active. 

2   Select the face or edge you want to revolve. 

3   Select the Revolve tool guide. 

4   Click the axis you want to revolve around. 

5   (Optional) Set the handedness of the helix by checking or 
unchecking the Right-Handed Helix option in the Options panel. 

6   Press the spacebar and enter the length and pitch or pull along the axis to create the helix dynamically. 

Pitch is the amount that the helix face shifts per 360 degrees of rotation. Length is the total length of 
the helix. 
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Sweeping faces 

You can sweep a face along a trajectory with the Pull tool. Sweeping a face around a closed path creates a 
torus.  

To sweep a face 

1   Make sure the Select tool guide  is active. 

2   Select the surfaces or faces you want to sweep.  

3   Alt+click the line or edge along which you want to sweep. 

You can also select the Sweep tool guide , then click the sweep trajectory. 
The sweep trajectory is shown in blue. Alt+double-click to select a tangent 
chain. Ctrl+click to add contiguous paths. 

Sweep works best when the sweep line is perpendicular to and touches the 
face you want to sweep. To quickly draw a sweep line, select the face, click the 
Line or Spline tool, select the Move Grid tool from the mini-toolbar, press Shift, 
and drag the Move handle's axis to rotate the sketch grid 90 degrees.  

To quickly sketch a face perpendicular to a desired trajectory, select the end of 
the trajectory and select a sketching tool to place the sketch grid at that point. Then draw the face. 

4   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar. 

Select: 

 Normal to Trajectory to keep the swept surface normal to the sweep trajectory. If your sweep 
trajectory is perpendicular to the face you want to sweep, this option is enabled for you. 

 Add to add material during the pull. If you sweep through another solid, it is merged into the 
swept solid. 

 Cut to remove material during the pull. If you sweep through another solid, material is 
removed. 

5   Click and drag in the direction of the Pull arrow to sweep the selected objects, or select Full Pull 
from the Options panel or mini-toolbar to sweep the entire length of the trajectory. If you select Full Pull 
and the face or surface being swept is in the middle of the trajectory, it will be swept in both directions. 

You can also use the Up To tool guide to select a face or surface on which you want to end the sweep. 

To create a torus 

1   Sketch a circle to describe the path. 

2   Select the circle and click the Insert Axis tool.  

3   Switch to 3D mode. 

4   Select the axis. 

5   Click the sketch tool you want to use to make the torus cross-section to automatically place the sketch 
plane perpendicular to the circle. 

6   Draw the sketch centered on a point on the edge of the circle. 

7   Sweep along the circle using the Full Pull option to create the torus. 
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Example 

 
Hexagons swept around circular and hexagonal sweep paths 

Drafting faces 

You can draft faces around another face or surface with the Pull tool.  

To draft a face 

1   Make sure the Select tool guide   is active. 

2   Select the face or contiguous faces you want to draft.  

3   Alt+click the face (including rounds) or surface about which you 
want to draft. 

You can also select the Draft tool guide , then click the face or 
surface. The draft face or surface is shown in blue. 

If you select two edge loops instead, you can create a split draft. 

4   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar. 

Select: 

 Add to add material during the pull. 

 Cut to remove material during the pull. 

 Draft Both Sides to pivot the face on the opposite side of the reference face as well as the 
selected face.  

5   Click and drag in the direction of the Pull arrow to draft the selected faces. 

To dimension the draft, type the rotation angle while you are pulling and press Enter.  

Examples 

 
Drafting around a spline surface 
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Blending 

Blending between faces 

You can blend between two faces with the Pull tool.  

To blend between two faces 

1   Make sure the Select tool guide   is active. 

2   Select the surfaces or faces you want to blend through. 

When you blend between two faces, the blend surface begins 
tangent to the edges of the initial faces and ends tangent to the 
edges of the end faces. To prevent this behavior, select the 
edges you do not want to use for tangency. The figure on the 
right shows the blends created with and without the effects of 
the edges. 

The edges of the blend are displayed. If they aren't, check that 
the  Blend option is selected in the Options window. 

3   (Optional) Alt+click the edges or lines you want to use as guides 
for the blend. 

4   (Optional) Click and drag the blend points to modify the blend 
edges. 

5   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar. 

Select: 

 Rotational Blend to create cylinders and cones whenever possible during the creation of a blend. 
You must have selected faces rotated around a common axis.  

 Periodic Blend to go all the way around when blending. You must have selected three or more 
faces rotated around a common axis, that also span an arc greater than 180 degrees. (Blending 
between 3 equal-radius circle faces creates a torus.) 

6   Click, drag, and release in the direction of the Pull arrow or select Full Pull from the Options panel or 
mini-toolbar to create the blend. 

Examples 

 
Blend between two surfaces using splines to guide the blend 
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Blend with edge tangency (no edges pulled) and blend without edge tangency (edges pulled) 

 
Blend between multiple surfaces, automatically ordered to prevent self-intersection 

 
Blend between multiple lines in space (profiles) with take-off vectors 
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Blending between edges 

You can blend between two edges with the Pull tool   in the Edit ribbon 
group on the Design tab. 

To blend between two edges 

1   Make sure the Select tool guide   is active. 

2   Click the   Blend option in the Options window. 
3   Click the starting edge of the blend. 

4   Ctrl+click the ending edge of the blend. 

5   (Optional) Check the Show take-off vectors option to display and adjust the angle at which the new 
edge will be created if it is not set automatically by tangency. 

You can adjust the length of a blend’s take-off vector to adjust the magnitude of the take-off (non-
tangent) or tangential influence at that point. You can also adjust the plane of rotation of a blend take-
off vector.  

6   Click, drag, and release in the direction of the Pull arrow or select Full Pull from the Options panel or 
mini-toolbar to create the blended surface. 

When a blend between splines will self-intersect, the splines are modified slightly to prevent this from 
happening.  

To blend between multiple edges 

1   Make sure the Select tool guide  is active. 

2   Select the two edges to blend between. 

3   Press Ctrl+Alt and select the other one or two edges that will guide the blend. 

The edges of the blend are displayed. If they aren't, check that the  Blend option is selected in the 
Options window. 

4   Select Full Pull from the Options panel or mini-toolbar to create the blended face. 

If you create a blend that results in a surface contained within a solid, the surface remains a separate 
object. 
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Example 

 
Blending between a surface edge and line in space using the Full Pull option 

Blending between points 

You can create a curve with the Pull tool by using the Blend option to blend between points. You can blend 
between any two points to create a curve, or select multiple points to create a spline. 

To blend between points 

1   Ctrl+click to select multiple points or vertices. 

The Blend option is selected automatically. 

2   Ctrl+click neighboring edges of the vertices if you want the blend curve to begin tangent to those edges. 

3   Click the Full Pull option in the Options panel to create the curve. 

4   If you want the curve to appear as a separate object in the Structure tree, right-click the curve and 
select Name Sketch Curve. 

Examples 

 
Blend curves tangent to neighboring edges 
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Creating slots 

You can create slots from holes using the Pull tool. You can also edit slots. Slots maintain the relationship 
between their faces. 

To create a slot 

1   (Optional) Select the Pull Both Sides option to create the slot in both directions. 

2   Pull the axis or face of a hole to create a slot. 

To create a curved slot 

1   Select the axis or face of a hole. 

2   Select the Rotate tool guide and click the axis of the driving cylinder. 

You can also Alt+click the axis of the driving cylinder. 

3   Pull the hole to create a curved slot. 

You can pull a curved slot 360 degrees to make a round cut. 

To create a radial slot 

1   Select the axis or face of a hole. 

2   Do one of the following: 

 Alt-click the face of the driving cylinder to set the direction of the Pull towards the axis of the 
driving cylinder. Click the Pull Direction tool guide and pull the hole to create a radial slot.  

 Ctrl-click the face of the driving cylinder to set the direction of the Pull towards the axis of the 
driving cylinder. Click the Pull Direction tool guide and pull the hole to offset the cylinder and 
create a radial slot simultaneously. 

 Select the Pull arrow that points toward the axis and pull. 

If you want to lengthen a radial slot while keeping it the same distance from a radial face, Ctrl+click the 
radial slot's axis and the face, then pull. 

If you want to move a slot along with a radial face Ctrl+select the hole’s axis and the face, then Ctrl+pull. 

To edit a slot 

You can modify a hole that was dragged to form a slot by pulling on any of the slot axes.  

To move a slot radially 

1   Select the Pull tool. 

2   Select both axes of the slot. 

3   Do one of the following: 

 Alt-click the face of the driving cylinder to set the direction of the Pull towards the axis of the 
driving cylinder. Click the Pull Direction tool guide and Ctrl-drag to move the slot radially.  

 Ctrl-click the face of the driving cylinder to set the direction of the Pull towards the axis of the 
driving cylinder. Click the Pull Direction tool guide and Ctrl-drag to offset the cylinder and move the 
slot. 

(You can move a hole radially by pressing Shift while dragging it with the Pull tool.) 
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To remove the slot relationship 

Right-click a face of the slot and select Remove Association.  

Any changes you make to the slot's face will affect only that face. 

Example 

 
Pulling a circular slot to make a round cut 

Scaling 

You can scale solids and surfaces with the Pull tool. You can scale multiple objects in different components. 

To scale a solid or surface 

1   Make sure the Select tool guide   is active. 

2   Select a solid or surface. 

3   Click the Scale Body tool guide .  

4   Click a point, vertex, or origin to set the origin for scaling.  

5   Pull to scale dynamically or press the spacebar and enter the scale. 

You can use enter expressions to calculate a scale factor. 

The following expression elements are available: 

 Infix (dyadic) operators:  + - * / ^ 

 Prefix (monadic) operators:  + - 

 Functions:  sin cos tan asin acos atan sqrt log log10 exp 

 Constants:  pi e root2 root3 

 Units:  m cm mm yd ft in ' " deg rad 

Normal precedence rules apply: 

1 + 2 * 3 ^ 4 => 1 + (2 * (3 ^ 4))) = 163 

Parentheses are required for expression arguments and optional for simple arguments: 

 sqrt 2 == sqrt(2) = 1.4142... 

 sqrt 2*2 => (sqrt 2) * 2 = 2.8284... 

 sqrt(2*2) = 2 

Missing operators are inferred: 

 1 1/2 => 1 + 1/2 
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 1’6” => 1’ + 6” 

 1ft 6in - 17in => 1ft + 6in - 17in 

 1 2 3 4 5 => 1 + 2 + 3 + 4 + 5 = 15 

 (1)(2)(3)(4)(5) => (1) * (2) * (3) * (4) * (5) = 120 

 2(1 + 2) => 2 * (1 + 2) = 6 

 sqrt 2 sqrt 2 => sqrt 2 * sqrt 2 = 2 

 4(4atan(1/5) - atan(1/239)) => 4 * (4 * atan(1/5) - atan(1/239)) = pi 

Units are applied to previous terms if units were not specified and are applied to subsequent terms unless 
you override them: 

 1 + 1cm => 1cm + 1cm 

 1cm + 1 => 1cm + 1cm 

 1cm + 1 + 1mm => 1cm + 1mm + 1mm 

 1cm + 1 1/2 mm => 1cm + 1mm + 1mm / 2 

Trigonometry functions work in radians by default, but you can enter degrees: 

sin(45 deg) 

Numbers support standard form, but e is a built-in constant: 

 2e2 = 200 
2e 2 => 2 * e * 2 = 10.873... 

 2e-2 = 0.02 
2e – 2 => 2 * e – 2 = 3.436... 

 2e1 = 20 
2e => 2 * e 

 

Do it 
faster 

Select the solid or surface, Alt+click a vertex to anchor the scale, and pull. 

To convert an existing solid or surface from millimeters to inches 

1   Change the units to inches as described above. 

2   Select the Pull tool in the Edit ribbon group on the Design tab. 

3   Select the object you want to convert. 

4   Scale the object by 25.4. 
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Copying edges and faces 

You can copy edges and faces by selecting the Pull tool's Extrude Edge option. You can also copy edges and 
faces with the Move tool.  

 

To copy an edge or edges 

1   Make sure the Select tool guide   is active. 

2   Select the edge or edges you want to copy. 
Double-click to select a tangent chain. 

3   Select the Copy Edge option  on the 
Options panel, or from the mini-toolbar. 

You can also Ctrl+drag with the Pivot Edge or 
Extrude edge options selected to copy the 
edge. 

The Pull arrow changes to show the two 
directions in which you can create copies of 
the edge. One arrow is highlighted to show 
the primary direction.  

4   If the arrow pointing the direction in which you want to copy the edge is not highlighted, click the arrow 
or press Tab to change the direction. 

5   Drag the edge in the direction of the highlighted Pull arrow. 

During the pull, the distance between the copied edge and the new edge is displayed. When you create 
an external edge, a surface is created between the copied edge and the new one. 

Do it 
faster 

Press Ctrl and drag to copy the selected face. 

Example 

 
When copying an edge, the edge adjusts based on the solid's geometry 
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Copying a round face 

Moving 

Use the Move tool to move any object, including drawing sheet views. The behavior of the Move tool 
changes based on what you have selected. If you select a solid or surface, you can rotate or translate it.  If 
you select a face or edge, you can pull or move around it. You can move 2D and 3D objects. 

When moving long distances, we recommend that you make a series of small movements to get there. 
When moving many faces, make sure to manually select all the faces that should be moved, instead of 
relying on SpaceClaim to automatically grab the interstitial faces. 

You can also use the Select tool to move objects by dragging them. 

To move an object 

1   Select the object you want to move. 

2   Use the Move handle to move the object. 

Detailed instructions

1   Select the Move tool  from the Edit ribbon group. 

2   Select the object that you want to move to display the Move handle. 

You can select multiple objects. (Use the Select Component tool guide to select the solid or component 
to which a clicked object belongs.) 

3   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar. 

4   (Optional) Drag the center point of the Move handle to anchor it to any face or edge in your design. 

You can also use the Anchor tool guide to select the face, edge, or vertex on which to place the Move 
handle. The yellow center sphere turns into a blue cube when the Move handle is anchored. 

5   (Optional) Re-orient the Move handle. 

Drag one of the small balls on the rotational axis to reorient the Move handle, or dimension the 
orientation by typing the rotation angle while you are 
dragging, thenpressing Enter. 

You can also Alt+click a point or line (or click the Move 
Direction tool guide, then click a point or line) to orient one of 
the Move handle's axes toward that point or along that line. If 
you Alt+click a trajectory, you can move along the trajectory. 
(Ctrl+Alt+click to add contiguous lines or edges to the 
trajectory.) If you Alt+click a plane, the direction of movement 
is set perpendicular to the plane. 
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6   Click an axis and drag in that direction to move the selected object. 

A dotted line extends from the Move handle axis to indicate the direction you selected for movement. 

You can press Ctrl to copy the object selected for movement and place it at the location at which you 
drag or dimension the move. Press Ctrl+spacebar to make a copy and place it at the dimension you 
enter. 

To dimension the move in Section mode, type the length of the move or the rotation angle (the angle 
can be positive or negative) and press Enter. You can also right-click and select Create Ruler 
Dimension from the mini-toolbar or the Options panel to dimension the move to any reference point 
along the move direction that you click. 

The cursor does not need to be on the axis to move the selected object. In fact, you may find it easier 
to control the move if you drag some distance from the entity and the Move handle. 

You can click the Up To tool guide and click a face or plane to move the selected object until the center 
of the Move handle is at the face or plane. You can also use this tool guide to rotate a solid, face, or 
surface until it is parallel to a face clicked with the Up To tool guide. Or use it to move to a point along a 
trajectory. 

The Move tool respects offset, mirror, and coaxial inferred relationships, if they exist. 

If you move a face that is in the same plane as another face, the face is detached. 

If you move an object into another object in the same component, the smaller object is merged into the 
larger one, and receives the larger object's properties. 

Moving a component moves all its subcomponents and objects. 

If the move fails, the Move handle is repositioned to the last valid location and orientation. If you are 
trying to move a protrusion surrounded by round faces, you may need to fill the rounds. 

You can also use the Move tool to: 

 Pivot solids 

1   Select an edge loop on the solid that you want to pivot. 

2   Click a linear axis of the Move handle. 

3   (Optional). Click the Fulcrum tool guide and click an alternate plane to pivot around. 

4   Drag to pivot the solid around a plane drawn through a point opposite the selected edge loop 
or to pivot the solid around the plane you selected with the Fulcrum tool guide. 

If the 
Move tool cannot maintain a planar or cylindrical face while pivoting, it will create a blended 
face. 
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 Pull solids 

You can use the Move tool to pull solids. If you select a face and move it, the solid is extended in 
the direction of the move. 

 Create patterns 

 Explode an assembly 

Tool guides 

Within the Move tool, there are several tool guides that let you specify the behavior of the Move tool: 
 

 

The Select tool guide is active by default. When this tool guide is active, you can select faces, 
surfaces, solids, or components within the Move tool.  

Click any object with the Select Component tool guide to select the solid to which the object 
belongs. Click again to select the component to which the object belongs. 

Select a point, vertex, line, axis, plane, or planar face with the Move Direction tool guide to 
orient the Move handle and set the initial direction of the move. (The object will not move until 
you drag.) 

 

Select a set of lines or edges with the Move Along Trajectory tool guide to move the selected 
objects along that trajectory. For best results, perform Moves along trajectories in small 
increments. If the object to be moved is a protrusion, it will be detached, then reattached in the 
new location. When you move a protrusion along a trajectory, rounds are automatically removed. 

 

Select an object, then use the Anchor tool guide to select the face, edge, or vertex that will 
anchor the move.  You can anchor the Move handle to a temporary object, such as the 
intersection between two axes by Alt+Shift+clicking the two objects. 

Select an object, then use the Fulcrum tool guide to move other objects around it. Select a 
pattern member to anchor it, or select a component to explode an assembly. 

 

Once you select the object to move and a Move handle axis, use the Up To tool guide to select 
the object you want to move up to. If a Move handle axis is selected, the Move is limited to that 
direction. (The axis must be selected to move up to the axis of an origin.) In a linear move to an 
intersecting object, the center of the Move handle is moved to the selected object. If the two 
objects do not intersect, the first object is moved parallel to the second. You can also select a 
point along a trajectory or the axis of an origin to move up to. You can also use this tool guide to 
move the sketch grid in Sketch and Section modes. 

 

Once you select the object to move and a Move handle axis, use the Orient to Object tool guide 
to click an object. Your selected object will move until the selected Move handle axis is aligned 
with the clicked object. You can also use this tool guide to move the sketch grid in Sketch and 
Section modes. 

Options 

The following options are available in the Move tool: 
 

Move Grid Select this option to move the sketch grid. 

 
Create Ruler 
Dimension 

Once you select an axis on the Move handle, select this option and click an edge or face 
to anchor the ruler. The ruler is oriented along the selected Move handle axis. Enter a 
value to use the ruler to dimension the move. 
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Maintain 
Orientation 

Select this option to maintain the orientation of the object when rotating or moving along 
a trajectory. 

Create 
Patterns 

Select this option if you want to create a pattern by Ctrl+dragging selected objects with 
the Move tool. Ctrl+dragging creates a copy of the selected object and moves it to a new 
location. If this option is enabled, a pattern relationship is also created. 

Detach First Select this option to detach a protrusion, move it, and reattach it at the new location. 
 

Moving in two dimensions 

Use the Move tool to move lines or points with the Move handle. When you move points or lines with this 
tool, they do not maintain their connections to other lines or points. If you want to maintain the connections 
in your sketch, use the Select tool to edit the sketch. 

To move sketch entities 

1   Click the Move tool. 

2   Select the line or point you want to move. 

3   Use the Move handle to move the line or point. 

Detailed instructions

1   Select the Move tool  from the Edit ribbon group. 

2   Select the line or point on the sketch grid that you want to move to display the Move handle. 

You can select multiple sketch entities. 

3  (Optional) Drag the center point of the Move handle to anchor it to any endpoint or midpoint of any line 
on the sketch grid.  

This functionality is useful when you want to rotate a sketch entity around another point on the sketch.  

4  (Optional) Click the Move Direction tool guide and click a line or edge to reorient the Move handle.  

You can also Alt+click the line or edge to reorient the Move handle. 

5   Click an axis and drag in that direction to detach and move the selected sketch entity. 

To dimension the move, type the length of the move or the rotation angle and press Enter. 

The cursor does not need to be on the axis to move the selected object. In fact, you may find it easier 
to control the move if you drag some distance from the entity and the Move handle. 

Creating patterns 

You can create a pattern of protrusions or depressions (including slots), points, or components. You can 
also create a pattern from a mix of object types, such as a pattern of holes (faces) and bolts (imported 
components) In SpaceClaim, any pattern member can be used to modify the pattern after you create it. If 
the change cannot be made to all pattern members, the member that cannot change is still part of the 
pattern. 

Any of the Move tool's tool guides are available to you while creating a pattern. 

To create a linear pattern 

1   Select a protrusion or depression to be the first member of the pattern. 

2   Select the Move tool. 

3   Check the Create patterns box in the Options panel. 

4   (Optional) Alt+click to set the direction for the pattern (or use the Direction tool guide).  
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5   Ctrl+drag the first member to copy it to the location of the last member of the linear pattern. All pattern 
members will be created between the first member and this member in a straight line. You can use the 
Up To tool guide to set the position. 

7   Press Tab, enter the number of members you want to have in the whole pattern in the Count field, and 
press Enter to create the linear pattern. 

To create a rectangular pattern 

Follow the steps for the linear pattern, but select a linear pattern as the first member of the pattern. 

To create an arc, circular, or cylindrical pattern 

1   Select a protrusion or depression to be the first member of the pattern. 

2   Select the Move tool. 

3   Check the Create patterns box in the Options panel. 

4   Alt+click to center the Move tool on the center of the circular pattern. 

5   Ctrl+drag the first member to copy it in a rotational direction. 

As soon as you pass a certain rotation threshold, you can preview the possible patterns. If you want a 
more closely-packed pattern, edit the pattern after you create it. If you want to create an arc pattern, 
mouse up at a location that does not form a circular pattern. 

6   Mouse up to select the circular pattern. 

7   Press Tab to enter the number of members you want to have in the whole pattern in the Count field. 

To create a radial pattern 

1   Select a protrusion to be the first member of the pattern. 

2   Select the Move tool. 

3   Check the Create patterns box in the Options panel. 

4   Use the Direction tool guide to set the direction of the Move tool toward the axis. 

5   Ctrl+drag the first member to copy it in a radial direction. 

As soon as you pass a certain rotation threshold, you can preview the possible patterns. If you want a 
more closely-packed pattern, edit the pattern after you create it. If you want to create an arc pattern, 
mouse up at a location that does not form a circular pattern. You can edit the incremental rotation 
angle. 

6   Mouse up to select the radial pattern. 

7   Press Tab to enter the number of members you want to have in the whole pattern in the Count field. 

To create a radial circular pattern 

1   Select all radial pattern members with the Move tool. 

2   Re-anchor the Move tool on the circular axis. 

3   Check the Create patterns box in the Options panel. 

4   Ctrl+drag the radial pattern to form a circular pattern. 

To create a pattern of points 

1   Click a vertex with the Move tool. 

2   Check the Create patterns box in the Options panel. 

3   Click the Move Along Trajectory tool guide. 

4   Click one of the edges that connects to the vertex. 
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5   Click the Move handle axis. 

6   Ctrl+drag to create the end pattern member and create the pattern. 

7   Click the new point with the Select tool to display and edit the count, the length along the edge, and the 
percentage of the edge that is between the first point and the end point. (For example, a point with a 
dimension of 50% appears at the midpoint of the edge.) 

Modify the count, length, and percent fields to edit the pattern of points. All points are associated to the 
edge, so that when the edge moves, the points move with it. 

When you create a pattern of points along an edge, points that are coincident to vertices are not 
included in the pattern.  

To edit a pattern's properties 

1   Select the face of one pattern member to display the pattern count and dimensions. 

2   Edit the pattern's properties. 

Press Tab to switch between the fields. 

3   Press Enter. 

To move a radial pattern in a linear direction 

1   Select all the members of the pattern. 

2   Select the Direction tool guide. 

3   Click an object to set the direction of the move. 

4   Drag the pattern. 

To move a pattern member 

1   Select a pattern member. 

2   Move the pattern member with the Move handle. 

If you move one of the middle members of a pattern, all the pattern members move, unless one is 
anchored. 

If you move a member at one end of a pattern, the member at the other end of the pattern 
automatically anchors itself, allowing you to adjust the spacing of the pattern. 

If you anchor a different member than the member opposite the direction you are moving, Move skews 
the pattern. 

If you have a linear pattern in a radial direction and you move a middle member without setting an 
anchor, then the entire pattern shifts in the selected direction. 

To anchor a pattern member 

1   Select the Fulcrum tool guide. 

2   Click a face of the pattern member you want to anchor. 

You can anchor any member of a linear or rotational pattern. 

To adjust linear pattern spacing 

1   Anchor a middle pattern member. 

2   Move another pattern member to adjust the spacing of the pattern around the anchored member. 

To adjust circular pattern spacing 

1   Select a member. 
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2   Drag the member with the Select tool to adjust the distance from the center of the pattern and the 
spacing between members. 

To add rounds or chamfers to a pattern 

1   Select the edge or edges of a pattern member. 

2   Right-click the selected edge and click Select > Pattern Edges to select all the corresponding edges in 
the pattern. 

3   Modify the edge(s) to create a round or chamfer. 

To remove a pattern member from the pattern 

Right-click the face of the pattern member and select Unpattern Member. 

Example 

 
Pattern of points 

Exploding an assembly 

1   Select all the components in the Structure tree that are part of the assembly you want to explode. 

2   Anchor the Move handle on one component. 

3   Select the Fulcrum tool guide and click another component. 

4   Select an axis on the Move handle and drag to explode the assembly in that direction. 
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Filling 

Use the Fill tool to fill in the selected region with the surrounding surface or solid. Fill can "heal" many cuts 
made into geometry, such as chamfers and rounds, subtractive revolves, protrusions, depressions, and 
regions removed by removing regions in the Combine tool. The Fill tool can also be used to simplify surface 
edges and cap surfaces to form solids. 

You can use the Fill tool in Sketch mode to fill a sketch line that is almost closed, but that has multiple small 
gaps. If the gaps are too large, multiple error message appear to show you where the gaps are. You can 
also use it when editing a layout. Fill functionality is useful when you sketch faces across section lines, but 
do not want the section lines to split the surfaces when you switch to 3D. 

To fill a region 

1   Select the edges that define a surface region, or the faces that define a region within or on a solid. 

You can select an object in the Structure tree to simplify it. 

2   Click the Fill tool  or press F. 

To fill sketch or layout lines 

1   Select a closed or almost closed loop of sketch lines. 

2   Click the Fill tool  or press F. 

If a gap is 1.5 times the length of the minor grid spacing on the sketch grid, the edges are extended to 
close the gap. If the gap is larger, a message appears in the status bar and the gap's endpoints flash. 

The mode is switched to 3D mode, and the filled loop becomes a surface. 

You can select the face of a solid when only the edge is displayed (such as in a drawing sheet view) 
using the scroll wheel. The edge becomes a slightly thicker line when the face is highlighted. If you fill 
lines in a layout mode, you can then pull the surface into 3D from the layout, but remain in edit layout 
mode after this action. 

You can fill lines and edges whether or not the sketched lines you want to fill were sketched in the same 
plane as the edges. (If the lines are imprinted on a face and become edges, filling those edges deletes 
them.) 

 

Do it 
faster 

Click the Fill tool in Sketch mode to fill any closed or almost closed loops and switch to 
3D mode. 

 

You can use the Fill tool to: 
 Cap a surface 

Select the edges of the surface you want to cap and click the Fill tool.  

For example, to fill an uncapped cylinder, select the open edge and click the Fill tooll. 
 Patch a surface 

Select the 
edges of a void 
in the middle
a surface or the 
edges of a void 
on the edge of 
a surface and 
click the Fill 

 of 

tool. 
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If you select two surface edge loops and select the Fill tool, the surfaces are extended until 

 
ate caps if necessary. 

 a round that removes the underlying face, 
ther action.) 

 
sion or depression and click the Fill tool. 

he edges are simplified into straight lines. You can also press 
elete to simplify the edges. 

 

they intersect. 
Fill a round or chamfer 

Select the round or chamfer and click the Fill tool to fill the round and cre

A RoundGroup is created in the Groups panel each time you fill a round. 

(You can fill any round created in SpaceClaim, even
until the round is changed by some o
Remove a protrusion or depression 

Select the protru
 Simplify edges 

If you fill the edges of a face, t
D

 

 
You can also fill all the edges of a spline surface to extend all the edges to form a simpler, larger 

s multiple surfaces or solids into one edge. Just select the 

lines, select them before clicking the Fill tool. 
 Fill multiple edge loops 

surface. You can also press Delete to simplify the edges. 

You can also fill complex edges on any other surface, including cones. 

You can simplify multiple 3D edges acros
edges you want to merge and click Fill. 

If you want to keep internal 

 
You can select multiple edge loops in the same solid or surface then click Fill to fill them – even if, 
when extended, the faces containing the edge loops would connect to other faces. 
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 Replace a face 

1   If you are replacing a 
single face, click the face 
you want to replace. 

2   Alt+click the replacement 
face. 

3   Select the Fill tool. 
 Replace multiple faces 

Ctrl+click any number of 
faces with the Select tool. 
Then Ctrl+Alt+click any number of additional faces. Click the Fill tool to replace the first set of 
faces with the second set of faces. 
 Remove rounds 

To fill a round 

1   Select the round face. 

2   Click the Fill tool  or press F. 

When multiple selected round faces are removed by the Fill tool, they are removed in a specific 
order so that they can be restored by right-clicking and selecting Reattach Rounds for each 
group, in reverse order. The image on the right shows edges from which rounds were removed by 
the Fill tool. 

If removing a face makes an invalid solid, the solid is converted to a surface. 

If a round face is difficult to remove, try Alt+clicking it with the Fill tool, or using the Replace tool.  

 

Capping round faces 

You can use the Fill tool to remove and cap round faces. You might want to do this if you are 
trying to move a protrusion surrounded by round faces and it cannot be moved because the rounds 
create impossible geometry.  

Usually you can just select all the round faces and click the Fill tool to remove and cap them all. 
However, sometimes this is not possible. In that case, select one round and fill it. If that works, 
undo and select that round and the next. Undo. Continue adding rounds to your selection and 
trying to fill them until the fill fails. Now you have identified one of the rounds that is causing the 
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problem. Next, fill all the rounds that filled successfully. Finally, repeat this process in the other 
direction of the round tangent chain. Once you have filled all the rounds except for the one or two 
causing the problem, select the one causing the problem and its two neighbors. Then click Fill. This 
process allows more options for the extension of neighboring edges to intersect and cap the round. 

 

 

Examples 

 
Simplifying edges 

 

 
Simplifying edges across multiple faces 

 

 
Capping a surface 

 
Capping a surface that crosses multiple edges 
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Selecting internal edges to keep 
them after filling.  

Selecting lines to simplify a surface 
by filling. Internal edges are 
removed. 

 

 
A difficult-to-remove round replaced before removing 

Replacing 
faces 

to 

hich are almost aligned. 

Use the Replace tool 
replace one face (or 
multiple faces) with 
another face (or faces). 
You can also use it to 
simplify a spline face that 
is very similar to a 
cylinder, or align a set of planar faces w

To replace a face 

1   Click the Target tool guide. 

2   Select the face you want to replace. 

You can also select multiple faces. 

3   Click the Source tool guide. 

4   Click the face (or faces) you want to replace the target face with. 
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5   Clic
 

k the C  omplete tool guide to replace the target face with the source face.

Do it Click one face, then the next to replace the first with the second. 
faster 

To simplify or align faces 

1   Click the Target tool guide. 

2   

pulsating red glow to indicate that they will be simplified or aligned. 

2   Click the Complete tool guide. 

Within the Replace tool, there are several tool guides that help step you through the editing process: 

Ctrl+click each face. 

The faces are displayed with a 

Tool guides 

If you did not pre-select the face that you want to replace, you can select it from within the 
Replace tool using the Target tool guide.  

Click the face you want to replace the target face with using the Source tool guide.  

Click the Complete tool guide to replace the target face with the source face, or to simplify or 
align the target face. 

Examples 

 
Faces that are almost planar targeted for alignment 

u can move any blend section, or you can edit it by moving 

eometry. Any two planar faces can be edited as a blend, but a single face 

You may find it useful to display a grid on the face when editing the face as a blend. 

1   Select the faces you want to convert to blended surfaces, or select existing blended faces. 

Editing faces as a blend 

You can use the Edit as Blend tool to edit any blended face or convert a regular face to a blended one. You 
can create a new blend section or delete one. Yo
an edge, moving a vertex, or bending an edge. 

If a face was originally created as a blend, the original blend surfaces will appear for editing, even if the 
faces originated as imported g
cannot be edited as a blend. 

To edit a face as a blend 
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2   Use the Edit as Blend tool to display the blend sections. 

3   Move, rotate, or edit the interior blend sections.  

You can also add or delete interior blend sections. 

Detailed instructions

1   Select the faces you want to convert to blended surfaces, or select existing blended surfaces. 

We recommend that you use the more powerful Select tool to do this, but you can also select faces 
within the Edit as Blend tool after the next step. 

2   Click the Edit as blend tool  in the Edit ribbon group to display the blend planes. 

If you did not pre-select the faces, you can select them in the Edit as Blend tool using the Select tool 

guide .  

Click a blend plane to select it.  

3   Move, rotate, or edit the interior blend planes. 

To move or rotate the blend plane 

Click the Move tool guide  and drag the Move handle to move or rotate the blend plane. 

To move a vertex or edge 

Click the Edit tool guide , click a vertex or edge of the blend section, and drag it to edit the 
blend plane. 

To bend an edge 

Click the Bend tool guide , click an edge, then drag in or out to bend the edge. 

4   Add or remove interior blend planes. 

To add a blend plane 

Click the Add Blend Plane tool guide  and click the face to insert a new blend plane through the 
face at that location. The orientation of the new plane is determined by the orientation of its 
neighboring blend planes.  

To remove a blend section 

Click a blend plane, then click the Remove Blend Plane tool guide   to delete it. The faces are 
redrawn between the remaining blend planes. If you delete the wrong blend plane, you can always 
press Ctrl+Z to undo. 

Tool guides 

Within the Edit as blend tool, there are several tool guides that help step you through the editing process: 

If you did not pre-select the faces to edit, you can select them from within the Edit as Blend tool 
using the Select tool guide.  
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Select the Move Blend Plane tool guide to move and orient the selected blend plane using the 
Move handle.  

Make edits to any blend section with the Edit Blend Section tool guide. You can move, bend, and 
replace edges or move vertices. Just click to select the vertex or edge you want to edit. 

Select the Bend tool guide and select a linear or arced edge to bend it. 

Select the Add Blend Plane tool guide to add new blend sections by clicking on the face to insert a 
new blend section through the face. You can modify your new blend sections just like the others. 

Select the Remove Blend Plane tool guide to click any blend section to delete it. 

Examples 
 

 

 

 

 "Waisting" a cylinder        

Moving the sketch grid 

Use the Move Grid tool to move the sketch grid. Make successive sketches by moving the grid after 
sketching closed line regions. These closed lines turn into regions when you move the grid.  

To move the sketch grid 

1   Click the Move Grid tool  on the mini-toolbar or click the Move tool and check the Move Grid option. 

2   (Optional) Select any sketch entities that you want to move along with the sketch grid. 

3   Select a Move handle axis. 

4   Drag along the axis of the Move handle to move or rotate the sketch grid. 

Press Shift while dragging to snap the move to angular and linear increments based on your snap 
settings as well as to snap the move parallel to planes, edges, and axes. You can also right-click and 
select Use Ruler Dimension, and enter a value or press Enter to drag the grid. You can also use the 
standard Move tool guides when moving the grid. 

The Move handle can be moved around by dragging the center ball onto appropriate entities on the 
sketch grid. 
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Intersecting 
You can use the intersect tools to merge and split a solid or surface in your design with another solid or 
surface. You can merge and split solids or surfaces with other solids or surfaces, split a solid with a face, 
and split a face with another face. You can also project the edges of a face onto other solids and surfaces in 
your design. 

SpaceClaim's intersection capabilities include the full suite of geometry combination, all done with one major 
tool (Combine) and two minor ones (Split Solid and Split Face). Combine always takes two or more objects. 
The split tools always act on one object and that object is automatically selected from the cutter or 
projection face. 

To understand what the Combine tool can do, the first step is to know which objects can be handled. Solid 
objects have faces that meet at corner edges. Edges that lie on faces can be deleted, but corners cannot. 
Surface objects have faces that come together at internal edges, and are surrounded by outside edges. 
Outside edges can be extended. Internal edges can be deleted if they are bounded by planar faces. For the 
purposes of combine, planes can be thought of as surface faces that extend across the design. 

When surfaces enclose a volume, they automatically change into solid objects. When edges of the same 
surface become coincident, they will automatically merge. Planes cannot be split by any combine operation, 
but they can be used to split with. In general, layer, color, and visibility in the structure tree propagates 
from the first selected item (the target) to the result. What happens as a result of the combination can be 
overridden with the options (both in the panel and the mini-toolbar). When you use the Combine or Split 
tools, the newly created objects have the layer properties of the previous objects. 

You have complete control over the pieces that solids and surfaces get cut into. When appropriate, 
SpaceClaim prompts you to remove regions, but you can choose to keep or remove those regions. 

When using the intersect tools, the original, individual layers and colors of the objects are maintained. 

Intersect ribbon group 

 
The Intersect ribbon group contains the following tools: 

 Use the Combine tool to merge and split solids and surfaces. 

 
Use the Split Solid tool to split a solid by one or more of its faces or edges. Then select one or more 
regions for deletion. 

 Use the Split Face tool to create an edge on a face by splitting it with another face or surface. 

 
Use the Project to Solid tool to create edges on a solid's face by extending the edges of another solid 
or surface. 
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Combining and splitting 

Use the Combine tool to merge and split solids and surfaces. These actions are sometimes known as 
Boolean operations. 

The Combine tool works in two modes:  

 “Slow mode” is activated by clicking a Combine tool guide. In this mode, once a tool guide is 
clicked, it remains selected until another tool guide is clicked. This mode works just like any other 
tool. You can box-select multiple targets and cut them without automatically merging them. 

For example, if you click the Select Target tool guide, you can click an object to add it to the 
selection and click a selected object to remove it from the selection. You can also use box-select. 
(Nothing is merged.) 

If you click the Merge tool guide, the selected targets are merged. You can click more objects to 
merge them to the targets or use box-select. 

If you click the Cutter tool guide, every object you click becomes a cutter and cuts the target 
immediately. You can also use box-select to create cutters. 

To delete regions created by the cuts, you must click the Delete Regions tool guide then click the 
region you want to delete. 

 “Fast mode” automatically activates tool guides and moves you through the workflow. This 
predictive mode exhibits the same behavior as the Combine tool had in previous SpaceClaim 
releases, although you can now box-select multiple cutters to add even more efficiency. 

In both modes, if you select objects, then click the Combine tool, the objects are automatically 
merged. The procedures in this section describe Fast mode behavior. 

To merge solids and surfaces 

1   Select the Combine tool. 

2   Click the first solid or surface. 

3   Ctrl+click additional solids or surfaces to merge them. 
 

Do it 
faster 

Ctrl+click the solids or surfaces you want to combine in the Structure tree, then click the 
Combine tool to merge them. 

Detailed instructions

1   Select the Combine tool  from the Intersect ribbon group or press I. 

2   Click the first solid or surface. 

3   Ctrl+click additional solids or surfaces to merge them. 

The Structure tree shows the merge.  

Solids can be merged with solids, and surfaces with surfaces. Solids and surfaces can only be merged if the 
surfaces make a region that can be added to or cut out of the solid. For example, if you select the face of a 
cylinder, copy and paste it, then you can merge it with the solid used to create it.  

To split solids and surfaces 

1   Select the Combine tool. 

2   Select the target. 

3   Select the cutter. 

4   (Optional) Select the region of the target to delete. 
 

Do it If you want to split a body by a face of the body, select the Split Solid tool. 
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faster If you want to create an edge on a face, select the Split Face tool.  

Detailed instructions

1   Click the Combine tool  from the Intersect ribbon group or press I. 

2   Select the solid or surface you want to cut. 

The Select Cutter tool guide is activated. 

3   (Optional) Control the behavior of the cut by selecting options. 

4   Click the surface you want to use to cut the solid. 

Depending on the option you chose, the cutting surface will be kept or deleted. Review the information 
in the Structure panel to see the solids or surfaces created by the cut. 

Mouse over the target solid to see the regions created by the cut. 

5   Click each region you want to delete. 

When you are finished selecting the areas to be deleted, click the Select Target tool guide to combine 
some more, or select another tool. 

Tool guides 

Within the Combine tool, there are several tool guides that help step you through the splitting process. 
 

 

The Select Target tool guide is active by default. If you did not pre-select the target solid or 
surface, you can select it from within the Combine tool using the Select tool guide.  

Click the Select Bodies to Merge tool guide to select multiple solids or surfaces to merge together. 
 Tool guides that appear with a double outline are "sticky," and allow you to perform the same 
action repeatedly. For example, when this tool guide appears with a double outline, just keep 
clicking objects to merge each object with the previous one. To "unstick" the tool guide, you can 
click it again, click another tool guide, or click an empty place in the Design window 

 

The Select Cutter tool guide activates once you select a target. When this tool guide is active, click 
to select the solid or surface you want to use to cut the target. You can Ctrl+click when this tool 
guide is active if you need to add other solids to your cutter selection. 

 

The Select Regions tool guide activates once the target is cut. When this tool guide is active, 
mouse over the target to preview the regions created by the cut. Click a region to delete it.  

Options 

The following options are available for the Combine tool. Select these options from the Options docking 
panel, or right-click and select them from the mini-toolbar: 
 

Merge when 
done 

Select this option to merge all touching solids or surfaces when you exit the Combine 
tool. Hidden objects are not merged. 

Make curves 
Select this option to create edges at intersections instead of selecting regions. You will 
not be able to preview regions for deletion. As soon as a region is selected for deletion, 
this option is disabled. 

Keep cutter 

SpaceClaim assumes that you created a cutter object to be used only for cutting. If you 
want to keep the cutting surface in your design, select this option. If this option is not 
selected, then the cutting surface is automatically deleted as soon as you select it. In 
other words, cutter objects are normally "used up" unless you select this option. A kept 
cutter can be a surface or solid, but either way only the regions of the target can be 
removed.  

If you are splitting surfaces, check this option to prevent the cutter object from being split 
by the target object. 
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Make all 
regions 

Select this option to cut the target object with the cutter object and the cutter object with 
the target object. Target and cutter must be the same type of object, either both solids or 
both surfaces. Because this option can create a large number of regions, we recommend 
using this option along with the Merge When Done option to quickly merge all 
remaining regions when you click another tool or press Esc to finish using Combine. 
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Merging 

Use the Combine tool to merge solids and surfaces. 

To merge solids and surfaces 

1   Select the Combine tool  from the Intersect ribbon group or press I. 

2   Click the first solid or surface. 

3   Ctrl+click additional solids or surfaces to merge them. 

The Structure tree shows the merge.  
Do it 
faster 

Ctrl+click the solids or surfaces you want to combine in the Structure tree, then click the 
Combine tool to merge them. 

Solids can be merged with solids, and surfaces with surfaces. Solids and surfaces can only be merged if the 
surfaces make a region that can be added to or cut out of the solid. For example, if you select the face of a 
cylinder, copy and paste it, then you can merge it with the solid used to create it.  

Using the Combine tool, you can: 

 Merge two solids 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the first solid. 

3   Ctrl+click the second solid to merge it with the first solid. 
The second solid takes on the color and visibility properties of the first solid. The Structure tree 
shows the merge. 

 Merge many solids 

1   Select the solids you want to combine using box selection. 

2   Select the Combine tool  from the Intersect ribbon group. 
The solids take on the color and visibility properties of the merged solid that appeared top-
most in the Structure tree. The Structure tree shows the merge. 
You can also select the Combine tool, select the first solid, then Ctrl+click each individual solid 
you want to merge. 

 Add material to a solid with a surface that forms a protrusion 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the first solid. 

3   Ctrl+click a surface that could create a protrusion on the solid to merge it with the solid. 
The surface becomes a protrusion on the solid and takes on the color and visibility properties 
of the first solid. The Structure tree shows the merge. 

 Merge two surfaces that share edges 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the first surface. 

3   Ctrl+click the second surface to merge it with the first surface. 
The second surface takes on the color and visibility properties of the first surface. The 
Structure tree shows the merge. 

 Merge surfaces that intersect to form an enclosed region 
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1   Select the surfaces that intersect to form an enclosed region using box selection. 

2   Select the Combine tool  from the Intersect ribbon group. 
The enclosed region becomes a solid and takes on the color and visibility properties of the 
merged surface that appeared top-most in the Structure tree. The Structure tree shows the 
merge. 

Example 

 
Six surfaces enclosing a volume, box-selected and combined with the Combine tool 

 Merge a surface and a plane 

Ctrl+click a surface and a plane to cap the surface.  

 

Merging solids 

You can merge two or more solids with the Combine tool.  

To merge two solids 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the first solid. 

3   Ctrl+click the second solid to merge it with the first solid. 
The second solid takes on the color and visibility properties of the first solid. The Structure tree shows 
the merge. 

To merge multiple solids 

1   Select the solids you want to combine using box selection. 

2   Select the Combine tool  from the Intersect ribbon group. 
The solids take on the color and visibility properties of the merged solid that appeared top-most in the 
Structure tree. The Structure tree shows the merge. 
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You can also select the Combine tool, select the first solid, then Ctrl+click each individual solid you want 
to merge. 

Merging surface protrusions 

You can merge a surface that forms a protrusion to a solid.  

To merge a surface protrusion 

1   Select the Combine tool   from the Intersect ribbon group. 

2   Click the first solid. 

3   Ctrl+click a surface that could create a protrusion on the solid to merge it with the solid. 
The surface becomes a protrusion on the solid and takes on the color and visibility properties of the first 
solid. The Structure tree shows the merge. 

 

Merging surfaces 

You can merge surfaces with the Combine tool. Surface must share edges to be merged. If surfaces enclose 
a volume, you can use the Combine tool to quickly convert the enclosed volume into a solid and trim the 
extra.  

Sometimes, if you manipulate a surface so that it becomes self-intersecting, you may need to create a solid 
from the surface that remains.  

To merge surfaces that share edges 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the first surface. 

3   Ctrl+click the second surface to merge it with the first surface. 
The second surface takes on the color and visibility properties of the first surface. The Structure tree 
shows the merge. 

To merge surfaces that enclose a volume 

1   Select the surfaces that intersect to form an enclosed region using box selection. 

2   Select the Combine tool  from the Intersect ribbon group. 
The enclosed region becomes a solid and takes on the color and visibility properties of the merged 
surface that appeared top-most in the Structure tree. The Structure tree shows the merge. 

To create a solid from a self-intersecting single surface 

1   Click the Select tool in the Edit ribbon group. 

2   Select the "open" edge of the set of surfaces, shown in black. 

3   Click the Combine tool. 

To repair a self-intersecting surface 

1   Click the Select tool in the Edit ribbon group. 

2   Double-click the edge loops. 

3   Click the Combine tool. 
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Example 

 
Six surfaces enclosing a volume, box-selected and combined with the Combine tool 

 
Repairing a self-intersecting surface with the Combine tool 

Capping a surface with a plane 

Ctrl+click a surface and a plane to cap the surface.  

 

Splitting 

Use the Combine tool to split solids and surfaces.  

To split solids and surfaces 

1   Click the Combine tool  from the Intersect ribbon group or press I. 

2   Select the solid or surface you want to cut. 

The Select Cutter tool guide is activated. 

3   (Optional) Control the behavior of the cut by selecting options. 
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4   Click the surface you want to use to cut the solid. 

Depending on the option you chose, the cutting surface will be kept or deleted. Review the information 
in the Structure panel to see the solids or surfaces created by the cut. 

Mouse over the target solid to see the regions created by the cut. 

5   Click each region you want to delete. 

When you are finished selecting the areas to be deleted, click the Select Target tool guide to combine 
some more, or select another tool. 

Do it 
faster 

If you want to split a body by a face of the body, select the Split Solid tool. 
If you want to create an edge on a face, select the Split Face tool.  

Using the Combine tool, you can: 

 Split a solid with a surface or plane 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the solid you want to cut. 

3   Click the surface you want to cut the solid with. 

You can Ctrl+click multiple surfaces that together completely intersect a solid. 

4   Mouse over the solid to see the regions created by the cut. 

5   Click the region you want to delete. 

 Split a solid with a solid 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the solid you want to cut. 

3   Click the solid you want to cut with. 

4   Mouse over the solid to see the regions created by the cut. 

5   Click the region you want to delete. 

 Split a surface with a solid or plane 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the surface you want to cut. 

3   Click the solid or plane you want to cut the surface with. 

4   Mouse over the surface to see the regions created by the cut. 

5   Click the region you want to delete. 

 Split a surface with a surface 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the solid you want to cut. 

3   Click the surface you want to cut the solid with. 

You can Ctrl+click multiple surfaces that together completely intersect the target surface. 

4   Mouse over the solid to see the regions created by the cut. 

5   Click the region you want to delete. 

 Remove material from a solid with a surface that forms a depression 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the solid you want to cut. 
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3   Click the surface you want to use to create a depression. 

4   Mouse over the solid to see the regions created by the cut. 

5   Click the region you want to delete. 

 Remove an enclosed volume from a solid 

1   Create the exterior solid and interior solid in two different components. 

2   Select the Combine tool  from the Intersect ribbon group. 

3   Click the exterior solid. 

4   Click the interior solid to use it as the cutter. 

5   Click the interior solid to delete it. 

Splitting a solid 

Use the Combine tool to split solids. Solids can be split by surfaces, planes, and other solids.  

To split a solid with a surface or plane 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the solid you want to cut. 

3   Click the surface you want to cut the solid with. 

You can Ctrl+click multiple surfaces that together completely intersect a solid. 

4   Mouse over the solid to see the regions created by the cut. 

5   Click the region you want to delete. 

 

To split a solid with another solid 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the solid you want to cut. 

3   Click the solid you want to cut with. 

4   Mouse over the solid to see the regions created by the cut or click another solid to cut with. 

5   Click the region you want to delete. 

Splitting a surface 

Use the Combine tool to split solids. Surfaces can be split by solids, planes, and other surfaces.  

To split a surface by a solid or plane 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the surface you want to cut. 

3   Click the solid or plane you want to cut the surface with. 

4   Mouse over the surface to see the regions created by the cut. 

5   Click the region you want to delete. 
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To split a surface by another surface 

1   Select the Combine tool  from the Intersect ribbon group. 

2   Click the surface you want to cut. 

3   Click the surface you want to cut the surface with. 

You can Ctrl+click multiple surfaces that together completely intersect the target surface to fully cut the 
surface. You can box-select surfaces that only partially intersect the target surface to partially cut the 
surface.. 

4   Mouse over the surface to see the regions created by the cut. 

5   Click the region you want to delete. 

Removing material from a solid 

Use the Combine tool to remove material from a solid based on the intersection of a solid or surface. You 
can remove the material defined by a surface that forms a depression, or remove a solid completely 
enclosed within another solid.  

To remove material from a solid using a surface that forms a depression 

1   Select the Combine tool   from the Intersect ribbon group. 

2   Click the solid you want to cut. 

3   Click the surface you want to use to create a depression. 

4   Mouse over the solid to see the regions created by the cut. 

5   Click the region you want to delete. 

To remove an enclosed volume from a solid 

1   Create the exterior solid and interior solid in two different components. 

2   Select the Combine tool  from the Intersect ribbon group. 

3   Click the exterior solid. 

4   Click the interior solid to use it as the cutter. 

5   Click the interior solid to delete it. 

Splitting a solid 

Use the Split Solid tool to split a solid by one or more of its faces or edges. Then select one or more regions 
for deletion. The Split Solid tool expects that you have already selected the cutter objects. From these faces 
or edges, the single target body is inferred, since a face or edge can only belong to one solid or surface. If 
only one solid face is selected as a cutter, the default action is to extend that face to cut as far as it can 
through the solid. If a face of a surface is selected, then it is automatically removed.  

The Split Solid tool works in two modes:  

 “Slow mode” is activated by clicking a Split Solid tool guide. In this mode, once a tool guide is 
clicked, it remains selected until another tool guide is clicked. This mode works just like any other 
tool.  

 “Fast mode” automatically activates tool guides and moves you through the workflow. This 
predictive mode allows you to box-select multiple cutters to add even more efficiency. 

120 



SpaceClaim 2008 SP1 User’s Guide 

To split a solid by one of its faces 

1   Click the Split Solid tool   from the Intersect ribbon group. 

2   Click the faces or edges you want to use to cut the body. 

Mouse over the solid to see the regions created by the cut. 

2   (Optional) Click a region to delete it. 

When you are finished deleting regions, select another tool.  

If the selected edges do not completely encircle a portion of a solid or surface, no region selection can 
occur. 

 

Do it 
faster 

Select a face with the Select tool, then select the Split Solid tool to cut the solid with the 
face. 

You can use the Split Solid tool to: 

 Split a solid by its edges 

 Split a solid by its faces 

Tool guides 

Within the Split Solid tool, there are several tool guides that help step you through the splitting process: 
 

The Select Cutter tool guide is active by default. When this tool guide is active, click to select the 
face you want to use to cut the solid. 

 

The Select Regions tool guide activates once you once the solid is cut by the face. When this tool 
guide is active, mouse over the target to see the regions created by the cut. 

Options 

The following options are available in the Split Solid tool. Once you select the edge or face to pull, select 
these options from the Options docking panel, or right-click and select them from the mini-toolbar: 
 

Merge when 
done 

Select this option to merge all touching solids or surfaces when you exit the Split Solid 
tool. Hidden objects are not merged. 

Extend faces Extends the selected cutter face to cut through the target solid. 

Example 

 
Solid split by a spline face 

Splitting a face 

Use the Split Face tool to create an edge on a face or surface by splitting it with another face or edge. 
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To create an edge on a face 

1   Click the Split Face tool  from the Intersect ribbon group. 

2   (Optional) Select a tool guide. 

Mouse over faces or edges in your design to preview the edge that will be created on the target.  

3   Click to select the face or edge you want to use to split the selected face. 

Detailed instructions

Split a face with another face 

1   Click the Split Face tool  from the Intersect ribbon group. 

2   Click to select the face you want to split. 

You can Ctrl+click to select multiple faces.  

3   Click the Select Cutter Face tool guide. 

Mouse over faces in your design to preview the edge that will be created on the target.  

4   Click the face or surface to split the selected face with an edge. 

Split a face using a point on an edge 

1   Click the Split Face tool  from the Intersect ribbon group. 

2   Click to select the face you want to split. 

You can Ctrl+click to select multiple faces.  

3   Click the Select Cutter Point tool guide. 

Mouse over the edges of the face to preview the edges that will be created.  

4   Click a point on the edge to split the selected face. 

The percent distance along the edge is displayed. 

Split a face using two points on edges 

1   Click the Split Face tool  from the Intersect ribbon group. 

2   Click to select the face you want to split. 

You can Ctrl+click to select multiple faces.  

3   Click the Select Two Cutter Points tool guide. 

4   Click a point on an edge. 

Mouse over edges of the face to preview the edges that will be created.  

5   Click a point on another edge to split the selected face. 

Tool guides 

Within the Split Face tool, there are two tool guides that help step you through the splitting process: 

 

The Select Target tool guide is active by default. If you did not pre-select the target face or 
surface, you can select it from within the Split Face tool using the Select tool guide. Ctrl+click 
multiple surfaces or solid faces in the same plane to split them all. 

The Select Cutter Face tool guide activates once you select a target. When this tool guide is active, 
click to select the face or surface you want to use to create an edge on the target. 

122 



SpaceClaim 2008 SP1 User’s Guide 

The Select Cutter Point tool guide activates once you select a target. Mouse over an edge to 
preview the new edges that will be created. Click to create the edge on the selected face. You can 
mouse over an edge with this tool guide to display and edit the length along the edge, and the 
percentage of the edge that is between the first point and the end point. 

The Select Two Cutter Points tool guide activates once you select a target. Click to select the first 
point on an edge, then mouse over another edge to preview the new edge that will be created. 
Click to create the edge on the selected face. You can mouse over an edge with this tool guide to 
display and edit the length along the edge, and the percentage of the edge that is between the 
first point and the end point. 

Examples 

 
Previewing edges that can be created using the Select Cutter Point and Select Two Cutter Points tool guides 

 
Splitting a face in section mode by selecting points on a section line 

Projecting to a solid 

Use the Project to Solid tool to create edges on a solid's face by extending the edges of another solid, 
surface, sketch, or note text. 

To project the edges of a face, surface, sketch, or note text to a solid 

1   Select the Project to Solid tool   from the Intersect ribbon group. 

2   Click the face, surface, sketch or note text whose edges you want to project. 

The projection occurs perpendicular to the selected object onto the nearest solid faces. The nearest 
solid faces are determined automatically. 

3   (Optional) Alt+click a face or edge to set another direction for the projection. 

To project edges to selected faces of a solid 

1   Select the Project to Solid tool   from the Intersect ribbon group. 

2   Click the face, surface, or note text whose edges you want to project perpendicular to the face. 
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The nearest solid faces are determined automatically. 

3  Select the Use Selected Faces option in the Options panel. 

The purple edges disappear. 

4  Select the faces you want to project onto individually. 

Options 

The following options are available for the Project to Solid tool. Select these options from the Options 
docking panel, or right-click and select them from the mini-toolbar: 
 

Use Selected 
Faces Select this option to project only onto the faces you choose. 

Project Through 
Solids 

Select this option to project edges on all faces through the entire solid instead of just 
the faces closest to the "projector" face. 

Extend 
Projected Edges 

When a projected edge does not completely span across a face, this option extends the 
lines until another edge is reached. 
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Inserting 
The Insert tools allow you to insert components, images, planes, axes, origins, cylinders, and spheres, and 
create relationships between the solids and surfaces in your design.  

Insert ribbon group 

 
The Insert ribbon group contains the following tools: 

 Use the Insert tool to insert a component or an image into your design. 

 Use the Plane tool to insert a plane into your design. 

 Use the Axis tool to insert an axis into your design. 

 Use the Origin tool to insert an axis into your design at the location of the Move handle. 

 Use the Cylinder tool to quickly create a cylinder. 

 Use the Sphere tool to quickly create a sphere. 

 Use the Shell tool to convert a solid to a shell. 

 Use the Offset tool create an offset relationship between faces in your design. 

 Use the Mirror tool to designate a face or plane as a mirror. 

Inserting a component 

You can insert another design created in SpaceClaim or another application as a component of your design. 
The design is inserted as an external component, linked to the external file. You can make this component 
internal to your own design. Lightweight components are displayed with solid edges and transparent faces 
until you right-click the component and select Load component from the context menu. 

To insert another design as a component 

1   Click the Insert tool  in the Insert ribbon group. 

2   Navigate to and select the design you want to include as a component, then click Open on the Open 
Design window. 

Progress is displayed on the status bar until the design is inserted as an external component. You can 
insert multiple copies of the same component. Modifying one of these components will modify every 
copy unless you make them internal to your design. 

Make an external component internal to your design 

1   Right-click the external component in the Structure tree. 

2   Select Use Internal Copy from the context menu. 
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If your design includes multiple copies of an external component, making one of them internal does not 
affect the other copies.  Making another copy of the same external component internal creates a second 
instance of the same internal component. 

Inserting an image 

You can insert an image into your design or onto a drawing sheet. Inserted images and their transparency 
colors, aspect ratio, and placement information are saved with the design.  

To insert an image 

1   Select Image from the Insert drop-down in the Insert ribbon group. 

2   Select the BMP, JPG, PNG, or TIF image file you want to insert and click Open. 

3   Click on the face that defines the plane on which you want to insert the image. 

An ImagePlane appears in the Structure tree and the image is placed on the plane. 

To resize an image 

Select the image and drag the control handles.  

You can right-click the image and select Properties to set whether you can adjust the aspect ratio in the 
Keep aspect ratio property in the Properties panel. 

To rotate an image 

Drag the handle at the top of the image to rotate the image.  

You can also drag the handle not connected to the image edge to change the center of rotation. 

To flip an image 

Drag handle across the other side of the image to flip the image.  

To copy an image 

1   Select the image. 

2   Press Ctrl and drag the image to create a copy of the image. 

To set the transparency of the image 

Change the value in the Transparency property. 

To set a color in the image to be transparent 

1   Click the Transparent Color Table property drop-down to display the color selection window. 

Mouse over the pixels in the image to display their RGB values. 

2   Click  and click a pixel in the image that is the color you want to become transparent.  

You can use the Zoom slider to zoom into the image and drag to pan the image within the window. 

The color you selected appears in the drop-down next to the eyedropper icon. You can add multiple 
transparent colors by repeating this process, and remove the selected color (or all colors) using the 
eraser icons. The image window previews the image with the transparency you selected. 
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Inserting a plane 

You can define a plane by selecting various faces, edges, axes, or lines in your design. The plane will extend 
a small amount beyond the edges of the face to make it easier to work with. The plane will maintain this 
margin around all the objects in your design, extending and trimming itself as you add, remove, or move 
solids within your design.  

Planes are useful for creating layouts and annotations. Planes are not linked to the geometry used to create 
them; they must be explicitly selected to move along with other items. You can also use a plane to quickly 
clip your design to show only the geometry behind the plane. 

To insert a plane 

1   Select one of the following: 
Select a: To insert a plane: 
Planar face That contains the face 
Planar face and point Through the point and parallel to the face 
Planar face and edge Through the edge and perpendicular to the face (useful when creating a 

sweep path) 
Two parallel planar faces At the midpoint between the two faces 
Axial or cylindrical face Tangent to the face at the selection point 
Two axial faces with 
parallel axes 

Tangent to both faces as close as possible to the selection points 

Planar edges That contains the edges 
Axis That contains the axis 
Two parallel axes That contains the axes 
Two origin axes That contains the axes 
Axis (or line) and one 
point 

That contains the axis (or line) and the point 

Endpoint of any line Through the endpoint and normal to the line at the endpoint 
Three points  That contains those three points 
Line sketched on a plane Through the line and normal to the plane 
Line and point on the 
line 

Through the line and the point 

Two planar lines That contains those two lines 

You can also select temporary objects to define planes. 

2   Select the Plane tool  from the Insert ribbon group to insert the plane. 

(You can also select the Plane tool first, then select an object.) An error message appears in the status 
bar if your selection does not define a plane. 

To insert a plane tangent to a cylinder and parallel to a plane 

Select a plane, Ctrl+click a cylinder, then click the Plane tool.  

To insert a plane tangent to a cylinder and perpendicular to a plane 

Select a cylinder, Ctrl+click a plane, then click the Plane tool.  

To insert a plane through the mid-point between two points 

1   Select the Plane tool. 

2   In 3D mode or Section mode, Alt+Shift+click two points to create a temporary plane that includes the 
midpoint. 

3   Click the temporary plane. 
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To clip your design with a plane 

Right-click a plane and select Clip with Plane. To restore the view of your design, right-click the plane and 
select Clip with Plane again.  

Planes, axes, and annotations are not clipped. 

Example 

 
Planes inserted parallel and perpendicular to the selected plane, and tangent to the selected cylinder 

Inserting an axis 

You can extend any axis in your design to make it available for revolves or rotations. The axis will extend a 
small amount beyond the edge of the space containing your design. It will maintain this margin extending 
and trimming it as you add, remove, or move objects in your design. Axes are not linked to the geometry 
used to create them (unless they are an extension of existing axes); they must be explicitly selected to 
move along with other items.  

To insert an axis 

1   Select one of the following: 
Select a: To insert an axis: 
Axial face That contains the face's axis 
Two, non-parallel planar 
faces 

At the intersection of the theoretical planes containing the two faces 

Linear edge That contains the edge 
Cylinder and tangent 
plane 

At the intersection of the cylinder and plane 

Line That contains the line 
Origin axis Along the origin's axis 
Circle or arc That contains the center point and is normal to the line 
Two points Through both points 

You can also select temporary objects to define planes. 

2   Select the Axis tool  from the Insert ribbon group to insert the axis. 

To insert an axis through the mid-point between two points 

1   Select the Select tool. 

2   Alt+Shift+click two points to create two temporary axes that cross at the midpoint. 

3   Click the temporary axis. 

4   Select the Axis tool to create the axis. 
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Inserting an origin 

You can insert an origin at any location in your design where you can anchor the Move tool. You can anchor 
a ruler to an origin, and snap to origins while in Sketch mode. This allows you to dimension from an origin 
and quickly move the sketch grid to an origin. You can also insert an origin at a solid's center of mass or 
volume. 

To insert an origin 

1   Select the Move tool. 

2   Position the Move handle where you want the origin to appear. 

3   Select the Origin tool  to insert an origin. 

The origin appears in the Design window and in the Structure tree. 

To insert an origin at the center of mass or volume 

1   Select the Mass tool  from the Analysis ribbon group. 

2   Select the solid at whose center you want to place the origin. 

Axes appear at the center of mass or volume. 

3   Select the Origin tool . 

The origin appears at the center of mass or volume. 

To insert an origin at the mid-point between two points 

1   Select the Move tool. 

2   Alt+Shift+click two points to create a temporary point at the mid-point. 

3   Click the temporary point to place the Move handle there. 

4   Select the Origin tool . 

The origin appears at the midpoint. 

Creating a cylinder 

Use the Cylinder tool  to sketch the cylinder's axis in 2D and create its diameter in 3D. 

The sketch grid must be visible in the workspace before you can draw. 

To draw a cylinder 

1   Click to set the first endpoint of the cylinder's axis. 

2   Click to set the other endpoint. 

3   Click to set the diameter of the cylinder. 
Do it faster Click and drag to draw the axis, then click to set the diameter. 

Detailed instructions

1   Select the Cylinder tool   from the Insert ribbon group. 

2   (Optional) If you want to dimension the first endpoint of the axis, press Shift and hover the mouse over 
a line or point to create a dimension relative to that line or point. 

3   Click or press Enter to set the first endpoint of the axis. 

4   (Optional) Dimension the axis. 
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5   Click or press Enter to set the other endpoint of the axis. 

By default, the axis is dimensioned to its first endpoint. You can also press Shift and hover the mouse 
over another line or point to create a dimension relative to that line or point. 

6   (Optional) Dimension the cylinder's diameter. 

7   (Optional) Select options from the Options panel, or right-click and select them from the mini-toolbar.  

8   Click or press Enter to set the diameter of the cylinder. 

Options 

The following options are available in the Cylinder tool.  
 

Add Add material to create a solid cylinder. 

Cut Remove material when the cylinder intersects another object.  

Example 

 
Tube with nubs 

Creating a sphere 

You can quickly create a sphere using the Sphere tool. 

To create a sphere 

1   Select the Sphere tool  from the Insert ribbon group. 

2   Click to set the center of the sphere and the plane in which the sphere's radius is dimensioned. 

As you move the mouse, you can see a preview of the sphere. Sphere creation works best when you 
move the cursor in the x-y direction of the plane indicated by the first click. 

3   Click to set the radius of the sphere. 

To move a sphere 

Drag the sphere's center with the Select tool in Section mode to move the sphere. The section must cut 
through the center of the sphere to move it. 
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Converting a solid to a shell 

Use the Shell tool to remove one of the faces of the solid and create a shell of a specified thickness. You can 
then use the Shell tool to remove other sides of the shell. SpaceClaim automatically creates an offset 
relationship between the sides of the solid for you. 

To create a shell 

1   Select the Shell tool  from the Insert ribbon group. 

Mouse over the solids in your design to highlight the faces that could be removed. 

2   (Optional) Enter a value into the dimension field to change the thickness of the shell. 

Enter a negative number to create the shell thickness from the outside of the solid. 

3   Click the face you want to remove. 

The face is removed and a shell is created. The baseline of the offset is shown in blue. If you did not 
change the thickness, the default thickness is set by the minor grid spacing. 

Continue clicking to remove multiple faces. 

To create a closed shell 

1   Select the solid. 

2   Click the Shell tool  to create an internal shell. 

To edit a shell 

Right-click the shell to change its thickness. 

Tool guides 

 

This tool guide is active by default. Select a 
face of the solid to remove it and create a 
shell. Ctrl+click to remove multiple faces.  

 

If you create a shell, then add a protrusion 
onto it, you can extend the shell through the 
protrusion by clicking the More Shell tool 
guide, then clicking the newly added 
protrusion. 

Example 

 
Open shell and closed shell 

Creating an offset relationship 

Use the Offset tool to create an offset relationship between two faces. This relationship will be maintained in 
the other 2D and 3D editing tools. For example, when you select an offset face with the Pull tool, the offset 
dimension is displayed. Baseline faces do not display a dimension. 
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To create an offset relationship 

1   Click the Offset tool  in the Insert ribbon group. 

Mouse over your design to see the faces eligible for offset relationships. 

2   (Optional) Select options. 

Select the Find All Same Offset option if you want to select all contiguous face pairs that have the 
same offset distance as the pair you selected. If this option is not selected, the offset relationship is 
only created for the selected pair of faces. 

2   Click the first face.  

3   Click the second face.  

You have now established an offset relationship between the face pair and other contiguous face pairs 
with the same offset distance (if the All the Same option is selected). The Toggle Baseline tool guide 
activates.  

4   (Optional) Click to select the baseline face(s). 

When you move one of the faces with a design tool, the other face in the offset pair moves to maintain 
the offset relationship. 

Tool guides 

Within the Offset tool, there are several tool guides that help step you through the editing process: 

The Face Pair tool guide is active by default. 

 

When the Toggle Baseline tool guide is active, click the faces that you want to be the baseline of 
the offset. 

Mirroring objects 

Use the Mirror tool to designate a face or plane as a mirror, or create a mirror plane between two faces. 
The plane becomes a persistent mirror once you create geometry using the mirror. You can quickly mirror 
solids, or you can use the Mirror Face tool guide to mirror faces. The mirror relationship is maintained when 
you use other 2D and 3D tools to edit your design. 

Mirrored objects are created on the same layer as the original object. Mirrored points do not maintain their 
mirror relationship. 

To mirror in Sketch mode 

1   Draw a line or construction line. 

2   Right-click the line and select Set as Mirror Line. 

3   Sketch on one side of the line to mirror the sketch on the other side. 

To mirror objects 

1   Select the plane you want to be a mirror. 

2   Click the object you want to mirror. 

Detailed instructions

1   (Optional) Create the plane you want to use as a mirror using the Insert Plane tool and position it with 
the Move tool. 

2   Click the Mirror tool  in the Insert ribbon group. 
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Mouse over the solids in your design to preview the geometry that can be created by the mirror. 

3   Click the object you want to mirror. 

You can click solids or surfaces in your design or click a component in the Structure tree. 

 

You can use the Mirror tool to: 

 Mirror a body or face 

1   Click the Mirror Body  or Mirror Face tool guide . 

Mouse over the solids or faces in your design to preview the solid or face that will be 
created on the other side of the mirror plane. 

2   Click the solid or face to create the mirrored solid or face. 

The mirror plane is created and will persist in other tools. 

If you mirror faces that enclose a volume, a solid is created. 

 Set up a mirror relationship between two faces 

1   Click the Setup Mirror  tool guide. 

As you mouse over the faces in your design, the eligible faces are highlighted. A face is 
eligible if it is parallel to another face in your design. 

2   Click a face. 

3   Click a parallel face. 

The second face is highlighted in blue and the mirror plane appears halfway between the 
two faces. Certain actions performed on one face will now be mirrored on the other face. 

 Remove a mirror face or plane 

1   Click the Remove Mirror  tool guide. 

2   Click the face from which you want to remove the mirror relationship. 

You can temporarily disable a plane in any tool. Select a mirrored face to display the mirror 
plane, then click the mirror icon to disable the mirror. Click the mirror icon again to enable 
the mirror.  

 Find similar faces on the other side of a mirror plane 

1   Click the Setup Mirror  tool guide. 

2   Click a face. 

Ctrl+click to select multiple faces. 

3   Alt+click a mirror plane. 

Identical faces equidistant from the mirror plane are highlighted in blue, and a mirror 
relationship is created. 

Tool guides 

Within the Mirror tool, there are several tool guides that help step you through the mirroring process: 

The Mirror Plane tool guide is active by default. Select a face or plane to use it as a mirror. (You 
can also use this tool guide to select another mirror plane to use if one is already selected. 

The Mirror Body tool guide activates automatically once you select a mirror face or plane. Mouse 
over the solids in your design to preview the solid that will be created by the mirror. Click a solid to 
mirror it. 
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Once you select a mirror face or plane, use the Mirror Face tool guide to select the faces you want 
to mirror. Mousing over the faces before you click them previews the face that will be created by 
the mirror. Click a face to mirror it. 

The Setup Mirror tool guide can be used any time to create a mirror plane between two faces. 
Only those two faces will be affected by the mirror. If you click a face then Alt+click a mirror 
plane, you can use this tool guide to create a mirror relationship between identical faces 
equidistant from the plane.  

Use the Remove Mirror tool to remove the mirror relationship between two faces.  

Mirroring a solid, surface, or face 

You can mirror a solid, surface, or face.  

To mirror a solid or surface 

1   Click the Mirror Body  or Mirror Face tool guide . 

Mouse over the solids or faces in your design to preview the solid, surface, or face that will be created 
on the other side of the selected mirror plane. 

2   Click the solid or face to create the mirrored solid or face. 

The mirror plane is created and will persist in other tools. 

If you mirror faces that enclose a volume, a solid is created. 

Set up a mirror relationship between two faces 

You can create a mirror plane between two parallel faces in your design.  

To set up a mirror relationship 

1   Click the Setup Mirror  tool guide. 

As you mouse over the faces in your design, the eligible faces are highlighted. A face is eligible if it is 
parallel to another face in your design. 

2   Click a face. 

3   Click a parallel face. 

The second face is highlighted in blue and the mirror plane appears halfway between the two faces. 
Certain actions performed on one face will now be mirrored on the other face. 

Remove a mirror face or plane 

You can remove or disable a mirror.  

To remove a mirror face or plane 

1   Click the Remove Mirror  tool guide. 

2   Click the face from which you want to remove the mirror relationship. 

You can temporarily disable a plane in any tool. Select a mirrored face to display the mirror plane, then 
click the mirror icon to disable the mirror. Click the mirror icon again to enable the mirror.  
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Find similar faces on the other side of a mirror 

You can create mirror relationships by finding similar faces on the other side of an existing mirror.  

To find similar faces on the other side of a mirror 

1   Click the Setup Mirror  tool guide. 

2   Click a face. 

Ctrl+click to select multiple faces. 

3   Alt+click a mirror plane. 

Identical faces equidistant from the mirror plane are highlighted in blue, and a mirror relationship is 
created. 

Inserting temporary objects 

You can create temporary points, axes, and planes while working with other tools. Temporary objects can 
be used to dimension to and create other objects. For example, you can use them to create a ruler 
dimension, or anchor the Move handle on them. These temporary object disappear when you switch tools. 

 
To create a temporary: Alt+Shift+click: 

Midpoint between two points and a 
bisecting line 

Two points 

Bisector lines and intersection point Two non-parallel lines 

Line midway between two lines Two parallel lines 

Circle that completes an arc An arc 

Plane midway between two planes Two parallel planes 

Bisecting planes and edge of intersection Two non-parallel planes 

Focus point Cone 

Major and minor foci Ellipse 

Examples 

 
Midpoint between two points and a bisecting line 

 
Line midway between two parallel lines 
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Bisector lines and intersection point 

 
Circle that completes an arc 
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Assembling components 
In SpaceClaim, a component consists of any number of objects, such as solids and surfaces. You can think 
of a component as a "part." A component can also contain any number of sub-components. You can think of 
a hierarchy of components and sub-components as an "assembly." The assembly tools work on components 
within the assembly; to enable the tools you must select two objects in different components. When 
working with components, you may want to specify how they are aligned with each other, that is, create a 
mating condition. Mating conditions that you create with the Assembly tools are shown in the Structure tree. 

You can create multiple mating conditions for your components. If your components are not fitting together 
the way you expect, try clicking the checkbox next to the mating condition in the Structure tree to turn off 
the mating condition. A mating condition that cannot be satisfied is indicated with a different icon in the 
Structure tree. You can toggle the conditions on and off or delete them in the Structure tree. When creating 
mating conditions, the component clicked first will contain the mating conditions. 

Assembly ribbon group 

 
The Assembly ribbon group contains the following tools: 

 Align the selected faces of objects in two different components with the 
Align tool.  

 
Align the selected axes of objects in two different components with the 
Center tool. 

 
Rotate components around their alignment axis so that the selected 
faces point in the same direction with the Orient tool. 

To toggle a mating condition 

Uncheck the mating condition checkbox in the Structure tree to disable the mating condition. Check the box 
to enable the mating condition. 

To delete a mating condition 

Right-click the mating condition in the Structure tree and select Delete Mating Condition. 

To reverse the sense of the mating condition 

Right-click an Align or Orient mating condition in the Structure tree and select Reverse Sense to align the 
components to the opposite side of the alignment plane. 

137 



SpaceClaim 2008 SP1 User’s Guide 

Working with components 

The Structure tree contains the Structure 
tree, which shows you each of the 
objects in your design. You can quickly 
show or hide any component using the 
checkbox next to the object's name. You 
can expand or collapse the nodes of the 
tree, rename objects, create, modify, 
replace, and delete objects, create 
components, copy components, make 
components independent, open a 
component in a new design window, set 
the component to be a sheet metal 
component, make a component active, 
make a component independent, delete, 
rename, or display properties. 

Offset, mirror, and shell relationships 
stay with a solid when it is moved to 
another component, unless the 
relationship would link two components 
when it is moved. 

The top-level design (called 
StructureTree in the image on the 

ce 

ther 
cept the one you made independent. 

right) is also a component. 

If you are working with a single instan
of an external component, make that instance independent to prevent your changes from being made to 
the external component file. Once you make a copied sub-component independent, you can modify it 
without changing any of the other instances of that sub-component. Or you can modify one of the o
instances to change all the copied sub-components ex

If your design includes multiple copies of an external component, making one of them internal does not 
affect the other copies. Making another copy of the same external component internal creates a second 
instance of the same internal component. 
 

Do it 
faster 

Shift+click and Ctrl+click multiple objects to work with them as a group.  

About lightweight components 

When you insert an external file into your design, if you have the Enable lightweight assemblies advanced 
SpaceClaim option enabled, only the component's graphic information is loaded. This allows you to quickly 
view the component with the Orient tools and load the geometry information when you are ready to work 
with it in SpaceClaim.  

To create a component 

Right-click top-level design (or another component) in the Structure tree and select New Component from 
the context menu to create a new component or sub-component. 

To copy a component 

1   Select a component and click the Copy tool or press Ctrl+C. 

2   Select the component under which you want to create a copy and click the Paste tool or press Ctrl+V. 
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An instance of the component is created, which is linked to the original component. All changes made to 
the copied component are also made to the original unless you make the copy independent.   

To insert a component or assembly 

1   Select the Insert File tool   in the Insert ribbon group. 

2   Navigate to the component and double-click to insert it. 

The component is placed in the center of the workspace and its sub-components (if it is an assembly) 
appear in the Structure panel.  

To activate a component 

Right-click the component and select Activate Component from the context menu. 

If the component is lightweight, it is also loaded. Any new objects are created within this component. A 
component must be active before you can cut or copy it for pasting. 

To externalize a component 

1   Right-click the component and select Open Component from the context menu. 

The selected component appears in a new Design window. 

2   Select Save As from the Application menu to save the component as a separate file. (DO NOT check the 
Save as copy box.) 

The icon in the Structure tree of the original design changes to reflect that the component is now 
external.  

To copy an external component into your design 

Right-click the component and select Use Internal Copy from the context menu. 

The selected component is copied into your design. Any changes you make to the component do not affect 
the original, external file. 

To load a lightweight component 

Right-click the component and select Load Component from the context menu. 

The component and all its subcomponents' geometry information is loaded, and you can work on the 
components with any SpaceClaim tool. 

To make a component independent 

Right-click the inserted, dependent component in the Structure tree and select Make Independent from 
the context menu. 

The icon in the Structure tree changes, and the component is renamed <OriginalComponentName>2. 

If your design consists of multiple instances of the same external component, and that external component 
also contains multiple instances of another external subcomponent, making the subcomponent independent 
makes both the subcomponent and its parent component independent. Any parent component in the tree, 
all the way up to the top-level design component, will also be made independent.  

To create or specify a material for a component 

1   Select a component in the Structure tree. 

2   Select the Properties panel. 

3   Enter the name of the material in the Material Name property. 

4   Press Enter. 
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5   Enter the density of the material in the Density property. 

If you specified the density for the material elsewhere in the design, or specified it in the same 
SpaceClaim session, SpaceClaim displays that value in the Density property for you. 

Aligning components 

Use the Align tool to align the planar faces of different components. 

To align the planar faces of two components 

1   Click the face of the component you want to move. 

2   Ctrl+click the face of the component you want to remain in the same location. 

3   Click the Align tool  in the Assembly ribbon group. 

The two faces are aligned along the same plane, and an Align Planes mating condition appears under 
the moved component in the Structure tree. If you want to align to the other side of the plane, right-
click the Align Planes mating condition in the Structure tree and select Reverse Sense. 

Centering components 

Use the Center tool to align the axes of two components. 

To align the axes of two components 

1   Click the axis of the component you want to move. 

Mouse over an axial face to display that face's axis. 

2   Ctrl+click the axis of the component you want to remain in the same location. 

You can also select the faces defined by the axes. 

3   Click the Center tool  in the Assembly ribbon group. 

The two axes of the components are aligned and a Center Axes mating condition is created in the 
Structure tree under the moved component.  

Orienting components 

Use the Orient tool to rotate components around their alignment axis so that the selected faces point in the 
same direction. 

To orient two components 

1   Align the axes of the two components. 

2   Click the face of the component you want to move. 

3   Ctrl+click the face of the component you want to stay in the same location. 

4   Click the Orient tool  in the Assembly ribbon group. 

The second component rotates around the alignment axis until the two selected faces are oriented in 
the same direction, and an Orient Directions mating condition appears under the moved component.  
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Example 

 
Components before and after orienting 
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Measuring and analyzing 
Select a tool from the Analysis ribbon group to display measurements for the edges, faces, and solids in 
your design, or to display a u-v grid . 

Analysis ribbon group 

 
The Analysis ribbon group contains the following tools: 

 Use the Mass Properties tool to display volume information for the objects in your design.  

 
Use the Measure tool to display measurements of the edges and faces in your design.  Select from this 
tool's menu to display edges and volumes of intersection. 

 Use the Face Grid tool to display a grid on any face or surface in your design. 

Displaying mass 

Use the Mass tool to display volume 
information for the solids and surfaces in 
your design.  

If you use the tool on a surface, it will 
display the total surface area. If there are 
multiple surfaces on the same plane, the 
tool displays the total surface area for all 
the surfaces.  To display the surfaces’ 
individual surface areas, use the Measure 
tool.  

To view mass properties of a solid 

1   Select the Mass Properties tool   from the Analysis ribbon group. 

Click a solid in the Structure tree or by triple-clickin2   g it in the Design window to display its volume, 

e the principle moments and axes for another point, Ctrl+click an origin to add it to 

late the actual moment of inertia, multiply the moment measurement by the density of the 

number is the red axis of the origin, the second is the green axis, and the third is the blue axis.  

center of mass, and principle moments and axes. 

A small origin appears at the center of volume with its axes oriented in the direction of the principle 
axes. To calculat
your selection.  

To calcu
solid.  

The axis is indicated with x, y, z values; in the figure above, these values are (0, -1, 0). The first 
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Displaying measurements 

Use the Measure tool to display measurements of the edges and faces in your design. You can select 
different units for measurement by setting the SpaceClaim Units options. 

To view a measurement 

1   Select the Measure tool  from the Analysis ribbon group or press E. 

Mouse over your design to preview the faces and edges eligible for measurement. 

2   Click an edge or face to display measurement information. 

Select two points, edges, or faces to display the distance and angle between them.  

You can select one or two objects to be measured with the Measure tool. If you try to add a third object 
to the selection, the object you selected first is deselected. 

Displaying edges of intersection 

Use the Quick Interference tool  to display the edges where solids intersect each other.  

To display the edges of intersection 

1   Select the Quick Interference tool  from the Measure tool menu in the Analysis Ribbon group. 

2   Click intersecting solids to see their edges of intersection. 

Displaying intersection volumes 

Use the Volume Interference tool  to display volumes created by the intersection of solids in your design. 

To display volumes of intersection 

1   Select the Volume Interference tool  from the Measure tool menu in the Analysis Ribbon group. 

2   Ctrl+click solids to display the volumes created by their intersection in red. 

Displaying a face or surface grid 

Use the Face Grid tool to display the curves that define any face or surface in your design. You may find it 
useful to display a face grid when working with the Edit as Blend tool. 

To view a face or surface grid 

1   Select the Face Grid tool  from the Analysis ribbon group. 

2   Click a face or surface. 

Ctrl+click to display the grid on multiple faces and surfaces. Click a face again to hide the grid. 
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Examples 

 
Face grids displayed on a blended face and on a sphere 
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Detailing 
You can detail your designs to communicate with others or to submit your designs for review with the tools 
on SpaceClaim's Detailing tab. With the detailing tools, you can annotate your designs, create drawing 
sheets, and review changes to designs. You can customize detailing options to conform to standards or 
create your own custom style. 

Detailing tools are grouped into the following ribbon groups: 
 

Orient Quickly display a particular view of your design. 

Font Format note text by adjusting the font characteristics. 

Annotation 
Create notes on your design with text, dimensions, geometric tolerances, 
tables, surface finish symbols, and datum symbols, center marks, center 
lines, and threads. 

Views Add views to a drawing sheet. 

Sheet 
Setup Format a drawing sheet. 

3D Markup Create markup slides to illustrate the changes made to a design. 

Press Esc, then S to end any detailing action and return to the Select tool. 

Annotations 
You can annotate your designs, drawings, and 3D markups with notes, dimensions, geometric tolerances, 
surface finish and datum symbols, as well as center marks, center lines, and threads. When you create 
annotations that are attached to the objects in your design, they stay attached, even when you modify 
those objects using the Design tools. Annotations created on a drawing sheet or 3D markup slide are part of 
that sheet or markup only; they do not appear on your design. 

Each annotation has properties which you can modify in the Properties panel. When you create the first 
annotation, it is scaled so that it will be visible when your design is zoomed to its extents in the Design 
window. All other annotations use the same scale. 

Annotation ribbon group 

 
The Annotation ribbon group contains the following tools: 

 Use the Dimension tool to create a measured dimension. 

 Use the Create Note tool to select an annotation plane and enter text onto the plane. 

 Use the Note Leader tool to connect a note to an object. 

 
Use the Center Line tool to add a center mark on any circle, arc, cylinder end, or sphere, and put 
center lines on any cylindrical face. 
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 Use the Surface Finish tool to create a surface finish symbol. 

 Use the Geometric Tolerance tool to create a geometric tolerance. 

 Use the Thread tool to create a threaded surface on any cylinder, cone, or hole. 

 Use the Datum Symbol tool to insert a datum symbol. 

 Use the Table tool to insert a table note. 

 Click to display SpaceClaim's detailing options. 

Press Esc, then S to end any detailing action and return to the Select tool. 

Creating notes 

Use the Create Note tool to annotate your designs, drawing sheets, and 3D markups. You can use this tool 
to create and edit notes. You can also project the note onto a sketch or onto a solid. Place the annotation 
plane on one layer and the note on another layer, then turn off layer visibility for the annotation plane to 
hide it. 

To create a note 

1   Select the Create Note tool   from the Annotation ribbon group in the Detailing tab. 

Mouse over the faces of your design to preview the eligible annotation planes. (In Sketch and Section 
mode, the sketch grid defines the annotation plane.) 

2   Click a face to create the plane on which to place the note. 

To create an annotation plane for a cylindrical face, select the cylinder's axis. 

If you need to change the annotation plane, right-click and click Select New Annotation Plane from 
the context menu. Then right-click the new place and click Set As Annotation Plane. 

3   Click to place the note on the plane. 

4   Enter the text of the note. 

Click  in the mini-toolbar to insert a symbol into your note at the cursor location. 

Click   in the mini-toolbar to insert a dynamic field. Dynamic fields include current values from a 
variety of properties.  

You can format the note text, and enter the text by cutting, copying, and pasting the text from other 
notes or dimension annotations. 

5   Adjust the orientation of the note by dragging the rotation handles. 

To create a note field 

1   Click within the text of the note and place the cursor where you want the field to appear. 

2   Right-click to display the mini-toolbar. 

3   Click  in the mini-toolbar to display the Insert Field window. 

The Fields tab displays the properties available for insertion. (Document properties are those that 
appear in the Properties panel when you click the top-level design in the Structure tree.) 

4   Select a value from the Category drop-down to filter the properties displayed in the Fields list. 

If you click Selected Object, you can click any object in the Design window or Structure tree to make 
its properties available. 

If you select Formula, you can enter an expression, and include any numeric fields within the 
expression. 

The following expression elements are available: 
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 Infix (dyadic) operators:  + - * / ^ 

 Prefix (monadic) operators:  + - 

 Functions:  sin cos tan asin acos atan sqrt log log10 exp 

 Constants:  pi e root2 root3 

 Units:  m cm mm yd ft in ' " deg rad 

Normal precedence rules apply: 

1 + 2 * 3 ^ 4 = 1 + (2 * (3 ^ 4)) = 163 

Parentheses are required for expression arguments and optional for simple arguments: 

 sqrt 2 = sqrt(2) = 1.4142... 

 sqrt 2*2 = (sqrt 2) * 2 = 2.8284... 

 sqrt(2*2) = 2 

Missing operators are inferred: 

 1 1/2 = 1 + 1/2 

 1’6” = 1’ + 6” 

 1ft 6in - 17in = 1ft + 6in - 17in 

 1 2 3 4 5 = 1 + 2 + 3 + 4 + 5 = 15 

 (1)(2)(3)(4)(5) = (1) * (2) * (3) * (4) * (5) = 120 

 2(1 + 2) = 2 * (1 + 2) = 6 

 sqrt 2 sqrt 2 = sqrt 2 * sqrt 2 = 2 

 4(4atan(1/5) - atan(1/239)) = 4 * (4 * atan(1/5) - atan(1/239)) = pi 

Units are applied to previous terms if units were not specified and are applied to subsequent terms unless 
you override them: 

 1 + 1cm = 1cm + 1cm 

 1cm + 1 = 1cm + 1cm 

 1cm + 1 + 1mm = 1cm + 1mm + 1mm 

 1cm + 1 1/2 mm = 1cm + 1mm + 1mm / 2 

Trigonometry functions work in radians by default, but you can enter degrees: 

sin(45 deg) 

Numbers support standard form, but e is a built-in constant: 

 2e2 = 200 
2e 2 = 2 * e * 2 = 10.873... 

 2e-2 = 0.02 
2e – 2 = 2 * e – 2 = 3.436... 

 2e1 = 20 
2e = 2 * e 

5   Click a property in the Fields list. 

6   Click the Format tab to format the text within the field. 

The formatting options are based on the type of the property value. For example, strings can be 
formatted with upper case, lower case, initial capitals, or title case. 

7   Click OK to insert the formatted, dynamic field into the note at the cursor location. 

If the field is empty, check to make sure that the property you selected has a value by selecting the 
appropriate object and viewing the Properties panel. 
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To copy a note 

Ctrl+drag a note with the Move tool to copy it. 

To edit a note 

1   Select the note to move, size, or rotate it. 

To move the note box, mouse over the edge of the box until the cursor changes to , then drag the 
note. 

To size the box containing the note, drag the handles of the note box (the white circles).  

To rotate the note, drag the rotation handle (the green circle). Press Shift to snap to angular 
increments. 

2   Select the text of the note to reformat it. 

Click a field to edit it. Changing the value of a string also changes it in the Properties panel. 

3   Modify the note's properties in the Properties panel. Modify the: 

 Space property to set the size of the note. Select Model Space to size the text based on the 
actual measurements of the objects in your design. Select View Space to size the text based on 
the view of the design in the Design window. 

 Flagnote property to create a border around the note. Select a shape from the drop-down. Enter 
a value in the Minimum width property to prevent the flag from resizing automatically to fit the 
content of the note. 

To display the text of an annotation and hide the plane 

1   Create two layers, one for notes, and one for the annotation planes. 

2   Place the note on one layer and the annotation plane on another layer. 

3   Turn off the visibility of the layer that contains the annotation plane. 

Formatting note text 

You can adjust the font, size, style (bold, italic, underline), alignment of the text within the box, and create 
superscripts and subscripts using the tools in the Font ribbon group, or by right-clicking the annotation and 
selecting from the mini-toolbar.  

Font ribbon group 

 
 

The Font ribbon group contains the following tools: 
Family Select the font family. 

Size Select or enter a font size. 

 Select an amount of offset to create a superscript or subscript.

 Bold, italicize, or underline the note text. 

 Left, center, or right-justify the note text. 
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 Set the text direction from left-to-right or right-to-left. 

To format text 

1   Select the text in the note. 

2   Use the tools in the Font ribbon group to format the selected text. 

To create a superscript or subscript, select a preset amount from the Vertical Text Offset drop-
down, or select Custom and enter a custom amount to raise or lower the text 

Creating note leaders 

Use the Note Leader tool to create an arrow from your note.  

To create a note leader 

1   Select the Note Leader tool   from the Annotation ribbon group in the Detailing tab. 

Mouse over notes on the active annotation plane to see the possible ways to connect the note leader to 
the note. 

2   Click a note's connection point to draw the first segment of the note leader. 

Mouse over your design to highlight the geometry to which you can attach the end of the note leader. 
You can also attach leaders to temporary objects. 

3   For a segmented line, click to set each point of the note leader line. 

4   End the note leader. 

Click a vertex, edge, or face to attach the end of the note leader to it, or double-click to end the note 
leader at any point. The end of the note leader is an arrow unless you attach it to a face. 

To insert an all-around symbol 

Right-click the note leader and select All Around. 

To change a note leader's segments 

Drag a segment of the note leader line to move it and its surrounding boundary points. Right-click the note 
leader and select Add Jog Point to create a new segment. 

You can delete note leader line segments by deleting the jog points that border the segment. 

To change a note leader's properties 

1   Right-click the note leader and select Properties. 

2   Modify the Arrow Style, Length, and Width values. 

3   Set the All Around value to True to display an all-around symbol. Select False to hide it. 

To attach a note leader to a virtual sharp 

1   Select the Note Leader tool   from the Annotation ribbon group in the Detailing tab. 

2   Ctrl+click a line. 

3   Ctrl+click a converging line. 

The head of the note leader is attached to the virtual sharp. You can also drag the virtual sharp’s end 
point, draw another leader to the virtual sharp, create virtual sharps in cross-section, for rounds, and 
between an angled and straight edge. 
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Example 

 
A virtual sharp 

Creating dimension annotations 

Use the Dimension tool to add a measurement to your 
design, drawing sheet, or 3D markup.  

To create a dimension annotation 

1   Select the Dimension tool  from the Annotation 
ribbon group in the Detailing tab. 

Mouse over the faces of your design to preview the 
eligible annotation planes. (In Sketch and Section 
mode, the sketch grid defines the annotation plane.) 
If multiple objects occur at your cursor location, use 
the scroll wheel or arrow keys to highlight each one. 

2   Click a face to create the plane on which to place the 
dimension. 

To create an annotation plane for a cylindrical face, 
select the cylinder's axis. 

If you need to change the annotation plane, right-click and click Select New Annotation Plane from 
the context menu. Then right-click the new place and click Set As Annotation Plane. 

3   Click an edge or face. 

Where you click on a circle determines whether you will measure from the circle's center, near, or far 
edge. To select the center click the top, bottom, left, or right side of the circle.  

4   Mouse over your design to preview the possible dimensions. 

5   Click to create the dimension. 

To edit a dimension annotation 

1   Select the dimension annotation to move, size, or rotate it. 

To move the dimension note, mouse over the edge of the box with the Select tool until the cursor 

changes to , then drag the note. 

To size the box that contains the dimension note, drag the handles of the note box (the white circles).  

2   Select the text of the note to reformat it. 

3   (Optional) Right-click the dimension and select text formatting options from the mini-toolbar. 

Click  to select a tolerance format, then edit the text of the tolerance.  
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Click  to insert a field. You can select a field type and format from the Insert Field window. 

Select from the  drop-down to insert a symbol. 

4   Click an arrowhead to cycle through alternative leader styles. 

5   Click the note leaders to modify them. 

You can right-click a leader and select Add Jog Point to add a new point. 

6   Modify the dimension note properties in the Properties panel. Modify the: 

 Arrow Length and Width properties to set the length and width of the arrowheads 

 Measurement property to change the measurement type. For example, you may want to display 
the radius of a hole instead of the diameter. 

 Precision property to change the number of decimal places. 

 Upper Limit, Lower Limit, and Type of tolerance property to change the format of the 
dimension and enter upper and lower tolerance values. 

To attach a dimension annotation to a virtual sharp 

1   Select the Dimension tool  from the Annotation ribbon group in the Detailing tab. 

2   Click a line. 

3   Ctrl+click a converging line. 

The head of the note leader is attached to the virtual sharp. You can also drag the virtual sharp’s end 
point, draw another leader to the virtual sharp, create virtual sharps in cross-section, for rounds, and 
between an angled and straight edge. 

To display the annotation and hide the plane 

1   Create two layers, one for notes, and one for the annotation planes. 

2   Place the note on one layer and the annotation plane on another layer. 

3   Turn off the visibility of the layer that contains the annotation plane. 

To dimension to a virtual sharp 

1   Select the Dimension tool  from the Annotation ribbon group in the Detailing tab. 

2   Ctrl+click a line. 

3   Ctrl+click a converging line. 

The head of the note leader is attached to the virtual sharp. You can also drag the virtual sharp’s end 
point, draw another leader to the virtual sharp, create virtual sharps in cross-section, for rounds, and 
between an angled and straight edge. 

Example 

 
A virtual sharp 
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Creating geometric tolerance annotations 

 
Use the Geometric Tolerance tools in the Annotation ribbon group in the Detailing tab to add a tolerance to 
your design, drawing sheet, or 3D markup slide. In SpaceClaim, geometric tolerances are not created 
automatically. You can enter anything in a geometric tolerance, so we recommend that you read the 
geometric tolerance tooltips carefully to create intelligent geometric tolerance annotations. 

To create a geometric tolerance annotation 

1   Click the Geometric Tolerance tool . 

2   Click to place the geometric tolerance annotation on the appropriate annotation plane and display the 
Format tab. 

3   Select the characteristic symbol from the Symbol drop-down in the Geometric Tolerance ribbon group. 

4   Click in one of the Tolerance fields and enter any combination of text and modifying symbols from the 
Symbols ribbon group. 

To create multi-row geometric tolerance annotations, select a characteristic symbol, then enter text and 
modifying symbols in the second row. To combine the two rows so that they have one characteristic 
symbol, check the Composite Frame option.  

5   Press Esc to exit the annotation and close the Format tab. 

To display the text of an annotation and hide the plane 

1   Create two layers, one for notes, and one for the annotation planes. 

2   Place the note on one layer and the annotation plane on another layer. 

3   Turn off the visibility of the layer that contains the annotation plane. 
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Geometric Tolerance Format tab 

 

Datum symbols 

You can insert datum symbols onto your design, drawing sheet, or 3D markup slide.  

To add a datum symbol 

1   Select the Datum Symbol tool . 

Mouse over the faces of your design to preview the eligible annotation planes. 

2   Click to place the datum symbol on the appropriate annotation plane. 

3   Enter a letter. 

4   Use the Note Leader tool to create the note leader.  

To replace a dimension with a datum 

1   Click the Datum Symbol tool . 

2   Click the dimension text. 

To display the text of an annotation and hide the plane 

1   Create two layers, one for notes, and one for the annotation planes. 

2   Place the note on one layer and the annotation plane on another layer. 

3   Turn off the visibility of the layer that contains the annotation plane. 

Surface finish symbols 

You can insert surface finish symbols onto 
your design, drawing sheet, or 3D markup 
slide.  Surface finish symbols move along 
with the surface they are attached to. 

To add a surface finish symbol 

1   Select the type of symbol you want to use 
from the Surface Finish tool  drop-
down. 

Mouse over the faces of your design to 
preview the eligible annotation planes. If 
an annotation plane already exists, right-
click and select Select New Annotation Plane to choose a different plane. 

2   Click a face to place a leader on the plane. 

You can click as many faces as you'd like to add leaders to those faces. 

3   Click in an empty area of the Design window to place the surface finish symbol. 
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4   Modify the values in the Properties panel. Modify: 

 Font Size to change the font size for all the text fields on the symbol 

 Template to change the number of fields 

 Show All Around Symbol to add that symbol to the surface finish symbol 

 Type to change the type of surface finish symbol 

5   Enter text or symbols in the field. 

You can press Tab to switch between the fields. Right-click and select  from the mini-toolbar to insert 
a symbol. 

To display the text of an annotation and hide the plane 

1   Create two layers, one for notes, and one for the annotation planes. 

2   Place the note on one layer and the annotation plane on another layer. 

3   Turn off the visibility of the layer that contains the annotation plane. 

Examples 

 
Surface finish symbols using the Standard, Standard 2, and Standard 3 templates 

Center marks and center lines 

You can put a center mark on any circle, arc, cylinder end, or sphere, and you can put center lines on any 
cylindrical face on a drawing sheet. 

To add a center mark or center line 

1   Click the Center Line tool . 

2   Click an: 

 Edge of the end of the cylinder or hole to add a center mark. 

 Cylindrical face to add a center line. 

 Sphere to add a center mark. 

Example 

 
Center mark on the end of a cylinder and center line along the face of a cylinder 
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Center mark on a sphere 

Threads 

Use the Thread tool  to create a threaded surface on any cylinder, cone, or 
hole.  

To create a threaded surface 

1   Click the Thread tool  in the Annotation ribbon group on the Detailing 
tab. 

2   Click the edge of a cylinder, hole, or cone. 

The threads are indicated as a texture on the surface, and the thread 
depth is shown when you view the threaded object in Section mode. An 
inner thread  or outer thread  object also appears in the Structure 
tree. (Broken threads appear with a small yellow triangle over the icon.) 

3   Click the surface to edit the properties of the threaded surface in the Properties panel. 

The Type property controls whether threads are selected from a table or entered manually. For cylinder 
threads, select Standard to select values for the other properties from a drop-down list. The most likely 
values are selected by default (next smaller size for external threads, and the next larger size for 
internal threads). Select Custom to enter offset values. For tapered threads (threads made on conical 
surfaces) you can only use the Offset option. 

Set the Thread Depth Type property by selecting Blind or Full Thread.  Full Thread is the default for 
through holes and Blind is chosen automatically when the thread placement cylinder or cone ends in a 
plane at a convex edge. 

To customize the thread properties 

The thread data XML files that drive the drop-down menus for Standard thread properties are located in the 
SpaceClaim Library/Threads directory. You can: 

 Add or files to the directory to display the name in the Series property drop-down when you click 
the threaded surface with the Thread tool. Remove files to remove them from the property. 

 Add rows to an individual file to display them in the Size property drop-down. Remove rows to 
remove them from the property. 

 Specify a different directory for thread files by adding a different directory to the support file 
options. 

Tables 

You can place a table on an annotation plane using the Table tool in the Annotation ribbon group.  

To add a table 

1   Add an Annotation plane or activate an existing plane. 

2   Click the Table tool . 

3   Drag to create the table. 

You can: 

 Select the table, then drag to select multiple cells. Once multiple cells are selected, you can right-
click and select Merge Cells or Unmerge Cells.  

 Select one or more cells and right-click to access the other context menu functions, which allow 
you to add and remove columns and rows. 
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 Click within a table cell to edit its contents. 

 Drag a column or row boundary to resize the column or row.  

 Select rows, columns and cells by positioning the cursor to the left of the row, to the top of the 
column, and in the internal left side of the cell. 

 Apply font and paragraph properties to selected text. 

 Press Tab to navigate through table cells. 

 Drag the left side of the table to resize it. 

To move or rotate a table 

1   Click the outer, dotted border of the table to select it. 

2   Use the: 

 Arrow keys to move the table. 

 Ctrl+arrow keys to move the table by a very small amount. 

 Round handle at the top of the table to rotate the table. 

To delete text within a table 

1   Select all the cells in the table. 

2   Press Delete. 

To delete a table 

1   Select all the cells in the table. 

2   Right-click and select Delete Rows or Delete Columns to delete the entire table. 

To set table properties 

1   Click the outer, dotted border of the table to select it. 

2   Modify the number of columns and rows, row height, column width, and cell alignments and margins. 
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Drawing sheets 

 
SpaceClaim helps you create drawing sheets. When you add a new drawing sheet to a design, views of the 
design are created for you automatically. You can then add, remove, and edit these views, as well as move 
them around on the sheet using the tools in the Detailing tab. Drawing sheets are saved within your design. 

Normally, you will create the drawing sheet, set up the sheet, apply a format, add and modify views, then 
annotate the views.  

Drawing sheets and their views appear in the Structure tree. You can place drawing sheet views on layers. 

You can edit your design directly while viewing the drawing sheet using the tools on the Design tab. 

To create a new drawing sheet 

Select New > New Drawing Sheet from the application menu. 

A drawing sheet containing top, front, and right-side views appears in the Design window, and the Drawing 
Sheet appears in the Structure tree. The Detailing tab is displayed. You do not need to create a design 
before creating a drawing sheet. SpaceClaim allows you to create and edit geometry within the drawing 
sheet itself. When you create a new drawing sheet for an empty design, the sheet contains the view 
outlines, with handles you can use to control the size and position of the view. You can delete the handles 
and move the view using the outline. 

When sketching on a drawing sheet, you can: 

 Click within the view boundary with a sketch tool to display a sketch grid.  

 Use the scroll wheel to select a face of a solid in the drawing sheet when only the edge is 
displayed. 

 Override colors for solids and surfaces. Changing the colors on the drawing sheet does not affect 
the colors in the design. 
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When beginning a design from an empty drawing sheet, you can right-click a design on the drawing sheet 
and select Open Component to display the design in a new Design window. 

Modifying one view changes the related views as appropriate. 

To display a drawing sheet in the Design window 

Right-click the sheet in the Structure tree and select Open Sheet. 

To delete a drawing sheet 

Right-click the sheet in the Structure tree and select Delete. 

To view the drawing sheet head-on 

Right-click anywhere in the drawing sheet and select View > Flat View. 

To edit design annotations 

Right-click the annotation plane in the Structure tree and select Show all dimensions to display any 
design annotations on that plane. Click an annotation to edit it. Changes made on the drawing sheet will 
also appear in the design. 

Setting up a drawing sheet 

You can format the drawing sheet using a template, orient the page, and select a paper size for the sheet. 
When you select the format and size of the drawing sheet, SpaceClaim automatically sets the scale, but you 
can modify it.  

Sheet Setup ribbon group 

 
 

The Sheet Setup ribbon group contains the following tools: 

 
Select a default or custom format, or remove the formatting from the drawing sheet with the Format
tool.  

 
Select a portrait or landscape orientation for the page from the Orientation drop-down list. 

 
Select the page size from the Size drop-down list. 

Scale Enter a scale in the Scale field. For example, enter 1:1 to display views of your design at life size. 
 

Formatting a drawing sheet 

You can apply SpaceClaim formats to your drawing sheet or create your own custom formats. You can show 
or hide the format lines on the sheet. 
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To apply a format to the drawing sheet 

Select a default drawing sheet from the Format tool drop-down. 

To apply a custom format to the drawing sheet 

1   Select More Formats from the Format tool drop-down. 

2   Navigate to the SCDOC file containing the format and click Open. 

Remove the formatting from the drawing sheet 

Select Remove Current Format from Format tool drop-down. 

Create a custom drawing sheet format 

1   Create a new drawing sheet. 

2   Set the orientation, size, and scale of the drawing sheet. 

3   Draw on the drawing sheet using the Sketching and Annotation tools. 

You can also insert an AutoCAD file to create the format. When inserting, select the Import onto 
drawing sheet option. 

Tip: If you insert fields based on document properties  into annotations on the drawing sheet, you can 
create a drawing sheet format that automatically updates when it is applied to a drawing sheet in a 
design.  

4   Save the drawing sheet into a support directory. 

The drawing sheet appears as a format within the Format tool's drop-down list. 

Views 

You can add and remove views from the drawing sheet, move them around the sheet, and modify their 
properties. You can create general views, projected views, cross-section views, and detail views. These 
views are all related to the view used to create them, and inherit properties from that view. 

To add a view to the drawing sheet 

1   Select one of the following tools from the Views ribbon group on the Detailing tab: 

 General View tool  to add a new, independent view. 

 Projected View tool  to create a view projected from one of the other views on the drawing 
sheet. 

 Cross Section tool  to create a cross-section view using one of the other views on the drawing 
sheet.  

 Detail View tool  to create an enlarged view of a particular area.  

2   Click to place the view on the drawing sheet. 

3   Press Esc or S to exit the tool. 

To add a new, independent view 

1   Click the General View tool . 

2   Click the drawing sheet to add the view at that location. 
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To modify a General view 

1   Select the view. 

2   Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change 
the:  

 Orientation to change the orientation of the view to isometric, trimetric, or any side. If you 
change the orientation of a general view from which projected views were created, the orientation 
of the projected views also change.  

 Rendering mode to change the graphics style for the view. Select Inherit if you want to link the 
graphics style to the drawing sheet.  

 Scale to magnify or shrink the view. When you change the scale, the Type property changes to 
Independent from sheet. You can select Linked to sheet to set the scale to be the same as 
the scale used for the drawing sheet. 

3   You can also adjust the appearance of your design on the drawing sheet by using the:  

 Snap View tool to correctly position the design. 

 Move tool to position the design more accurately. 

When you modify the orientation of a general view, any views dependent on the general view are 
oriented simultaneously. Other general views do not change. 

To select a view on the drawing sheet 

1   Press S to activate the Select tool. 

If you are in another tool, press Esc to cancel the current action, then press Esc again to exit the tool 
and activate the Select tool. 

2   Mouse just outside the view on the drawing sheet, or scroll over the design shown in the view until a 
dashed box around the view is displayed. 

3   Click the box to select the view. 

To move a view on the drawing sheet 

1   Select the view. 

2   Drag the view with the Select tool to move it or click the Move tool and move it with the Move handle. 

Projected and cross-section views move together as a group. 

To orient the design shown in a view 

1   Select the component shown in the view. 

2   Select the Move tool on the Design tab. 

3   Use the Move handle to orient the component within the view. 

Views related to the current view also change their orientation. 

To modify a view 

1   Select the view. 

You can select multiple views to modify the properties they have in common. 

2   Modify the view's properties in the Properties panel or right-click and modify the view using the mini-
toolbar. 

3   Control the visibility of the view in the Structure tree. 
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Projected views 

Projected views show another side of the model. 

To create an orthogonal projected view 

1   Click the Projected View tool  on the Detailing tab's Views ribbon group. 

2   Click within the view you want to use to create the projected view. Do not click a highlighted edge. 

If dotted gray lines do not appear around the view, it is not selected. If this occurs, press Esc and try 
again. 

3   Move your mouse to preview the projected view. 

Orthogonal views are created as you move toward the top, bottom, left, and right of the current view. 

4   Click to place the view on the drawing sheet. 

5   Press Esc or S to exit the tool. 

To create an auxiliary projected view 

1   Click the Projected View tool  on the Detailing tab's Views ribbon group. 

2   Mouse over the view until the edge you want to use to create an auxiliary projected view is highlighted, 
then click. 

If dotted gray lines do not appear around the view, it is not selected. If this occurs, press Esc and try 
again. 

3   Move your mouse to preview the projected auxiliary view. 

Auxiliary views are created as you move the mouse perpendicular to the highlighted edge. 

4   Click to place the view on the drawing sheet. 

5   Press Esc or S to exit the tool. 

To modify a projected view 

1   Select the view. 

2   Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change 
the:  

 Orientation Type to change the projected view to a General view. This makes the selected view 
independent of the view used to create it. 

 Rendering mode to change the graphics style for the view. Select Inherit if you want to link the 
graphics style to the parent view. 

 Scale to magnify or shrink the view. When you change the scale, the Type property changes to 
Independent from sheet. You can select Linked to sheet to set the scale to be the same as 
the scale used for the drawing sheet. 

161 



SpaceClaim 2008 SP1 User’s Guide 

Cross-section views 

Cross-section views show a cross-section through your design. To create a cross-section view, you must 
already have at least two views: one that will become the cross-section, and another that will be used to set 
the cross-section plane. You can add a cross-section to any view type. 

To create a cross-section view 

1   Click the Cross Section View tool  on 
the Detailing tab's Views ribbon group. 

2   Select the view you want to convert to a 
cross-section. 

If dotted gray lines do not appear around 
the view, it is not selected. If this occurs, 
press Esc and try again. 

3   Mouse over a related view to display the 
cross-section indicator and preview the 
cross-section. 

The indicator line snaps to geometry in the 
view. Geometry in front of the cutting 
plane is not displayed. 

4   Click to place the cross-section indicator 
and create the cross-section view. 

The view is labeled automatically. 

5   Press Esc or S to exit the tool. 

To modify a cross-section view 

1   Move the cross-section indicator to change the cutting plane. 

2   Select the cross-section view. 

3   Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change 
the value in:  

 Orientation Type to change the cross-section view to a General view. This makes the selected 
view independent of the view used to create it. 

 Rendering mode to change the graphics style for the view. Select Inherit if you want to link the 
graphics style to the parent view. 

 Scale to magnify or shrink the view. When you change the scale, the Type property changes to 
Independent from sheet. You can select Linked to sheet to set the scale to be the same as 
the scale used for the drawing sheet. 

 Section Type to create a total or area cross-section. Select Total to display 3D geometry not on 
the cross section plane. Select Area to display only the geometry on the cross-section plane. You 
can select None to turn the view into a General view. 

4   Select a region within the cross-section view.  

5   Modify the values in the Properties panel. Change the value in the following Cross hatching properties:  

 Exclude from sectioning to remove the selected region from the cross-section view.  

 Fill styles to add or removing hatching from the region.  

 Angle to modify the angle at which the hatching lines are drawn. 

 Spacing to modify the space between hatching lines. 

 Offset to modify the start point of the first hatching line. 
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Detail views 

Detail views allow you to magnify a portion of another view to show more detail. To create a detail view, 
you must already have at least one view on your drawing sheet. 

If a detail view does not display correctly, make sure that you loaded any lightweight components shown in 
the view. 

To create a new detail view 

1   Click the Detail View tool  on the Detailing tab's Views ribbon group. 

2   Select one of the following options: 

  Create Detail of Selected View to create a new detail view with the boundary drawn on an 
existing view. 

 Convert Selected View to Partial to convert an existing view. 

3   Select the Sketch Boundary Type from the Options panel. 

4   (Optional) Enter the Scale on the Options panel. 

5   Click on the view that will create the detail to set the anchor point for scaling. 

Usually, you will create an anchor point very close to the detail that you want to show in the view.  

6   Click to set the center of a boundary circle, a corner of a rectangle, or the first point of a closed spline. 

7   Click again to define the boundary circle or rectangle, or click multiple times to define the boundary 
spline.  

The detail view is displayed. 

8   Click to place the detail view on the drawing sheet. 

9   Press Esc or S to exit the tool. 

To modify a detail view 

1   If you created a circular boundary, you can drag to expand or shrink it. 

2   Select the detail view. 

3   Modify the values in the Properties panel, or right-click and select a style from the mini-toolbar. Change 
the value in:  

 Rendering mode to change the graphics style for the view. Select Inherit if you want to link the 
graphics style to the parent view. 

 Scale to magnify or shrink the view. When you change the scale, the Type property changes to 
Independent from sheet. You can select Linked to sheet to set the scale to be the same as 
the scale used for the drawing sheet. 

 Orientation type to change the detail view to a General view. 
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3D markup 
SpaceClaim allows you to create 3D markup slides so that you can highlight and communicate the 
differences between versions of a design. 

Slides can be exported in PowerPoint and XPS formats.  

Markup ribbon group 

 
 

The Markup ribbon group contains the following tools: 

 Create a new 3D markup slide for the current design with the New Slide tool. 

 
Display the dimensions of the previous version and the current version with the Original Dimension 
Values tool. 

 
Apply colors to the design that indicate the type of change that occurred with the Color Changed 
Faces tool. 

To create a 3D markup 

1   Open the design you want to mark up in the Design window. 

2   Select Save As New Version from the Application menu to create a new version of your design. 

The new version is saved with a version number appended to the file name, and becomes the active 
Design window. 

3   Make changes to the new version of the design. 

4   Select New > 3D Markup from the Application menu to create the first 3D markup slide.  

The slide is shown in the 3D Markup panel, the design window, and the Structure tree. In the Structure 
tree, the version you created in step 2 is labeled Reference Design.  

5   Select the Insert tool from the Design tab and insert a previous version or the original version of the 
design into the slide.  

The design appears in the Structure tree, labeled either Alternate Version or Original Version. In 
the Design window, the previous version of the design is displayed in the wireframe transparent style 
and is placed directly on top of the new version. The Move tool is active. 

6   (Optional) Move the alternate version to a new location by clicking on a Move handle axis and dragging. 

7   Customize the slide using the tools in the Markup ribbon group in the Detailing tab. 

You can document the dimension changes with dimension annotations, color the faces based on the 
type of changes made, and apply any other annotations using the tools in the Annotation ribbon group 
in the Detailing tab. You can right-click a lightweight component and select Load Component to load it 

8   Create as many slides as you need to effectively communicate your changes. 

9   Select Save As XPS or Save As PowerPoint from the Application menu to export the 3D markup 
slides to a separate document. 
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Example 

 
Structure tree shows contents of each slide. 3D Markup panel shows two slides in the slideshow. Design 
window shows reference and original versions compared with dimensions and coloring for changed faces.  

Creating 3D markup slides 

Use the New Slide tool in the Markup ribbon group on the Detailing tab to create a new 3D markup slide. 

To create a 3D markup slide 

1   Select the New Slide tool  or right-click in the 3D Markup panel and select New Slide from the 
context menu. 

A new 3D markup slide appears in the 3D Markup panel containing the reference design. (The reference 
design is the design that was active when you first created the 3D Markup document. 

2   Insert a previous version of the design for comparison. 

Displaying changes to dimensions 

Use the Display Original Dimension Values tool to create dimension 
annotations for the current and original dimensions.  

To display changes to dimensions 

1   Select the Original Dimension Values tool   from the Markup ribbon 
panel on the Detailing tab. 

2   Create dimension annotations with the Dimension tool. 

The original dimension appears alongside the current one if that dimension changed between the two 
versions. 

To edit a change dimension 

Click within the dimension and edit the text. 

To return the change dimension to its original values, select the note and click the Original Dimension 
Values tool  from the Markup ribbon panel on the Detailing tab. 
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Coloring changed faces 

Use the Color Changed Faces tool in the Markup 
ribbon group on the Detailing tab to automatically 
color the faces that changed from one version to 
another based on the nature of the change. 

We recommend creating a legend on your slide 
similar to the following to help communicate the meaning of each color: 

 
New faces are colored green. Green faces did not exist in the previous 
version and will appear only on the modified version of the design. 

 
New topology is colored blue. Blue faces have changes to both the face and 
its edges, but the face existed in the previous design. 

 
Deleted faces are colored red. Red faces will appear only on the previous 
version of the design. 

 

Faces with changed edges are colored pink. Pink faces are in the same 
spatial location, but are bounded differently because their edges have 
changed. 

 
Faces with a changed spatial location are colored yellow. The edges of 
yellow faces have not changed from the previous version. 

If you want to manually color the faces, you can apply colors to the individual faces on your 3D Markup 
slide. 

To temporarily color changed faces 

Click the Color Changed Faces tool . Click again to remove the colors. 

The colors are shown on the current slide.  

Detailing options 
You can customize the style of your annotations in a single design or set a custom style as the default for all 
designs. You can quickly customize the style to conform to ASME or ISO/JIS standards, or you can create a 
style by customizing note leaders, dimensions, and geometric tolerances. 

To customize SpaceClaim detailing options 

1   Select SpaceClaim Options from the Application menu and click Detailing or click  in the 
Annotation ribbon group on the Detailing tab. 

2   Select one of the following from the Detailing options for drop-down list: 

 All New Documents to create a default detailing style for all your designs. 

 This Document to set options for the current design only. 

3   Make your annotations, views, and linestyles conform to ASME, ISO, or JIS standards or Customize the 
default drawing sheet format. 

Select one of the following: 

 Use external format to select a pre-defined format provided by SpaceClaim or click Browse to 
select a custom format from any SpaceClaim file. 

 No format to use blank drawing sheets of a particular size and orientation. 

If these options are disabled, select All New Documents in the Detailing options for drop-down. 
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Click Reset to ASME Default to customize annotations for ASME systems. 

Click Reset to ISO Default to customize annotations for ISO systems. 

Click Reset to JIS Default to customize annotations for JIS systems. 

JIS defaults are the same as ISO, except that JIS uses third-angle views while ISO uses first-angle 
views. (A third-angle view is labeled by the object. Therefore,  the front of the object is the "Front view" 
in JIS. A first-angle view is labeled by the direction you are looking. For example, if you are looking 
front, you see the back of an object. Therefore, the back of the object is the "Front view" in ISO.) 

4   Customize drawing sheet views. 

To customize General views 

1   Modify the Default view projection. Select: 

 First Angle to label the view by the direction you are looking. For example, if you are looking front, 
you see the back of an object. Therefore, the back of the object is the ”r;Front view.”  

 Third Angle to label the view by the object. For example, the front of the object is the ”r;Front 
view.”  

2   Modify the Default front view position. Select: 

 Top left to place the front view at the top left corner of the drawing sheet. This is the ISO standard. 

 Top right to place the front view at the top right corner of the drawing sheet 

 Bottom left to place the front view at the bottom left corner of the drawing sheet. This is the ASME 
and JIS standard. 

 Bottom right to place the front view at the bottom right corner of the drawing sheet. If you use 
third angle projection, ISO standards also allow this position. 

To customize Cross Section views 

Modify the following settings: 

 Section line arrow size - Enter a value to set the size of the arrow shown on the end of the section 
indicator. 

 Section line length - Enter a value to set the length of the section indicator. 

 Section cut line extension distance - Enter the length of the arrows that extend from the section 
indicator. 

 Section line arrow direction - Select whether you want the arrows to point toward or away from 
the section indicator. 

 Trim back section cut line interiors - Check this box, then enter the length of the section line you 
want to appear connected to each arrow. 

 Default section name note prefix - Select how you want the section label to appear on the 
drawing sheet. 

To customize Detail views 

Modify the following settings: 

 Detail view name text height ratio - Set the ratio of a character's height to width. For example, a 
value of 1.4 sets the character height to 140% of its width. 

 Default view note layout - Select One Line to display the detail name and scale on one line. Select 
Two Lines to display the scale below the detail name. 

 Default detail name note prefix - Select how you want the detail label to appear on the drawing 
sheet. 

 Default view scale note prefix - Select how you want the scale label to appear on the drawing 
sheet.  
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 Detail view boundary note placement - Select how you want the detail name and scale 
information to be positioned relative to the detail boundary. 

To customize the display of threaded surfaces 

Select a value from the Cosmetic thread display standard drop-down.  

ASME Simplified is the same as ISO and JIS Conventional display standards. 

5   Customize the annotation options. 

Modify the following settings in the Annotation Options area: 

 Default text height - Enter the height of the annotation text. 

 Leader circle size - Enter the size of the circle that connects note leaders to faces. 

 Leader arrow length - Enter the length of the arrow on note leaders. 

 Leader arrow width - Enter the size of the arrowhead on note leaders. 

 Leader shoulder length - Enter the length of the line from the note text to the note leader arrow. 

 Leader textbox gap - Enterthe size of the margin between the note text and the beginning of the 
note leader. 

 Center line extend- Enter the length that a center line will extend past the edge of the object. 

 Default arrow fill style - Select the style you want to use for the arrowheads on note leaders from 
the drop-down list. 

 Default dimension text location - Select how you want to align the note leader text with the note 
leader line from the drop-down list. 

 Default GTOL font name - Select the font you want to use for geometric tolerance symbols from 
the drop-down list. The two fonts in this drop-down list contain all the geometric tolerance symbols 
necessary. These symbols will be used as necessary in annotations, even when you select a different 
font for the annotation text. 

 Virtual sharps rendering style - Select the symbol you want to use to indicate the virtual sharp. 

 Enforce dimension line - Check the box to use the European standard of keeping the dimension 
line when the extension lines are shown. 

 Tight gap between dimension line and text - Check the box to shrink the gap between the 
dimension text and witness lines. 

 Horizontal dimension text - Check the box to keep all annotation text oriented horizontally. 

 Override layer color for annotations - Check the box to set all annotation text to the color 
selected shown in the Annotation color control. If you choose to override the layer color, select the 
color used for the override from the Annotation color control. 

 Extension line gap - Enter the size of the margin between geometry and the end of dimension lines. 

 Extension line extend - Enter the length that the dimension lines cross each other. 

 Dimension line extend - Enter the length of the arrow that appears outside the dimension lines. 

 Dimension text offset - Enter the distance between the dimension text and its leader line. 

6   Customize the linestyle options. 

Modify the following settings in the Linestyle Options area: 

 Default thick lineweight - Enter the default width for thick lines. 

 Default thin lineweight - Enter the default width for thin lines. 

 Select an object type, then select the Line style and Thickness for that object. 

7   Click OK to save all your changes and close the window. 
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Displaying designs 
The tools you use to customize the appearance of your design within the design window are found on 
SpaceClaim's Display tab. You can customize your design by modifying which objects are displayed, the 
style in which solids and edges are displayed, and the color in which solids appear in your design. You can 
create layers to save different customizations and display characteristics. You can customize the workspace 
by creating windows or splitting the window to display multiple views of your design. You can also show or 
hide workspace tools. You can also configure the docking/detached location of all your workspace windows.  

Display tools are grouped into the following ribbon groups: 
 

Orient Quickly display a particular view of your design. 

Style Determine how the solids in your design will be displayed. 

Window Create new design windows, split windows, and quickly switch between 
windows. 

Grid Determine how the sketch grid and the geometry above or below the 
grid is displayed 

Show Display or hide tools in the Design window. 
 

Working with objects in the Structure tree 
The Structure tree contains the Structure tree, which shows you each of the objects in your design. You can 
quickly show or hide any object using the checkbox next to the object's name. You can expand or collapse 
the nodes of the tree, rename objects, 
create, modify, replace, and delete 
objects, as well as work with 
components. 

The top-level design (called 
StructureTree in the image on the 
right) is also a component. The figure on 
the right shows some objects that can 
appear in a Structure tree.  

When you select a solid or surface (or 
other object) in the Design window, it is 
highlighted in the Structure tree. 

You can Ctrl+click or Shift+click objects 
in the Structure tree to select multiple 
objects at once. 

To set the visibility of objects 

There are now three methods for setting 
the visibility of objects in the Design 
window: 

 Right-click an object in the 
Structure tree and select Always 
Visible from the context menu. 

 Uncheck the box in the Structure tree to hide the object in the Design window. The object icon is 
displayed in gray. You can also right-click an object in the Design window and select Hide (or select it 
in the Design window and press Ctrl+H) to turn the visibility of the object off. 

 Check the box next to the object in the Structure tree to set the visibility of the object to the layer 
visibility.  
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If the layer visibility is on, the icon appears normally. If the layer visibility is off, the icon appears like the 
Solid_LayerHidden icon in the figure on the right. You cannot work with hidden objects in the Design 
window. 

 
Do it 
faster 

Shift+click and Ctrl+click multiple objects to work with them as a group.  

To find an object in the Structure tree 

Right-click any solid, surface, plane, axis, or other object in the Design window and select Locate in 
Structure Tree to display the object in the Structure tree. If the Structure panel is not open, it is 
displayed. 

To expand or collapse components 

Click  or press + on the number pad to expand a component. Click   or press - on the number pad to 
collapse it. Right-click any component (including the top-level component) and select Expand All or press * 
on the number pad to expand the component and all its subcomponents. 

To rename objects 

Right-click an object in the Structure tree and select Rename or press F2 to rename the selected object. 

Once you save a file, the top-level design component's name is set to the file name and it cannot be 
renamed. 

To move objects into components 

Drag any object or component to move it into another component.  

To use an object as a secondary selection for a tool 

Alt+click an object in the Structure tree.  

For example, if you want to revolve an object, you can click to select the face to Pull, then Alt+click an axis 
in the Structure tree to set the revolve axis for the pull. 

Orienting designs 
Select a tool from the Orient ribbon group to orient your design in the workspace. You can use these tools 
at any time, even when you are designing with other 2D or 3D tools.  
 

Do it 
faster 

Drag the middle mouse button to spin, Shift+drag it to pan, and Ctrl+drag it to zoom. You 
can switch between spinning, panning, and zooming by pressing and holding Ctrl (to zoom) 
or Shift (to pan). When you release the key, you will return to spinning.  

Orient ribbon group 

 
The Orient ribbon group contains the following tools: 

 Use the Home tool to return the orientation of your design to the default, trimetric view. You can 
customize the Home view to show your design with any orientation, location, and zoom level.  
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 Click the Plan View tool to display a head-on view of the sketch grid or the select plane or planar face.  

 
You can use the Spin tool to re-orient your design in any direction. Spinning your design allows you to 
view it from any angle. 

 Use the Pan tool to move your design within the Design window.  

 Use the Zoom tool to display your design closer or farther away in the Design window. You can zoom 
the design to fill the Design window, zoom into an area, or zoom in or out a preset amount. 

 Use the View tool to display a trimetric or isometric view of your design. You can also display a head-on 
view of the top, bottom, front, back, right, or left side. 

 Use the Snap View tool to display a head-on view of a face. You can also use the tool to "throw" the 
highlighted face to the top, bottom, right, or left. 

 Use the Rotate tool to rotate your design 90 degrees in the plane of the screen. You can rotate your 
design clockwise or counterclockwise. 

Orient modes 

When you click the Spin, Pan, and Zoom tools, they stay enabled until you click them again, press Esc, or 
click another tool. 

Undoing and redoing views 

You can undo and redo views using the Previous View and Next View tools  on the status bar. 

Spinning your design 

You can use the Spin tool to re-orient your design in any direction. Spinning your design allows you to view 
it from any angle. SpaceClaim uses standard arc-ball rotation; your design spins as if you could grab it with 
the cursor and adjust it like a real object. 

When you click the Spin tool, it stays enabled until you click it again, press Esc, or click another tool.  

To spin your design 

1   Select the Spin tool   from the Orient ribbon group or status bar. 

2   Select one of the following from the Spin drop-down: 

 On Center to spin around the center of your design. 

 On Cursor to spin around the cursor location.  

3   Click and drag to spin your design.  

If you start dragging on a highlighted line, edge, or axis, you can rotate your design around it. You can 
remove this feature by setting the advanced SpaceClaim option Rotate about preselected object in 
spin. (Press Alt and drag to rotate around a highlighted object whether or not this option is selected.) 

You may find it easier to reach a desired orientation if you use short mouse drags to spin the design a 
little bit at a time. 

If you double-click a face while using the Spin tool, the face is zoomed so that it fills the design window. 
 

Do it 
faster 

Set the Rotate about preselected object in spin option. Then, when working in any tool, 
position the middle mouse button on the face, edge, plane, or axis about which you want to 
spin your design, and drag to spin. 
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Panning your design 

Use the Pan tool to move your design within the Design window.  

When you click the Pan tool, it stays enabled until you click it again, press Esc, or click another tool. 

To pan 

1   Select the Pan tool  from the Orient ribbon group or status bar. 

2   Drag to move your design around the Design window. 

If you double-click a face while using the Pan tool, the face is zoomed so that it fills the design window. 
 

Do it 
faster 

When working in any tool, Shift+click the middle mouse button and drag to move your 
design. 

Zooming into and out of your design 

Use the Zoom tool to display your design closer or farther away in the Design window. You can zoom the 
design to fill the Design window, zoom into an area, or zoom in or out a preset amount.  

When you click the Zoom tool, it stays enabled until you click it again, press Esc, or click another tool. 

To zoom in and out 

1   Select the Zoom tool  from the Orient ribbon group or status bar. 

2   Click where you want to center the zoom. 

3   Drag down to zoom into your design; drag up to zoom out. 

You can also use the scroll wheel to zoom in and out. 
 

Do it 
faster 

When working in any tool, Ctrl+click the middle mouse button, then drag up and down 
to zoom. You can also press Ctrl+ or Ctrl- to zoom in or out a preset amount. 

To zoom the design or a selected face or edge to fit the Design window 

Select Zoom > Extents or press Z. 

The design or selected face or edge is zoomed so that it fills the Design window. When working with a 
drawing sheet, it will fit the drawing sheet to the Design window. If you resize the Design window, the 
design will also be resized until it again fills the Design window. 

To zoom into a selected area 

1   Select Zoom > Zoom Box In. 

You can also right-click in the Design window and select View > Zoom Box In from the menu. 

2   Click and drag to select the area. 

Two rectangles appear as you draw. The dotted rectangle shows your selection; the solid rectangle 
shows what will be displayed in the Design window. When you mouse-up, the design pans and zooms 
until it fits within the area. 

To zoom in and out a preset amount 

Select Zoom > Zoom In  to bring your design closer. Select Zoom > Zoom Out to move your design 
further away. 

When working in any tool, press Ctrl and + or Ctrl and - to zoom in and out a preset amount.  
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Rotating your design 

Use the Rotate tool to rotate your design 90 degrees in the plane of the screen. You can rotate your design 
clockwise or counterclockwise. 

To rotate your design 90 degrees 

Click the Rotate tool . 

To change the rotation direction 

Select Rotate > Rotate 90 Counterclockwise. 

Your design rotates 90 degrees counterclockwise and the Rotate tool icon changes to . Clicking the 
Rotate tool will continue to rotate in the counterclockwise direction.  

Select Rotate > Rotate 90 Clockwise to rotate your design in the clockwise direction and set the Rotate 
tool to rotate clockwise. 

Your Home view 

Use the Home tool to return the orientation of your design to the default, trimetric view. You can customize 
the Home view tool so that it displays your design with a specific orientation, location, and zoom level.  

Compared to the isometric view, the trimetric view orients your design so that the front face is angled 
slightly towards you and less of the top is shown. Compare the two views in the image below. 

 

To display the Home view 

Click the Home tool  in the Orient ribbon panel or press H. 

To customize the Home view 

1   Use the other Orient tools to set up a view of your design in the workspace. 

2   Select Home > Set As Home View to make the view in the active Design window the Home view. 

Now, when you click the Home tool, your custom view is displayed. Your home view is saved with your 
design. 
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Click Home > Reset Home View to return the Home view to the default, 
trimetric view. 

Display a head-on view of the sketch grid 

Click the Plan View tool  in the Orient ribbon group or in the Sketching mini-
toolbar to display a head-on view of the sketch grid or the selected plane or 

If this tool is disabled, select a plane or planar surface or display the sketch 

f your design. You can also display a head-on 
 

Compared to the isometric view, the trimetric view orients your design so that the front face is angled 
slightly towards you and less of the top is shown. Compare the two views in the image below. 

planar face.  

grid. 

Selecting a view 

Use the View tool to display a trimetric or isometric view o
view of the top, bottom, front, back, right, or left side. Your design's orientation in the head-on views is
determined by SpaceClaim's default coordinate system.  

 

To select a view 

Select the view you want from the View tool menu  in the Orient ribbon group. 

n 

k, Right, or Left from the View tool menu. 

To display a trimetric or isometric view of your desig

Select Trimetric or Isometric from the View tool menu. 

To display a head-on view of your design 

Select Top, Bottom, Front, Bac
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Snapping to a view 

 You can also use the tool to "throw" 
ng sheet, flipping one view also flips all 

de. It is disabled in Sketch and Section mode. 

To 

Use the Snap View tool to display a head-on view of a selected face.
the highlighted face to the top, bottom, right, or left. On a drawi
related views. 

ou can use this tool only in 3D moY

snap the view 

1   Click the Select tool ress S.  from the Edit ribbon group or p

2   Select the Snap View tool  from the Orient ribbon group. 

3   Click a face to view it head-on. 

This gesture will work even with very small mouse movements. 

 you want. 

4   Click, drag, and release the mouse towards the top, bottom, right, or left side of the design window to 
"throw" the face to that side. 

5   Repeat steps 3 and 4 until you see the view

Graphics style 
SpaceClaim offers several different ways to style your design. You can apply styles to your entire design or 
drawing sheet, to individual layers, or to individual views in your drawing sheet. 

To apply a graphics style to your design 

Select an option from the Graphics Style tool  from the Style ribbon group on the Display tab to display 

s, as wireframes with hidden lines displayed in light gray, and as 
wire
indicate the difference between solids and surfaces. 

lid or surface to be transparent, opaque, or metallic 

1   Select the solid or surface. 

2   Select Transparent, Opaque, or Metallic from the Face Style 

your design with that option.  

Select the option that works best for you for any given task. You can display geometry with a shaded or 
perspective shaded style, as wireframe

frames with hidden lines removed. We recommend that you use the shaded style to most clearly 

To set a so

  drop-down to apply that surface 
style to the selected solid or surface. 

If you apply the Opaque style to a surface, it will be returned to the transparent style if it becomes part 
of a new surface, such as after a merge. 
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Examples 

  

Transparent brac
opaque pole 

Displaying edges 

 

ket with Metallic style 

 

Use the Edges tool to customize which edges are displayed.

Select any combination of the following edge options from the Edges tool  menu on the Display tab's 
Style ribbon group. The edge selections apply to your entire design. 
 

Select: To toggle the display of: 
Tangent Lines indicating tangent edges and edges that do not span a face 
Surface All edges on surfaces 
Solid All non-tangent edges on a solid 
Silhouette Lines indicating the silhouetted edges of all curved surfaces. This option affects only 

Wireframe, Hidden Line, and Hidden Line Removed graphics styles. 
Lay
Lines 

out Layout lines on the layout planes shown in the Structure tree 

Applying colors to your design 

Use the Color tool to apply color to the solids, surfaces, and components in your design. You can also apply 
de. Sketches are drawn in the color of the active component. 

 and components are determined by the layer they are on. However, 
you

1   

Assemblies imported from other modeling software can have only one color applied to the entire 
 set their color simultaneously. 

color to individual faces on a 3D markup sli

Normally the colors of solids, surfaces,
 can override the layer colors. 

To apply the layer color 

Select the object you want to color. 

assembly. You can Ctrl+click multiple components in the Structure tree to

2   Select Color by Layer from the Color tool on the Display tab's Style ribbon group. 

or it with the layer color 

yer color for a solid 

   Select the solid you want to color. 

3   Select the layer from the Layer tool to place the solid on that layer and col
displayed on the Color by Layer icon and next to the layer on the Layer panel. 

To override the la

1

Assemblies imported from other modeling software can have only one color applied to the entire 
assembly. 

2   Select a color from the Color tool on the Display tab's Style ribbon group. 
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If the color you want does not appear, select Custom Color and create the color. 

To override the layer and solid color for a face in a 3D markup slide 

1   Select the face you want to color. 

2   Select a color from the Color tool on the Display tab's Style ribbon group. 

If the color you want does not appear, select Custom Color and create the color. 

s in your designs and drawing sheets. The line 
styles you choose apply to annotations, center marks, center lines, and drawing sheet cross-section view 

detail view boundaries. You can apply line styles to individual 
 that you set is exactly the width that will be printed when 

you print an unscaled drawing sheet. 

ceClaim options. Setting the line styles 

ff

the line style. 

 the Line Style tool menu. 

eight from the Line Weight tool menu. 

 grouping mechanism for visual 
 characteristics include visibility and 

d and modified in the Layer tool in the Style ribbon 

Layers are especially useful when you want to hide 
s created are automatically 

 layer. 

Right-click in the Layers panel and select New.  

yer. Any objects created are automatically placed on this layer. 

To 

Rig
righ

To delete a layer 

Layers panel and select Delete.  

Line styles 

You can apply a custom line style and line weight to the line

arrows, hatching, hatched area borders, and 
objects or to all the objects on a layer. The width

You can set the default line styles for various objects in the Spa
individually overrides the default setting. 

Linestyles can be assigned to layers so that you can have di erent line styles for sketch and layout lines. 

To apply a line style 

1   Select the objects or layer to which you want to apply 

2   Select the line style from

3   Select the line w

Working with layers 
A layer can be thought of as a
characteristics. Visual
color.  Layers can be managed in the Layers panel and 
accesse
group on the Display tab. 

annotation planes. Any object
placed on the active

To create a layer 

This layer becomes the activate la

rename a layer 

ht-click the layer in the Layers panel and select Rename or click the layer name and slowly drag to the 
t.  

Layer0 cannot be renamed. 

Right-click the layer in the 

Layer0 cannot be deleted. 
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To 

1   

The Layer tool in the Style ribbon group on the Display tab displays the layer of the selected object. If 
no object is selected, it displays the layer on which new objects are placed. It is blank if selected objects 

t(s) on that layer. 

You can also create a new layer to place the selected object onto that layer. 

er

2   

place an object on a layer 

Select the solid, surface, or component. 

are on different layers.  

2   Select a different layer from the drop-down list to place the selected objec

To set layer visibility 

1   Select a layer in the Lay s panel. 

Click  to show the objects on the layer. Click   to hide them. 

If an object is located on a layer with the visibility turned off, and the object in the Structure tree is set 
to show visibility by layer, the object is not visible in the Design window, and cannot be acted on by the 
design tools. Layer visibility can be overridden in the Structure tree. 

To set the visibility of layout lines and imported, DWG and DXF lines 

Select Solid or Hidden from the layer's line drop-down in the Layers panel. 

To modify the layer color 

1   Select a layer in the Layers panel. 

2   Select a color from the  drop-down. 

You can also specify a custom color by selecting Custom Color and using the Color window.  
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Workspace windows 
Displaying your design in multiple windows 

Use the New Window tool to create new workspace windows. Creating multiple windows allows you to set 
up several views of your design. Each window has a numbered tab at the bottom of the workspace.  

To create a new workspace window 

Select the New Window tool  on the Display tab's Window ribbon group. 

A new tab appears at the bottom of your workspace and a number is appended to the design, drawing 
sheet, or 3D markup name. You can click the middle mouse button on the tab of any design, drawing sheet, 
or 3D markup window to close that window 

Splitting the workspace window 

 
Use the Split Window tool to divide the workspace window into multiple windows. Splitting the window 
allows you to see multiple views of your design simultaneously.  

Select how you want to split the workspace window from the Split Window tool  menu on the Display 
tab's Window ribbon group. The window is split based on your selection. 
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Switching between windows in the workspace 

If you have more than one window open, you can select the window you want to display from the tabs at 
the bottom of the workspace. If you have many windows open and the tabs do not fit in the workspace, you 
can use the Next Window and Previous Window arrows  at the bottom of the workspace to switch 
between windows. 

You can also use the Switch Window tool to select the window you want to display. Select the window you 

want to display from the Switch Window tool  menu on the Display tab's Window ribbon group. 

Maximizing the Design window 

Press F11 to maximize the design window to full screen. You can still switch between windows and use the 
tool guides when the window is maximized.  

Press F11 to return to the standard user interface. 

Displaying workspace tools 
You can adjust the display of workspace tools and the display of your design in the Design window using 
the tools in the Show ribbon group on the Display tab, and by modifying SpaceClaim options. 

To customize the tools displayed while you are working with your design 

SpaceClaim offers the following tools on the Show ribbon group on the Display tab to assist you while 
creating, editing, and detailing your designs: 

 Check the World Origin box to display the axes that set the default orientation of the design in 
the Design window. 

 Check the Spin Center box to mark the center of the spin when using the Spin tool. (This is the 
same as the Show Spin Center SpaceClaim option.) 

 Check the Offset Baseline Faces box to display offset relationships with blue shading. 

 Check the Coaxial Face Groups box to display faces that share an axis with blue shading. 

 Check the Lineweight box to switch the line style of lines (such as those displayed in Hidden Line, 
Hidden Line Removed, and Wireframe graphics styles) from thin to the thickness set by the 
Lineweight tool in the Style ribbon group. 

 Check the Adjacent Entities box to display faint highlighting that appears on edges and faces 
adjacent when you hover over a point or edge. This feature is useful when you want to extrude the 
edge of a particular surface that meets another surface. 

To display other workspace tools, modify the settings in the Popular SpaceClaim options. 

You can also display journal-related tools by checking the Show Journal Tab option in the Advanced 
SpaceClaim options. 

Sketch grid styles 
You can modify whether the sketch grid is displayed, and how the geometry above or below the grid is 
displayed in each Design window. You may want to use one style when you are examining a component, 
and another when you are creating new geometry within a component. You can further customize the 
sketch grid by hiding section lines and faces using SpaceClaim options. 
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To show or hide the sketch grid 

Check the Show Sketch Grid box in the Grid ribbon group on the Display tab to display the sketch grid. 
The sketch grid appears in all the sketching tools. Displaying the sketch grid allows you to snap to grid lines 
and provides a visual cue to the orientation of your sketch within your design 

To determine how geometry above or below the grid is displayed 

1   Check the Fade Scene Under Grid box to make the geometry under the sketch grid more transparent.  

2   Check the Clip Scene Above Grid box to hide the geometry above the sketch grid. 

To clip your design with a plane 

Right-click a plane and select Clip with Plane. To restore the view of your design, right-click the plane and 
select Clip with Plane again.  

Planes, axes, and annotations are not clipped. 

Examples 

 
Examining a section with the scene clipped above the grid 
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Sketching on a cross-section with the scene faded below the grid 

Displaying lightweight components 
Lightweight components are a graphics-only representation of a design. You can adjust the transparency of 
the lightweight components in your design. If you do not see lightweight components when you open or 
insert a design, make sure your settings are configured to display them. 

To adjust the transparency of lightweight components 

1   Click the Transparency icon   on the status bar. 

2   Adjust the slider to set the transparency of the lightweight components in the Design window. All 
lightweight components are displayed with this transparency. 
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Working with SpaceClaim documents 

Creating, opening, and saving designs, drawing 
sheets, and 3D markups 
When you create a new design, it appears on a tab in the workspace. Designs can contain drawing sheets, 
multiple windows, and 3D markups. Each drawing sheet and 3D markup appears on its own tab in the 
workspace. You can edit your design directly using the drawing sheet. 

You can create a drawing sheet for an existing design, or you can begin with an empty drawing sheet  

Click a tab at the bottom of the SpaceClaim application window to display that design, drawing sheet, or 3D 
markup document, or click the arrow icons to cycle between them. Click the x icon to close the tab. 

To create a new design 

Select New > Design from the Application menu. 

To create a new drawing sheet for the active design 

Select New > Drawing Sheet from the Application menu to create a drawing sheet with three standard 
views of the design.  

Select New > Empty Drawing Sheet to create a drawing sheet without a format or views. 

If these menu options are disabled, create a new design. 

To create a new design and associated drawing sheet 

Select New > Design and Drawing Sheet from the Application menu to create a new design and an 
associated drawing sheet.  

To open an existing design, drawing sheet, or 3D markup document 

Select Open from the Application menu and select the file you want to open. The design and its windows, 
drawing sheets, and 3D markups open. 

You can Ctrl+click or Shift+click to open multiple files at once. Mouse over a recent file to see an image of 
the design and the full path to the file. 

To save a design 

Select Save from the Application menu. 

If you imported or opened non-SpaceClaim designs as multiple external documents, click References to 
specify where the documents are saved. Otherwise, opened design documents are stored in their original 
locations as .scdoc files, and inserted documents are saved in the same directory as your design. 

To copy a design 

1   Save any changes made to external components. 

2   Select Save as from the Application menu and enter a new name for the design. 

3   Check the Save as copy checkbox if you want to save a copy and continue working in your original 
design. Leave this box unchecked to close the original design and display the new design in the Design 
window 

4   Click Save. 
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To save a version of your design 

Select Save as > New version from the Application menu. 

Saving a version allows you to create 3D markups. 

To save a design as another file type 

Please see Importing and exporting. 

To close a design 

Make sure its window is active in the workspace, then do one of the following:  

 Select Close from the Application menu. 

 Right-click the Design window tab and select Close. 

 Click the x on the Design window tab bar (at the bottom of the application window). 

 Click the x at the upper right of the Design window if you have undocked it. 

To modify design properties 

Document properties are displayed when you select the top-level design in the Structure tree. Right-click in 
the Properties panel and select Add Property to create a custom property. Expand the property to display 
its value. Enter a name for the property, select its type (date, Boolean, number, or string), and enter its 
value. 

Importing and exporting components, designs, 
drawing sheets, and 3D markups 
Use the Open command to open files created with SpaceClaim (.scdoc) or any other modeling application. 
Use the Save As command to export parts, assemblies, drawing sheets, and 3D markups to formats read by 
other applications.  Your license type determines which of these actions are supported. 

If you work frequently with non-SpaceClaim files, we recommend that you set your file options to optimize 
the importing and exporting process for your needs. 

Object IDs for edges, faces, and bodies are now stored within the SCDOC file. Object IDs are preserved 
when other files are opened or inserted into SpaceClaim, and the IDs can also be exported. For example, if 
you export a design to an analysis company, and they tag geometry with load positions, boundary 
conditions, and so on, then when you re-import that design, make changes, and re-export to the analysis 
company, they will not need to recreate their tags on the new design. 
 

Supported file 
type 

Supported actions 

ProE (prt, asm) Open and insert parts and assemblies 
Solidworks (sldprt, 
sldasm) 

Open and insert parts and assemblies 

Inventor (ipt) Open and insert parts and assemblies (R12) 
CATIA version 4 
and 5 (model, 
CATPart, 
CATProduct) 

Open and insert parts and assemblies, including product manufacturing 
information (PMI) for parts placed on the Imported Annotation Planes layer (with 
visibility turned off) 
Export v5 parts and assemblies 

NX (prt) Open and insert parts and assemblies 
JT Open (jt) Open and insert parts and assemblies 

Export parts and assemblies 
Rhino (3dm) Open and insert parts and assemblies 

Export parts and assemblies 
ECAD Board (emn), Open and insert files. Named components are created at the heights and contours 
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Library (emp) defined by the ECAD file. Areas defined as “Keep in” or “Keep out” appear as open 
sketch lines.  

Parasolid (x_t, x_b) Open and insert parts and assemblies 
Export parts and assemblies 

ACIS (sat, sab) Open and insert parts and assemblies  
Export parts and assemblies (ACIS files flatten the assembly) 

AutoCAD (dwg, 
dxf) 

Open and insert drawings, parts, and assemblies. Drawings can be inserted as 
layouts. 
Export parts, assemblies, drawing sheets, and 3D markup slides 

VDA (vda) Open and insert parts and assemblies 
Export parts 

STEP (stp, step) Open and insert parts and assemblies  
Export parts and assemblies 

IGES (igs, iges) Open and insert parts and assemblies  
Export parts and assemblies 

Point curve text 
(txt) 

Insert curves 

XAML (xaml) Export part and assembly solids only  
STL (stl) Export parts and assemblies 
VRML (wrl) Export parts and assemblies 
OBJ (obj) Export parts and assemblies. Structure is not maintained. 
Image (jpg, png, 
bmp) 

Export parts, assemblies, drawing sheets, and 3D markup slides 

PowerPoint (xps) Export 3D markup slides 

To import a design 

1   Select Open from the Application menu or click  in the Quick Access toolbar, or click the Insert tool 
in the Insert ribbon group on the Design tab. 

2   Depending on the selected file type, additional elements appear in the Open window. For descriptions of 
these options or to set their default values, click Options. 

The first line of a Point curve text file must be Version=R2SP0. The second line should be 
Polyline=False to use splines to connect points, and Polyline=True to use line segments to 
connect points. Point-curve text files opened or inserted in SpaceClaim now display a closed curve when 
the file has a repeated value. Point-curve text files with multiple curves read the first column of data as 
both the number of the curve and the z-value, allowing curves to appear at different heights. Point-
curve text files with columns separated by commas can now be opened or inserted in SpaceClaim. This 
feature allows you to import any comma-separated value file into SpaceClaim. 

To import an ECAD file, first open the EMP file to generate a folder of library files in the same directory 
as the EMP file. Then open the corresponding EMN file to display the ECAD model in SpaceClaim. 

When importing a Rhino file, multi-segmented curves are consolidated. 

3   Navigate to and select the file you want to open or insert. 

If you are opening a file, it is displayed in a new Design window. If you are inserting a file, it appears as 
an external component within the active design. 

If there is an invalid character in the path of a file you are trying to open or insert, that character is 
replaced with a valid character to avoid errors. 

To export a design or 3D markup 

1   Select Save as from the Application menu. 

You can also press F12 or Ctrl+Shift+S. 

2   Select a file type from the Save as type drop-down. 

3   Depending on the selected file type, additional elements appear in the Save As window. 
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Click: 

 Save as copy if you want to save copies of external components referenced by the design with 
new names or replace external components with other external components. You must click 
Resources to do this. 

 References to display all the external components referenced by the file. Select an external 
component and click Browse (or double-click the component) to rename or replace the 
component. 

 Options to also set your default export options for the selected file type. 

When saving as an .STL file, the quality is based your graphics quality setting. We recommend setting 
the option to enable the highest possible graphics quality if you want your design to be useful as an SLA 
rapid prototype for form, fit, and function purposes. 

For CATIA, Parasolid, STL, and STEP files, you can select which version or protocol to save as. You can 
also set your default export options by clicking Options. 

When you save an SAT file to an X_T file, edges with zero length are removed from the design. 

Imported designs with identical filenames are given unique filenames when you save your SpaceClaim 
design. For example, if you imported name.prt and name.asm, these files are saved as name.scdoc 
and name2.scdoc.  

When you save a design with a shaded graphics style as a DWG file, it is converted to the hidden line 
style. 

When you save a sheet metal design as a DXF file, notes and bend lines are saved on the same layer, 
and the overall unfold dimensions are removed. 

When you save your design as an OBJ file, the current graphics tessellation is used for accuracy. You 
can modify the tessellation by setting the Image quality vs. graphics speed SpaceClaim option 

To export a design as an image 

Right-click in the Design window and select Copy Scene to copy the contents of the Design window to a 
PNG file. 
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Example 

 
PMI information from a CATIA file 

 
Consolidated multi-segmented curves from a Rhino file 

Printing drawing sheets and designs 
Your zoom settings determine how a drawing sheet or design will print. For best results, select a paper size 
from the Print window that is the same as the drawing sheet format. If you changed the orientation of the 
drawing sheet, then the view that appears in the Design window is the one that will be scaled to fit the 
selected paper size. This can result in a clipped drawing. 

Shaded designs are converted to hidden-line removed graphics style when you select Print from the 
application menu. Select Shaded from the Graphics Style drop-down after printing to return your design to 
the shaded style. 
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To print a drawing sheet 

1   Select Zoom > Zoom Extents from the Orient ribbon group in the Design tab. 

You can also print the drawing sheet at different zoom levels by zooming in or out, but for the best 
results, we recommend you use Zoom Extents. 

2   Select SpaceClaim Options from the Application menu and click Detailing. 

3   Select All New Documents from the Detailing options for drop-down list. 

4   Click No format and select the paper size and orientation. 

5   Click OK. 

6   Select Print > Print Preview from the Application menu to preview the print. 

You can zoom, set the page orientation, set print properties, and print the sheet from this window. 

7   Select Print from the Application menu. 

To print a design 

1   Select Zoom > Zoom Extents from the Orient ribbon group in the Design tab. 

You can also print the design at different zoom levels by zooming in or out, but for the best results we 
recommend you use Zoom Extents. 

2   Select Print from the Application menu. 

The design will be zoomed so that it fits the page size. 

To adjust the design's size on the page 

1   Select Print from the Application menu and click Print Preview. 

2   Select one of the following from the Content ribbon group: 

 Scene to display the design based on the size shown in the Design window. This setting is used by 
default for designs. 

 Extents to expand the design until it fills the printable area of the page. This setting is used by 
default for drawing sheets. 

3   If you selected Extents, select or enter one of the following from the Scale ribbon group: 

 Scale to fit to scale the design to fit the page. This setting is used by default. 

 Enter a value in the scale drop-down to scale your design by that amount. 

To correct a clipped print preview 

1   Close the print preview. 

2   Select the Home tool from the Orient ribbon group. 

3   Select Print from the Application menu and click Preferences to display your printer's Printing 
Preferences window. 

4   Set your printer settings in the Layout area to match the format and orientation of the drawing sheet. 

5   Set the paper size in the Advanced area to match the format paper size. 

If your printer only handles 8.5 x 11" paper, select the option that scales the image to fit the paper. 

6   Click OK on the Advanced Options and Printing Preferences windows, and click Apply on the Print 
window. 

To set page margins 

1   Select Print from the Application menu and click Print Preview. 

2   Click the Display tab and check Margins in the Show group. 
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3   Click the Print Preview tab and enter the margins in the Margins ribbon group. 

Journals and logs 
Journals record the actions you performed while creating your design, including file actions, such as closing 
a design. You must play a journal from a newly opened SpaceClaim application to avoid errors. 

SpaceClaim also logs information automatically into the SpaceClaim.log file, which can be found in one of 
the following directories: 

 C:\Users\<User>\AppData\Roaming\SpaceClaim on Vista systems 

 C:\Documents and Settings\<User>\Application Data\SpaceClaim on XP systems 

To display the journal tools 

1   Select SpaceClaim Options from the Application menu and click Advanced. 

2   Check the Show Journal tab in the Ribbon box and click OK. 

The Journal Tools tab is displayed. It contains the Journal ribbon group. 

 

To save all your actions in the current SpaceClaim session to a journal 

1   Click Save Current. 

2   Navigate to the directory where you want to save the journal, enter a name and click Save. 

3   Save the design files used in the session. 

To play the journal from your last session 

1   Exit and restart SpaceClaim. 

2   Click Replay Previous. 

To play a saved journal 

1   Exit and restart SpaceClaim. 

2   Click Replay. 

3   Navigate to and select the journal file you want to play and click Open. 

4   Review the actions from the session. 
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SpaceClaim file format 
Our files comply with the Microsoft Open Packaging Convention, which is also used by Microsoft Office 2007. 
 These files are actually zip archives with a special structure, the contents of which are primarily XML data.   

This open format makes it possible for third parties to get the information they need from SpaceClaim 
without talking directly to the SpaceClaim API.  For example, a PDM system could check in a SpaceClaim 
document with all external dependencies and show a 3D preview of the model.  One could also create a 
batch translator that runs on a UNIX operating system.   

Third parties planning on working with SpaceClaim data should contact SpaceClaim for advice on how to 
best integrate their solutions.  In general, the benefit of working with SpaceClaim files is that there is no 
need for a license of SpaceClaim to be present to read SpaceClaim data.  When creating SpaceClaim data or 
extending the SpaceClaim user interface, the API is a better choice.  SpaceClaim provides sample code for 
extracting solids from SCDOC files.   

Files contained within the SpaceClaim file 

This figure shows the files contained within a sample Flashlight.scdoc file. 
 

 

Files contained within the SpaceClaim file 

The document.xml.rels file contains pointers to all the files required to load the design into SpaceClaim. 
The figure below shows this content for the Flashlight example. 
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For example, you can use the information in this file to determine all the parts required for a BOM by 
looking at the assemblyComponent relationship. In this case, it points to another file called Standard 
Parts.scdoc. By opening this file and reviewing its components and subcomponents, you can generate a 
BOM report. 

There are three types of external file pointers: 

 assemblyComponent points to a file that contains subcomponents used in the assembly 

 drawingFormat points to the file used to format the drawing sheet 

 redlineComponent points to a 3D markup slide 

There are also multiple internal file pointers to the geometry files, thumbnail, tessellated data, and window 
settings. The bodyGeometry Id provides the key to identifying the bodies described in the other XML and 
XAML files. 

To view the data contained within SCDOC files 

1   Copy the .scdoc file you want to view. 

2   Replace the .scdoc file extension with the .zip file extension. 

3   Extract the files within the zip file. 

4   Open the folders and view the contents of the xml and xaml files with an XML viewer like XMLNotepad. 

To edit the data contained within SCDOC files 

You can safely modify some of the data contained within the .scdoc file; however, when creating 
SpaceClaim data or extending the SpaceClaim user interface, the API is a better choice. The following steps 
explain how to edit an annotation within the Flashlight\SpaceClaim\document.xml.  

1   Once you extract the files, open the document.xml with an XML viewer like XMLNotepad. 

2   Search for the text of the annotation you want to change. 

3   Edit the text. 

4   Save the file. 

5   Create a new zip file containing all the previously-extracted files. Make sure that you do not include the 
top-level folder. 
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6   Replace the .zip extension with a .scdoc extension. 

7   Open the file in SpaceClaim to check your edits. 

To view a tessellated model  

Open the facets.xaml file with Internet Explorer, or any other xaml viewer.   

To view a thumbnail of the file 

Open the thumbnail.png file with any graphics program. The thumbnail is displayed in Windows Explorer. 
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Customizing SpaceClaim 
You can customize SpaceClaim to best suit your working style. Most customization is done on the 
SpaceClaim options window, accessible from the Application menu. 

To customize SpaceClaim 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click the type of option you want to set from the navigation panel on the left. 

3   Modify the options on the page. 

4   Click OK to save all your changes and close the window. 

Option types 

You can set the following option types: 
 

 Popular 
Change your application color scheme, set file options for importing and exporting, grid 
size, application performance (speed vs. graphics quality), and customize the tools that 
are displayed while you are working in the Design window. 

 Detailing Change options for annotations and drawing sheets. 

 Color Change the color of the SpaceClaim application window. 

 Snap Change the objects snapped to while you are sketching and editing solids. 

 Units Set the units for dimensions, the sketch grid, and text height. 

 Support Files Set the search path for support files, such as standard thread size tables. 

 Sheet Metal Set the thickness, bend, and relief defaults for sheet metal components. 

 Advanced 
Modify how your design changes are displayed in the Design window, whether tools and 
hints are displayed, enable background loading, change the language, customize the Spin, 
Select, and Undo tools, reset the layout of the panels, and adjust the license warning. 

 Customize Add or remove tools and commands from the Quick Access toolbar. 

 Add-Ins Include or remove SpaceClaim add-ins. 

 Resources Download sample designs, check for updates, contact SpaceClaim, or view information 
about this version of SpaceClaim. 

Popular options 
Change your application color scheme, set file options for importing and exporting, grid size, application 
performance (speed vs. graphics quality), and customize the tools that are displayed while you are working 
with your design.  

To customize popular options 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Popular from the navigation panel on the left. 

3   Modify the options on the page. 

4   Click OK to save all your changes and close the window. 
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To set importing and exporting options for each file type 

1   Click File Options. 

2   Select the file type for which you want to set importing and exporting options. 

3   Modify the options for the file type. 

To adjust graphics quality and application performance 

1   Select a value from the Image quality versus graphics speed drop-down. 

Select a low number to increase the speed of the application; select a high number to increase the 
quality of the graphics. 

Increasing graphics quality may lower the SpaceClaim's responsiveness to actions in the Design window. 
If you notice a delay when working with your design, modify this option to increase application speed. 

2   Check the Anti-aliasing box if you want to display text and lines with smooth edges. 

Leaving this box unchecked will help speed performance. 

To customize the tools displayed while you are working in SpaceClaim 

Modify the settings in the Display Options section. Check: 

 Show tool ruler to display a ruler in the lower right corner of the sketch grid. 

 Show tool guides to display icons in the upper right corner of the Design window that help guide 
you through the editing process and provide greater flexibility when using the tool. Although most 
tool guide functions can be performed using a combination of keystrokes, we recommend that you 
leave them displayed for ease of use. 

 Show tooltips to display hints when you hover over tools, tool guides, and other icons. They 
briefly explain what will happen when you select the tool and provide some hints on how to use 
the tool. 

 Show splash screen on startup to display the SpaceClaim splash screen when you open the 
application. 

 Show mini-toolbar on selection to display a small toolbar near your cursor when you right-
click. The contents of the mini-toolbar depend on the tool you are using. You can click or scroll the 
middle mouse button to hide the mini-toolbar, and it fades as you move the mouse away from it. 

 Show tool KeyTips to display the keyboard shortcuts for each tool in the Ribbon bar. 

 Show arc centers to display small crosses on the sketch grid at the center of circles, ellipses, 
polygons, and arcs. 

 Show spin center to display the axis about which you are spinning your design when you use the 
Spin tool. 

 Show cursor arrows to display arrows next to your cursor that indicate the directions in which 
you can move your mouse to edit the selected object. The arrows also convey the change in size 
that will occur if you pull in that direction. Adjust the Cursor arrow transparency slider to 
control the transparency of the cursor arrows. Move the slider to the right to make the arrows 
more opaque; move it to the right to make them more transparent. 
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Examples 

  

Mini-toolbar showing Add, 
Cut, and Full Pull options 
for the Pull tool 

Opaque cursor arrows 
indicating the directions to 
move the mouse for a 
revolve 

File import and export options 
You can open and insert files from many other modeling applications into SpaceClaim for editing, and save 
your SpaceClaim designs as many different file types. If you work frequently with non-SpaceClaim files, we 
recommend that you set your file options to optimize the importing and exporting process for your needs. 

To customize importing and exporting options 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Popular from the navigation panel on the left. 

3   Click File Options. 

4   Select the type of file options you want to change. 

5   Click OK to save all your file-related changes and close the File Options window. 

6   Click OK to save all your changes and close the SpaceClaim Options window. 

To set general file options 

1   Click General. 

2   Check: 

 Use SpaceClaim color tones when importing to use the SpaceClaim color scheme for layers. This 
option is enabled by default to avoid fully saturated colors, on which highlighting is less visible. 

 Create multiple documents when importing assemblies to open or insert a non-SpaceClaim 
assembly as multiple documents. When you save your design, click References to adjust where the 
documents are saved. 

 Use matching SpaceClaim documents for faster import if a design contains an external 
component that was previously imported and converted to the SpaceClaim .scdoc format,and you 
want to re-use that previously imported file. 

 Automatically save imported documents to immediately save an opened or inserted non-
SpaceClaim file to an SCDOC file. (If you do not select this option, then opened or inserted files are 
not saved until you save the design.) 

 Improve imported data to improve a file when it is opened or inserted. De-selecting this option 
imports the file without stitching, healing, or other improvements. As a result, the file appears more 
quickly, but you may need to perform these actions manually. 

 Load model in background to orient large designs while they are loading. 
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Check Use lightweight assemblies to display a graphics-only representation of SpaceClaim files 
in the Design window. These files become components when loaded, opened, or inserted. Check 
Import JT and CATIA models as lightweight assemblies to load JT and CATIA models as 
lightweight assemblies. Check Import assembly structure only to display only the structure 
information about a SpaceClaim, JT, or CATIA, Pro/E, Solidworks, Inventor, or NX file in 
SpaceClaim's Structure tree. 

When you import a non-SpaceClaim file as a lightweight assembly, you can save the unloaded 
lightweight component as an SCDOC file with only rendering data (that is, without geometry data). 
You can then open this SCDOC file in a new design and load it normally to include the geometry 
data. 

 Allow import of hidden components to open or insert hidden components within CATIA v5, 
Parasolid, and Solidworks files and turn off their visibility in the Structure tree.  

 Allow export of hidden components to save components that have their visibility turned off in 
your design as hidden components when you save them as any other file type. 

To set ACIS file options 

1   Select ACIS. 

2   Select the ACIS version to set the format of exported designs. 

To set AutoCAD file options 

1   Select AutoCAD. 

2   Select the AutoCAD version to set the format of exported designs. 

3   Check the Save as Black and White box to remove any color information from exported designs. 

4   Select one of the following import settings: 

 Open DWG to use SpaceClaim's translator. It will attach DWG dimensions to the geometry in your 
design. 

 Autodesk Real DWG to use Autodesk's translator. It will disconnect DWG dimensions from the 
geometry in your design. 

5   Select one of the following export settings: 

 Open DWG to use SpaceClaim's translator. It will keep dimensions you created in SpaceClaim 
attached to the geometry in your design. 

 Autodesk Real DWG to use Autodesk's translator. It will disconnect dimensions from the geometry 
in your design. 

To set CATIA file options 

1   Select CATIA. 

2   Check Import part manufacturing information to include product manufacturing information when 
you open or insert CATIA designs. 

If you select this option, and you previously selected Import assembly structure only in the General file 
options, that option will be deselected. 

3   Select the CATIA version to set the format of exported designs. 

To set Parasolid file options 

1   Select Parasolid. 

2   Select the Parasolid version to set the format of exported designs. 
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To set STEP file options 

1   Select STEP. 

2   Select the STEP protocol to use to format exported designs. 

To set STL file options 

1   Select STL. 

2   Select one of the following output settings: 

 Binary to store the file data in binary format. 

 ASCII to store the file data in ASCII format. 

3   Select one of the following to set the resolution of the output file: 

 Coarse, Medium, Fine to use the deviation and angle preset values. 

 Custom to use the Deviation and Angle sliders to set a custom resolution. 

When exporting to STL, resolution indicates the number of sides of a polygon used to represent a 
circle. The deviation is the difference in distance between the circle’s radius and the polygon’s 
radius. The angle is the angle between the edge of the polygon and a tangent drawn through the 
circle at the same point. 

 System defined to use the STL tolerance defined by the graphics tessellation. 

Detailing options 
You can customize the style of your annotations in a single design or set a custom style as the default for all 
designs. You can quickly customize the style to conform to ASME or ISO/JIS standards, or you can create a 
style by customizing note leaders, dimensions, and geometric tolerances. 

To customize SpaceClaim detailing options 

1   Select SpaceClaim Options from the Application menu and click Detailing or click  in the 
Annotation ribbon group on the Detailing tab. 

2   Select one of the following from the Detailing options for drop-down list: 

 All New Documents to create a default detailing style for all your designs. 

 This Document to set options for the current design only. 

3   Make your annotations, views, and linestyles conform to ASME, ISO, or JIS standards or Customize the 
default drawing sheet format. 

Select one of the following: 

 Use external format to select a pre-defined format provided by SpaceClaim or click Browse to 
select a custom format from any SpaceClaim file. 

 No format to use blank drawing sheets of a particular size and orientation. 

If these options are disabled, select All New Documents in the Detailing options for drop-down. 

Click Reset to ASME Default to customize annotations for ASME systems. 

Click Reset to ISO Default to customize annotations for ISO systems. 

Click Reset to JIS Default to customize annotations for JIS systems. 

JIS defaults are the same as ISO, except that JIS uses third-angle views while ISO uses first-angle 
views. (A third-angle view is labeled by the object. Therefore,  the front of the object is the "Front view" 
in JIS. A first-angle view is labeled by the direction you are looking. For example, if you are looking 
front, you see the back of an object. Therefore, the back of the object is the "Front view" in ISO.) 

4   Customize drawing sheet views. 
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To customize General views 

1   Modify the Default view projection. Select: 

 First Angle to label the view by the direction you are looking. For example, if you are looking front, 
you see the back of an object. Therefore, the back of the object is the ”r;Front view.”  

 Third Angle to label the view by the object. For example, the front of the object is the ”r;Front 
view.”  

2   Modify the Default front view position. Select: 

 Top left to place the front view at the top left corner of the drawing sheet. This is the ISO standard. 

 Top right to place the front view at the top right corner of the drawing sheet 

 Bottom left to place the front view at the bottom left corner of the drawing sheet. This is the ASME 
and JIS standard. 

 Bottom right to place the front view at the bottom right corner of the drawing sheet. If you use 
third angle projection, ISO standards also allow this position. 

To customize Cross Section views 

Modify the following settings: 

 Section line arrow size - Enter a value to set the size of the arrow shown on the end of the section 
indicator. 

 Section line length - Enter a value to set the length of the section indicator. 

 Section cut line extension distance - Enter the length of the arrows that extend from the section 
indicator. 

 Section line arrow direction - Select whether you want the arrows to point toward or away from 
the section indicator. 

 Trim back section cut line interiors - Check this box, then enter the length of the section line you 
want to appear connected to each arrow. 

 Default section name note prefix - Select how you want the section label to appear on the 
drawing sheet. 

To customize Detail views 

Modify the following settings: 

 Detail view name text height ratio - Set the ratio of a character's height to width. For example, a 
value of 1.4 sets the character height to 140% of its width. 

 Default view note layout - Select One Line to display the detail name and scale on one line. Select 
Two Lines to display the scale below the detail name. 

 Default detail name note prefix - Select how you want the detail label to appear on the drawing 
sheet. 

 Default view scale note prefix - Select how you want the scale label to appear on the drawing 
sheet.  

 Detail view boundary note placement - Select how you want the detail name and scale 
information to be positioned relative to the detail boundary. 

To customize the display of threaded surfaces 

Select a value from the Cosmetic thread display standard drop-down.  

ASME Simplified is the same as ISO and JIS Conventional display standards. 

5   Customize the annotation options. 

Modify the following settings in the Annotation Options area: 
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 Default text height - Enter the height of the annotation text. 

 Leader circle size - Enter the size of the circle that connects note leaders to faces. 

 Leader arrow length - Enter the length of the arrow on note leaders. 

 Leader arrow width - Enter the size of the arrowhead on note leaders. 

 Leader shoulder length - Enter the length of the line from the note text to the note leader arrow. 

 Leader textbox gap - Enterthe size of the margin between the note text and the beginning of the 
note leader. 

 Center line extend- Enter the length that a center line will extend past the edge of the object. 

 Default arrow fill style - Select the style you want to use for the arrowheads on note leaders from 
the drop-down list. 

 Default dimension text location - Select how you want to align the note leader text with the note 
leader line from the drop-down list. 

 Default GTOL font name - Select the font you want to use for geometric tolerance symbols from 
the drop-down list. The two fonts in this drop-down list contain all the geometric tolerance symbols 
necessary. These symbols will be used as necessary in annotations, even when you select a different 
font for the annotation text. 

 Virtual sharps rendering style - Select the symbol you want to use to indicate the virtual sharp. 

 Enforce dimension line - Check the box to use the European standard of keeping the dimension 
line when the extension lines are shown. 

 Tight gap between dimension line and text - Check the box to shrink the gap between the 
dimension text and witness lines. 

 Horizontal dimension text - Check the box to keep all annotation text oriented horizontally. 

 Override layer color for annotations - Check the box to set all annotation text to the color 
selected shown in the Annotation color control. If you choose to override the layer color, select the 
color used for the override from the Annotation color control. 

 Extension line gap - Enter the size of the margin between geometry and the end of dimension lines. 

 Extension line extend - Enter the length that the dimension lines cross each other. 

 Dimension line extend - Enter the length of the arrow that appears outside the dimension lines. 

 Dimension text offset - Enter the distance between the dimension text and its leader line. 

6   Customize the linestyle options. 

Modify the following settings in the Linestyle Options area: 

 Default thick lineweight - Enter the default width for thick lines. 

 Default thin lineweight - Enter the default width for thin lines. 

 Select an object type, then select the Line style and Thickness for that object. 

7   Click OK to save all your changes and close the window. 

Color options 
You can adjust the color of the SpaceClaim application. The Color options page also contains placeholder 
elements for future color customization options.  

To adjust the color of the SpaceClaim application window 

Select a color scheme from the Color scheme drop-down. 

Select Custom Color if you want to choose a different color. You can mouse over the theme colors to 
display a preview, or click More colors and specify a unique color on the Custom tab of the Colors window. 
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The selected color appears in the background elements of the application, such as the title bar, tab bar, and 
ribbon bar. 

Snap options 
You can set snapping options for sketching and editing solids. Units for snap options are set by your Units 
options for all new documents. 

To customize snap options 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Snap from the navigation panel on the left. 

3   Modify the options on the page. 

4   Click OK to save all your changes and close the window. 

To set snapping options for sketching on the sketch grid 

1   Enter the angle increment you want to snap to when you press and hold Shift. 

2   Check Enable snapping in sketches to snap to objects while sketching. 

3   Check the box next to each item in the list to determine which objects you can snap to while sketching. 

To set snapping options for editing solids 

1   Check Enable snapping to solids with the Shift key to snap when you press and hold Shift using 
any tool. 

2   Set the snapping interval for tool movements in the Incremental area. 

For example, if you set the Linear increment to 1 mm, you will pull to whole millimeters instead of 
fractions of millimeters. 

3   Check the box next to each situation or object in the list to determine when a tool will snap while editing 
solids. 

For example, checking Round radius means that when creating a round, its radius will snap to the 
radii of existing rounds on the component. 

Units options 
You can set the units for dimensions, the sketch grid, and text height.  

To customize units 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Units from the navigation panel on the left. 

3   Select one of the following from the Units settings for drop-down list: 

 All New Documents to create a default detailing style for all your designs. These settings will not 
affect any currently open documents. 

 This Document to set options for the current design only. 

4   Modify the options on the page. 

5   Click OK to save all your changes and close the window. 
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To change the default units 

1   Select whether you want to use metric or the imperial system from the Type drop-down. 

2   Select the default units to be used for length. (Angles are always shown in degrees.) 

3   If you selected the imperial system, select whether you want to display fractions or decimals. 

4   If you selected decimals, enter the number of decimal places. 

5   Check the Show symbol box to display the units abbreviation. 

5   Check the Show trailing zero box to display trailing zeros in decimals. 

6   Check the Show "-" separator box to display a hyphen between whole values and fractions.. 

7   Review the preview. 

8   Click OK. 

To modify the sketch grid 

1   Enter the spacing between the smallest grid lines in the Minor grid spacing field. 

2   Enter the number of smaller grid lines between the larger, darker ones in the Minor grid lines per 
major field. 

To set the units for text height 

Select a unit type for note text from the Text height units drop-down. 

To convert an existing solid or surface from millimeters to inches 

1   Change the units to inches as described above. 

2   Select the Pull tool in the Edit ribbon group on the Design tab. 

3   Select the object you want to convert. 

4   Scale the object by 25.4. 

Support file options 
You can specify the directories in which you store support files, such as drawing sheet formats or thread 
size tables. Drawing sheets contained in these directories are displayed within the Format tool. 

To set the location of support files 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Files from the navigation panel on the left. 

3   Click Add or Browse and navigate to the file or directory you want to include. (You can also select the 
path and click Remove to remove it.) 

4   Select a path and click Move Up or Move Down to order the file paths. 

5   Click OK. 

Sheet metal options 
You can set the wall thickness, bend, and relief defaults for sheet metal components. These defaults can be 
changed for each component or bend by selecting the component or bend and modifying the property 
values in the Properties panel. Units for sheet metal options are set by your Units options for all new 
documents. 
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To customize sheet metal options 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Sheet Metal from the navigation panel on the left. 

3   Modify the options on the page. 

4   Click OK to save all your changes and close the window. 

To set basic sheet metal default properties 

1   Enter the default thickness for sheet metal walls in the Thickness field. 

2   Enter the default bend radius in the Bend radius field. 

3   Enter the K-factor in the K-Factor field. 

The K-factor is a value between .25 and .50 that is used to calculate the bend radius. K-factor is a 
percentage of the metal thickness and depends on factors such as the material and type of bending 
operation. 

To set bend relief default properties 

1   Select the bend relief type that will be created by default. 

You can change this type for an individual bend relief by selecting the bend relief with the Pull tool and 
clicking a different option in the Options panel. 

2   Select one of the following: 

 Use ratio relative to thickness to base the relief width and depth on the thickness of the wall. 

 Use absolute value to specify the exact width and depth of the bend relief. 

Advanced options 
Modify how your design changes are displayed in the Design window, whether tools and hints are displayed, 
enable background loading, change the language, customize the Spin, Select, and Undo tools, reset the 
layout of the panels, and adjust the license warning. 

To set advanced options 

1   Select SpaceClaim Options from the Application menu to display the SpaceClaim Options window. 

2   Click Advanced in the navigation panel on the left. 

3   Modify the options on the page. 

4   Click OK to save all your changes and close the window. 

To customize animation in the Design window 

Check:  

 Animate changes to view projection to animate the steps when you select a view. 

 Animate Full Pull to animate all the steps when you select the Full Pull option to revolve, sweep, 
or blend your design. 

To customize selection settings 

1   Check the Show previous selections with prehighlight hint box to highlight all the geometry you 
last acted on that includes the selected vertex, edge, or face. If you click again with the Select tool, the 
previously selected group will be selected for you with that one click. 

2   Enter how far away your cursor can be from the object you want to select in the Hit radius field. 
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To review a journal of the actions that created a design 

Check the Show Journal tab in the Ribbon box to save and play back a record of actions used to create 
a design. 

To customize update and license settings 

1   Check the Check for updates on startup box to use your internet connection to check for updates 
each time you start SpaceClaim. 

2   Enter the number of days before your license expires that you want to receive a warning message in the 
License Expiration Warning field.  

To customize spinning 

Check the Rotate about preselected object in Spin box to spin around the highlighted edge when you 
are using the Spin tool. You may want to uncheck this box if you are working with large or complicated 
designs. You can press Alt and to rotate around a highlighted object whether or not this option is selected. 

To extrude when sketching in Section mode 

Check the Enable sketch auto-extrude/revolve sketches in Section mode option. 

As you sketch in Section mode, lines that begin on an existing edge are extruded to form surfaces, and 
closed surfaces form solids. If the line begins on a solid, the line is finished automatically when you click 
another point on the solid. 

To change the language 

1   Select the language from the Language drop-down. 

2   Click OK. 

3   Exit and restart SpaceClaim. 

To set the number of stored undo actions 

1   Enter the number of actions you want available for undo in the Maximum undo steps field. 

We recommend that this value be set to at least 50. 

2   Click OK. 

3   Exit and restart SpaceClaim. 

To reset the layout of docking panels and windows 

To return the layout of the docking panels and SpaceClaim windows to their original locations, click Reset 
Docking Layout. 

To set display options for solids  

1   Select when you want interim calculations performed when modifying solids from the Preview before 
modifying drop-down list. If calculations are turned off, previews appear as wireframes. Select:  

 Auto to allow SpaceClaim to determine when to perform interim calculations based on the size of 
the component and the capabilities of your graphics card. 

 On to always calculate previews. 

 Off to never calculate previews. 

2   If you want SpaceClaim to help you when you are moving solids together so that the edges (such as 
rounds) converge perfectly, select Enable geometry convergence. If this option is enabled, when 
you are moving solids together, SpaceClaim will display a progress bar as it performs the convergence 
steps. 
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3   Check the Show cross sections in sketch box to display cross sections of solids with hatching. You 
might want to disable this option if you are working with complicated cross-sections. 

4   Check the Show cross section faces box to display a cross section through a solid as a face when 
clipped with the sketch grid in Sketch or Section mode. 

Example 

 
Extruding while sketching in Section mode 

Quick Access toolbar and ribbon bar options 
The Quick Access toolbar (QAT) is located on the title bar. The Ribbon is the menubar that contains all the 
tools in groups. You can add or remove tools from this toolbar and control the placement and display of the 
Ribbon.  

To customize the Quick Access toolbar and ribbon bar 

1   Click  next to the Quick Access toolbar. 

2   Select the items you want to appear in the toolbar. 

3   Select Place Quick Access Toolbar below the Ribbon to create a separate toolbar on the 
SpaceClaim interface. 

4   Select Minimize the Ribbon to hide the ribbon when you are working in the Design window. Click a 
tab to display the ribbon bar temporarily. 

5   Select Customize Quick Access Toolbar to display the SpaceClaim options window. (Any changes you 
made in the previous steps are saved automatically.) 

You can also select SpaceClaim Options from the Application menu and click Customize.  

6   Select the ribbon group that contains the tool you want to include in the QAT from the Choose 
commands from drop-down menu. 

7   Click the tool you want to include and click Add. 

Select a tool and click Remove to remove it from the QAT. 

8   Click OK. 

Add-in options 
The following add-ins are currently available for SpaceClaim: 

 ANSYS Launcher - Pass designs back and forth between SpaceClaim and ANSYS. 
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 Conversion - Batch convert files to the SpaceClaim format. 

 TraceParts - Insert a component from an expansive library of standard parts. 

You must install and activate each add-in before you can use it. If you want to use an add-in, but it is not 
available, contact SpaceClaim Customer Support. 

To activate an add-in 

1   Select SpaceClaim Options from the Application menu, then click Add-Ins. 

2   Check the box next to the add-in to activate it. 

3   Click OK. 

4   Exit SpaceClaim and restart it. 

To insert a Trace Part 

1   Select Insert from Trace Parts from the Insert tool on the Design tab. 

2   Select the part you want to insert. 

3   Click OK. 

The selected part appears as a new component in your design. 

Displaying workspace tools 
You can adjust the display of workspace tools and the display of your design in the Design window using 
the tools in the Show ribbon group on the Display tab, and by modifying SpaceClaim options. 

To customize the tools displayed while you are working with your design 

SpaceClaim offers the following tools on the Show ribbon group on the Display tab to assist you while 
creating, editing, and detailing your designs: 

 Check the World Origin box to display the axes that set the default orientation of the design in 
the Design window. 

 Check the Spin Center box to mark the center of the spin when using the Spin tool. (This is the 
same as the Show Spin Center SpaceClaim option.) 

 Check the Offset Baseline Faces box to display offset relationships with blue shading. 

 Check the Coaxial Face Groups box to display faces that share an axis with blue shading. 

 Check the Lineweight box to switch the line style of lines (such as those displayed in Hidden Line, 
Hidden Line Removed, and Wireframe graphics styles) from thin to the thickness set by the 
Lineweight tool in the Style ribbon group. 

 Check the Adjacent Entities box to display faint highlighting that appears on edges and faces 
adjacent when you hover over a point or edge. This feature is useful when you want to extrude the 
edge of a particular surface that meets another surface. 

To display other workspace tools, modify the settings in the Popular SpaceClaim options. 

You can also display journal-related tools by checking the Show Journal Tab option in the Advanced 
SpaceClaim options. 

Configuring SpaceClaim windows 
SpaceClaim has several docking windows that are initially docked along the left side of the application. You 
can minimize these panels, detach them, or dock them to different sides of the application. You can also 
dock and detach your design windows. 
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To minimize a panel 

Click the thumbtack icon to minimize the docked panel. Mousing over a minimized panel expands the panel 
while the cursor is over it. Once the cursor leaves the expanded panel, it returns to its minimized state. 

To maximize a panel 

Click the thumbtack icon  to "stick" the panel to the application window. 

To detach a panel or window 

Drag a panel by its title bar to detach it. Drag a design window by its tab to detach it. 

To dock a panel or window 

Drag a panel or window by its title bar or tab.  As you move the panel or window over the 
application, icons indicate possible docking positions.  

Mouse over an icon to preview the docked location. Release the mouse button to dock the panel 
at that location. 

To return docked panels to their default layout 

1   Select SpaceClaim Options from the Application menu and select Advanced. 

2   Click Reset Docking Layout. 

3   Click OK. 
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Sheet metal 

If 
you purchased the SpaceClaim sheet metal license, you can use SpaceClaim to create sheet metal designs 
and components. You can unfold a sheet metal design; changes made to a sheet metal component appear 
simultaneously in the unfolded component and in the original design.  

You can modify the thickness, inner radius, and K-factor of sheet metal components in the Properties panel. 
Modifying the component's properties affects all the objects in the component. Modified property values 
appear in bold. You can set the default values for sheet metal components by setting sheet metal options. 
Delete a modified property value to return it to the default value. 

The thickness of sheet metal is maintained with an offset relationship. A sheet metal component retains its 
properties when you move it into a non-sheet metal component, but they are only visible if you move it into 
a sheet metal component unchanged.  

SpaceClaim only recognizes a component as sheet metal if it consists only of planar and cylindrical faces. 

You can create patterns of flanges and notches on sheet metal parts. 

Sheet metal pull options 

The following sheet metal options are available in the Pull tool in addition to the regular pull options when 
you are working with a sheet metal component: 
 

Junction Type 

 

Select the type of joint you want to create when you pull on an edge. The available 
options are no overlap, partial overlap, full overlap, bend, and flange. These options 
are also available in the mini-toolbar. 

You can also: 

Click   to reverse the junction overlap.  

Click   to remove the rips and bends from the geometry and return to a shell, 
where there is no inside and outside radii. (You can also rotate a 180° "hem" to 
create a 90° flange.) 

Click   to remove the junction behavior, leaving only the geometry. 
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Bend Relief Type 

 

When pulling a partial wall, select the bend relief type. You can edit the bend relief's 
depth, width, and type in the Properties panel. (Right-click the bend face and select 
Properties.)  Bend reliefs are created automatically when they are required, 
including when you split a face. The available options are round, square, rip, and 
corner relief. These options are also available in the mini-toolbar.  

If a relief cannot be made, such as when it is tool close to the side, a message 
appears in the status bar. 

Bend Behavior  

  

When you pull the edge of a piece of sheet metal, how the junction is created 
depends on the edge you select and the direction you pull. When you pull across 
the other edge, the selected edge becomes an outside corner. When you pull away 
from the other edge, the selected edge becomes an inside corner. 

 The length of the inside surface of the wall is maintained. 

 The length of the outside surface of the wall is maintained. 

Sheet metal properties 

The following sheet metal properties are available in the Properties panel when a sheet metal component is 
selected. Modifying the component's properties affects all the objects in the component. Modified property 
values appear in bold. Delete a modified property value to return it to the default value. A sheet metal 
component retains its properties when you move it into a non-sheet metal component.  
Sheet Metal Set this property to True to convert the selected component to sheet metal. 

Thickness 
  

Enter the thickness for sheet metal walls. The thickness is maintained with an offset 
relationship. 

Inner Radius Enter the default inner radius for bend junctions, or enter the bend radius for the selected 
junction. 

K-Factor  

K-factor is a fraction (usually 0.25 to 0.50) used to calculate bend allowance, or the 
material required to correct for the change in length caused by bending a flat sheet. In 
addition to K-factor, bend allowance is influenced by factors such as material thickness 
and bend radius.  

K-factor relates to the depth of the neutral axis, a line within the sheet where the length 
does not change when the sheet is bent. The inside of the bend is under compression, the 
outside is under tension, and the neutral axis occurs somewhere between the midpoint of 
the material (K-factor=0.50) and a point closer to the inside of the bend (K-factor=0.25). 

Examples 

 
Example sheet metal part 
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Pulling a partial sheet metal wall 

Creating a sheet metal design 
You can create a sheet metal design using SpaceClaim's sketch and editing tools.  

To create a sheet metal design 

1   Right-click the component or top-level design and select Sheet Metal. 

The Structure tree icons change to indicate that the design  or component  is sheet metal. 

2   Sketch the sheet metal wall. 

3   Pull the face of the sheet metal wall. 

The sketch snaps to the thickness defined in the Properties panel. 

4   (Optional) Edit the junction type, bend relief type, and bend behavior (while in the Pull tool) with which 
future junctions will be created by selecting a junction type from the Options panel or mini-toolbar. The 
type of an existing junction can also be changed by selecting an edge or face of the junction and then 
changing its type in the Options panel, mini-toolbar, or Junction Type drop-down on the Properties 
panel.  

To reverse a junction, select an edge or face of the junction and click the Reverse Junction option  
in the Options panel or mini-toolbar. 

If you are planning on pulling a partial wall, select the bend relief type from the Options panel to specify 
the type of bend relief that will be created when you pull it. You can edit the bend relief's type, depth, 
and width in the Properties panel by selecting one of the edges in the bend junction. 

5   Select a linear edge of the sheet metal solid. 

The selected edge displays handles (yellow balls) at each end. The location of the handles can be 
adjusted to set the length of the flange or wall you want to create. (Drag the handles along the edge or 
press the spacebar to dimension the change in endpoints.) 

The pull arrows appear. (Do it faster: You can also mouse over the edge and pull.) If the pull arrows do 
not appear, then the selected edge cannot have material added to it. Select the arrow that shows the 
direction in which you want to pull by clicking on it or pressing Tab to switch between the two arrows. 

6   Pull the edge to create a bent wall. 

If Use Edge Location is selected as the Bend Behavior option, when you pull the edge of a piece of 
sheet metal, the resulting junction is created depending on the edge you select and the direction you 
pull. When you pull across the other edge, the selected edge becomes an outside corner. When you pull 
away from the other edge, the selected edge becomes an inside corner.  
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When the Inside option  is selected, the length of the inside surface of the wall is maintained. If the 
Outside option   is selected, the length of the outside surface is maintained. 

If you pull the top edge of a wall in the direction along the face with the No Overlap option selected, 
the new wall is offset by one thickness from the top. If you pull the bottom edge, the wall is offset one 
thickness from the bottom. If you select Partial overlap or Full overlap, the wall is extended without 
a junction. If you select Bend, an S curve is created. If you select Remove Junction, the junction no 
longer acts as a sheet metal junction. 

You can use the Up To tool guide to pull the wall up to a face or edge of another object. 

If you bend a wall back over itself to create a hem, a 0.0001 mm gap is created automatically. 

7   (Optional) Select the sheet metal component in the Structure tree and edit the sheet metal properties in 
the Properties panel. 

You can adjust the thickness, inside radius of bends, and K-factor for the sheet metal part. K-factor is a 
parameter of bends in a sheet metal part used to calculate the bend radius. K-factor is a percentage of 
the metal thickness and depends on factors such as the material and type of bending operation. The K-
factor can range from .25 to .50.  

For example, you can edit the radius of a single sheet metal bend by selecting the bend face and 
modifying the Inner Radius property in the Properties window. 

Continue editing your design using SpaceClaim's tools. 

Editing a sheet metal design 
In addition to the regular functions associated with the Pull and Move tools, several additional functions are 
available when you are working with sheet metal.  

To rotate a sheet metal wall 

Select one face of the sheet metal wall and rotate it with the Move handle.  

A default junction to rotate around is chosen based on which junction causes the smaller portion of the part 
to rotate. To rotate around the other junction, drag the Move handle anchor (the center ball) to an edge on 
the other junction. 

 

To move or dimension the location of walls 

Select the face of the wall to move. Pull the wall in the direction you wish to move it, dimensioning the 
change from its current location by typing or using the spacebar. To dimension the distance between two 
walls, use Create Ruler Dimension from the Options panel or the mini-toolbar to place a dimension 
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between the selected wall and another wall. Changing the value of this dimension will move the selected 
wall and update the surrounding geometry. The Move tool should be used to translate or rotate larger 
groups of walls. Bend reliefs move with the walls. 

 

To create corner reliefs 

Selecting multiple edges of a sheet metal wall and pulling them simultaneously creates the necessary relief 
in the corners in order to make the walls bendable. Pulling walls that form a corner simultaneously or 
sequentially produces different results. Both cases are shown below. When you create a corner junction, the 
No Overlap option is used by default. 
Do it 
faster 

Use the Selection filter in the status bar to select only vertices (by un-checking faces and 
edges), then box-select a sheet metal part to quickly select all the corners needing 
corner reliefs. 

 

To fill a face with a sheet metal rip 

Select the face of a sheet metal component with the Split Face tool and use the Select Two Cutter Points 
tool guide to create a rip across the sheet metal face to connect two corner reliefs, two points on two 
edges, or a combination. 

Click the face to fill the rip. The tool guide also snaps to 90 degree intersections with other edges. 

To create a jog in a sheet metal wall 

Select the edge of a sheet metal wall and then Pull it along the direction of the wall with the Bend joint type 
selected in the Options panel. The wall will jog up one wall thickness and continue in the same direction. An 
example is shown below.  

211 



SpaceClaim 2008 SP1 User’s Guide 

 
Pulling the selected edge along the wall but opposite its direction creates a hem offset by one wall thickness 
as shown below. You can also create a partial hem. 

 
 

Converting a design to sheet metal 
You can convert existing designs to sheet metal within SpaceClaim.  

To convert an existing component to sheet metal 

Set the Sheet Metal property of the component to True to convert it to sheet metal.  

To create a sheet metal box from a shelled box 

1   Right-click the component containing the shelled box in the Structure tree and select Sheet Metal. 

2   Create corner reliefs. 

3   Classify all edges as rips or bends, depending on how you what the part to unfold. 

To quickly convert a protrusion to sheet metal 

Click the Shell tool's More Shell tool guide, then click the protrusion to create a shell with the same 
thickness as the sheet metal component. 

To convert a plastic part to sheet metal 

1   Eliminate rounds to create sharp corners. 

2   Remove draft and internal features, such as ribs and punch-outs. 

3   Convert the component to sheet metal. 

4   Correct the wall thickness. 

5   Create corner reliefs. 
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6   Classify all edges as rips or bends, depending on how you want the component to unfold. 

Unfolding a sheet metal component 
Introductory paragraph. Insert animated image to the left of the topic title and align it to the right.  

To unfold a sheet metal component 

1   Right-click a face of a sheet metal component with at least one bend junction. 

The clicked face sets the orientation of the unfolded design. 

2  Select Unfold Part from the context menu. 

An unfolded version of the component is displayed in a new Design window with its overall dimensions, 
as shown in the figure below. It also appears in the Structure tree as an unfolded part . The visibility 
of the unfolded part in the original design is initially set to Off in the Structure tree. The unfolded part is 
saved as part of your design. 

Overall dimensions on an unfolded part are measured based on the orientation of the sketch grid. 

Bend lines for an unfolded part are placed on a Bends layer with the visibility off. Turn the visibility on in 
the Layers panel to view the bend lines. 

If an unfolded component has conflicting geometry, the conflicting geometry is made a separate surface 
in the Structure tree and highlighted in red, as shown in the figure below. The edge that prevents the 
unfold is also highlighted. 

You can also right-click the part and select Validate Body to display non-manifold areas in red. 

To work simultaneously on the folded and unfolded view of a design 

The unfolded view of a sheet metal part can be placed next to the folded view in order to work 
simultaneously on both views. Changes made to the part in one view update on the other.  

To place views next to each other, click and drag the tab for a Design window and drop it next to another 
view.  
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To export an unfolded part as .dxf 

The unfolded sheet metal part can be exported as a dxf file to be used in manufacturing. After placing 
desired dimensions and notes on the unfolded view using the tools in the Detailing tab, set the Graphics 
Style in the Display tab to be Wireframe. This step prepares the model for dxf export and shows you what 
the resulting image will look like. Next, select Save As from the SpaceClaim menu and specify AutoCAD files 
(*.dxf) as the export type. The unfolded model will be saved as a 2D dxf file with the included annotations.  

Calculations for unfolded lengths 

SpaceClaim can now use the sheet metal bend deduction to calculate unfolded lengths. You can edit this 
value in the Bend Deduction property for the selected bend. The bend deduction is 2 times the distance 
from the outside mold line to the beginning of the bend (that is, the "set back") minus the bend allowance. 

The Bend Allowance property contains the length of the arc through the bend at the neutral axis of the 
sheet metal wall being bent. Bend allowance and Bend deduction are linked. If you enter the value for one 
property, the other is calculated automatically. 

To use a sheet metal bend table to calculate unfolded lengths 

Copy a CSV file to the 
SpaceClaim 
Library/Bends 
directory or into a 
SpaceClaim Support File 
directory. Set the bend 
table for a sheet meta
component by selecting 
the component in the 
Structure tree and 
selecting the bend table
from the Bend Table 
property. All values may 
then be obtained from
bend table instead of 
being calculated. Any 
values not obtained from the bend table may result in an error whe

l 

 

 the

n you unfold the design. 

 

You can clear the sheet metal bend table assignment from a component by selecting the blank value from 
the Bend Table property drop-down.  

The table on the right shows a simple bend table as it would appear in a spreadsheet editor. Keywords are 
shown in bold. The table of values for a given thickness is shown with a shaded background: angle values in 
blue, radius values in green, and bend deduction values in yellow. 

When you unfold a sheet metal design, the thickness, inner bend radius, and angle from the design is used 
to determine the value in the selected table. 

Once you select a bend table, you can edit the Vee Die Width property in the Properties panel. Vee die 
width sets the width of the tooling that produces the bend. 

Bend table files are stored as comma-separated value (CSV) files which can be edited in a spreadsheet 
editor, such as Microsoft Excel, or in a plain text editor. 
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ers. 
iple 

This file shows the same data as in the previous 
table, but as it is stored in the comma-
separated value file. Each line consists of a
keyword, followed by one or more paramet
This example also shows how data for mult
thicknesses would be stored by including two 
bend deduction tables. 

 

 

 

 

 

 
Keyword description parameters for bend tables 
Keyword Description Parameters 

Version,<version-
number> 

Specifies the file format version. The file format version 
number is provided. The 
current version is 1.00. 

Type,<type-name> The type of data contained in the file. A single string representing 
the type of data contained in 
the tables. Currently the only 
supported value is 
BendDeduction. 

Units,<units-type> The default units are used for numeric 
values which do not have units provided 
explicitly. 

Must be in, mm, or cm.  

Thickness,<value> Begins a bend table definition. A single parameter 
specifying the thickness  for 
which the bend deductions 
in the table are defined. 

VeeDieWidth,<value> Optional. Specifies an optional tooling 
parameter, allowing multiple sets of 
bend deduction values for a given 
thickness.  

Must occur after a Thickness 
keyword. 

A single parameter 
specifying the width of the 
die tool. 

AngleValues,,<value>,… Defines the columns of the bend 
deduction table.  

Note the extra empty cell to aid in table 
alignment.  

The values defined by the table are 
associated with the preceding 
Thickness and VeeDieWidth 
keywords. 

A list of angles, specified in 
degrees. 

Radius,<radius>, 

<deduction-value>,… 

Defines the body of the bend deduction 
table.  

Individual deduction values may be 
omitted.  

The first parameter (radius) 
provides the inner bend 
radius for the table row. The 
 following parameters all 
provide the deduction values 
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Keyword Description Parameters 

The total number of deduction values 
provided cannot exceed the number of 
values provided above for the 
AngleValues keyword. 

for each combination of 
angle and radius. 

Example 

 
Folded and unfolded skewed bend 

Correcting a sheet metal component 
SpaceClaim’s sheet metal functionality can be used to fix components that are intended to be made from 
sheet metal but which do not conform to the sheet metal standards required for production. There are a 
number of typical errors in sheet metal creation that can be easily remedied in SpaceClaim. 

To correct a sheet metal component 

1   Fix joints that are not bendable. 

Select the edge of an improper joint with the Pull tool and then pick a joint type in the Options panel to 
have SpaceClaim remedy the problem. Once a proper joint has been created, it will update with changes 
to part thickness, bend radius, and K-factor as well as show the joint’s bend allowance on the unfolded 
design. An example of this change is shown below. 

 
2   Fill in extraneous geometry. 

A sheet metal component often has a number of details (such as punches, louvers, and vents) that may 
not be relevant to each person involved in the manufacturing process. SpaceClaim allows these details 
to be quickly and easily filled in order to simplify parts and retain focus on only the elements necessary 
for each step of the manufacturing process.  

To fill in geometry, use Select to box select desired features and then Fill to remove them. An example 
is shown below. 
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To identify non-manifold parts 

Right-click a sheet metal component and select Validate Body to highlight all non-manifold parts in red. A 
non-manifold  part is one in which you cannot tell the inside of the sheet metal from the outside. 

An example of a manifold part is a sheet metal tank for holding water. It is always clear that the inside of 
the wall is where the water is and the outside of the wall is where the air is.  

This is especially useful tool when troubleshooting a part that has been imported into SpaceClaim.  

For example, if you create an L-shaped wall in SpaceClaim, then use the Move tool to rotate the short wall 
all the way around to make a hem, SpaceClaim inserts a small gap so that the whole gap remains manifold. 
If a part imported from another program is not manifold, the L-shaped wall appears as a thick wall folded 
over, with no indication of inside and outside. Highlighting in red will help to troubleshoot the non-manifold 
parts that have been imported into SapceClaim. 

 
Unfolded sheet metal component, showing the non-manifold area in red 
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SpaceClaim add-ins 
The following add-ins are currently available for SpaceClaim: 

 ANSYS Launcher - Pass designs back and forth between SpaceClaim and ANSYS. 

 Conversion - Batch convert files to the SpaceClaim format. 

 TraceParts - Insert a component from an expansive library of standard parts. 

You must install and activate each add-in before you can use it. If you want to use an add-in, but it is not 
available, contact SpaceClaim Customer Support. 

Developing SpaceClaim add-ins 
The SpaceClaim Application Programming Interface (API) allows you to create add-in applications that 
extend the functionality of SpaceClaim.  An add-in application is a managed code DLL that uses Microsoft® 
.NET Framework 3.0 and the SpaceClaim API. 

For more information about the SpaceClaim API, please review the Developer's Guide (English only). The 
Developer's Guide was written by developers, for developers. It is located in your SpaceClaim API 
installation directory. There is also class library documentation. To display these files, double-click the 
SpaceClaim_API.chm and API_Class_Library.chm files. 

219 


	SpaceClaim 2008 SP1 User's Guide
	Introduction
	Getting started
	Tutorials
	 Bracket and knob assembly
	Turbine wheel tutorial

	 SpaceClaim interface
	Working with objects in the Structure tree
	Working with layers
	Groups
	Options panel
	 Properties
	 SpaceClaim shortcuts
	 Mouse gestures

	SpaceClaim objects
	Working with components
	Getting help

	Designing
	2D and 3D design modes
	Editing in cross-section
	Cutting, copying, and pasting
	 Dimensions
	Detaching in 2D and 3D
	 Undoing and redoing your actions
	Move handle
	Sketching
	 Editing a sketch
	Copying a sketch
	The sketch grid
	 Moving the sketch grid
	Layouts
	Moving in two dimensions
	Dimensional sketching
	Points
	Lines
	Tangent lines
	Construction lines
	Rectangles
	Three-point rectangles
	Circles
	Three-point circles
	Construction circles
	Ellipses
	Tangent arcs
	Swept arcs
	Three-point arcs
	Polygons
	Splines
	Splitting lines
	Trimming lines
	Creating corners
	Creating rounded corners
	Offsetting lines
	Projecting onto the sketch grid
	Bending

	 Editing
	 Selecting objects
	 Moving protrusions and depressions
	Moving solids and surfaces
	Editing a sketch
	Copying a sketch
	Pulling with the Select tool
	Pivoting with the Select tool
	Advanced selection techniques

	Pulling
	Offsetting or extruding faces
	Extending or extruding surface edges
	Rounding edges
	Chamfering edges
	Extruding edges
	Pivoting edges
	Revolving faces
	Revolving edges
	Revolving helices
	 Sweeping faces
	Drafting faces
	 Blending
	Blending between faces
	Blending between edges
	Blending between points

	 Creating slots
	Scaling
	 Copying edges and faces

	Moving
	Moving in two dimensions
	Creating patterns
	Exploding an assembly

	 Filling
	Replacing faces
	Editing faces as a blend
	Moving the sketch grid

	 Intersecting
	 Combining and splitting
	 Merging
	Merging solids
	Merging surface protrusions
	Merging surfaces
	Capping a surface with a plane

	Splitting
	Splitting a solid
	Splitting a surface
	Removing material from a solid


	Splitting a solid
	Splitting a face
	Projecting to a solid

	 Inserting
	Inserting a component
	Inserting an image
	Inserting a plane
	Inserting an axis
	Inserting an origin
	Creating a cylinder
	Creating a sphere
	Converting a solid to a shell
	Creating an offset relationship
	Mirroring objects
	Mirroring a solid, surface, or face
	Set up a mirror relationship between two faces
	Remove a mirror face or plane
	Find similar faces on the other side of a mirror

	Inserting temporary objects

	 Assembling components
	 Working with components
	Aligning components
	Centering components
	Orienting components

	 Measuring and analyzing
	Displaying mass
	 Displaying measurements
	Displaying edges of intersection
	Displaying intersection volumes

	Displaying a face or surface grid


	Detailing
	Annotations
	Creating notes
	Formatting note text
	Creating note leaders
	Creating dimension annotations
	 Creating geometric tolerance annotations
	Datum symbols
	Surface finish symbols
	Center marks and center lines
	Threads
	Tables

	 Drawing sheets
	Setting up a drawing sheet
	Formatting a drawing sheet
	Views
	 Projected views
	 Cross-section views
	Detail views


	 3D markup
	Creating 3D markup slides
	Displaying changes to dimensions
	Coloring changed faces

	Detailing options

	Displaying designs
	Working with objects in the Structure tree
	Orienting designs
	Spinning your design
	Panning your design
	Zooming into and out of your design
	Rotating your design
	Your Home view
	Display a head-on view of the sketch grid
	Selecting a view
	Snapping to a view

	Graphics style
	Displaying edges
	Applying colors to your design
	Line styles

	Working with layers
	 Workspace windows
	Displaying your design in multiple windows
	Splitting the workspace window
	Switching between windows in the workspace
	Maximizing the Design window

	Displaying workspace tools
	Sketch grid styles
	Displaying lightweight components

	Working with SpaceClaim documents
	Creating, opening, and saving designs, drawing sheets, and 3D markups
	Importing and exporting components, designs, drawing sheets, and 3D markups
	Printing drawing sheets and designs
	Journals and logs
	SpaceClaim file format

	Customizing SpaceClaim
	Popular options
	File import and export options
	Detailing options
	Color options
	Snap options
	Units options
	Support file options
	Sheet metal options
	Advanced options
	Quick Access toolbar and ribbon bar options
	Add-in options
	Displaying workspace tools
	Configuring SpaceClaim windows

	Sheet metal
	Creating a sheet metal design
	Editing a sheet metal design
	Converting a design to sheet metal
	Unfolding a sheet metal component
	Correcting a sheet metal component

	SpaceClaim add-ins
	Developing SpaceClaim add-ins



